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1 Introduction

This chapter introduces TeemTalk and describes the scope of this manual.

What is TeemTalk?
HP's TeemTalk host access software provides the ability to connect and communicate with
applications on mainframes and midrange systems. These connections can be made from virtually
any desktop running Microsoft Windows or Linux. TeemTalk enables desktops to emulate more than
30 different green screen terminals including IBM 3270, 5250, DEC VT, HP, MDIS Prism, and Wyse.

TeemTalk also provides a range of facilities to enhance your terminal emulation experience. These
include the following:

● Programmable soft buttons.

● Redefinable key and mouse button functions.

● Redefinable display attributes and colors.

● Multiple concurrent sessions displayed on tabs.

● Auto logon for automating all or part of the host logon process.

● Script language to automate various operations.

About This User's Manual
This manual explains how to use TeemTalk version 7.2. It assumes you are familiar with the
operating system in which you are running TeemTalk. Note that your version of TeemTalk may not
support every emulation or feature described in this manual.

Terms & Conventions
The following terms and conventions are used in this manual:

keys to press

When you need to press two or more keys together at the same time, such as the Shift key and
the F4 key, this will be indicated by a plus character between the key names. For example: Shift
+ F4. The + character does not represent a key to be pressed.

click

To click means to click the left mouse button once when the mouse pointer is on a particular
item on the display, such as an icon. You should use the left mouse button unless specifically
told otherwise.

double-click
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To double-click means to click the left mouse button twice in quick succession when the mouse
pointer is on a particular item on the display, such as an icon. You should use the left mouse
button unless specifically told otherwise.

drag

To drag means to position the mouse pointer on an item on the display (such as the edge of a
window), then hold down the left mouse button and move the mouse while keeping the button
held down.

Getting More Information
Technical Support

Current information about HP products including the latest software updates is available at:

http://www.hp.com/#support

In addition, this user manual and other HP documentation is available at the HP web site for
browsing or downloading.

Contacting Us

If you need to contact HP, use one of the methods listed at:

http://welcome.hp.com/country/us/en/wwcontact_us.html
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2 Getting Started

This chapter describes how to use the TeemTalk Session Wizard to create a session configuration
file, then the various methods available to run it. An overview of the TeemTalk window elements
follows, then descriptions of the configuration bar and status bar.

Creating a Session Using the Session Wizard
Introduction

TeemTalk enables you to create session configuration files which specify the terminal emulation to
run and its settings, how to connect to the host, and additional features such as display colors, soft
button definitions and keyboard macros.

A TeemTalk session configuration file can be created using the TeemTalk Session Wizard as
described in this section, or when TeemTalk is running a session by selecting Save Session As on
the File menu.

Using the Session Wizard
1. Run the TeemTalk Session Wizard from the Start menu by selecting All Programs > HP > HP

TeemTalk Terminal Emulator > Session Wizard.

2. In the Session Name field, enter a unique name that will identify this session configuration for
future selection.

The name specified here will be used as the filename for the .tts session configuration file that
will be created, and it will also appear in the title bar of the TeemTalk window in brackets when
the session is being run.
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3. Select the Transport method then click the Configure button to specify settings.

● SSH2

The SSH2 (Secure Shell) client/server protocol is used to encrypt and transmit data
securely over a network, with authentication provided by a password and/or key. Refer to
the section SSH2 Transport on page 13 for details.

● Serial

Enables host communication using the serial transport protocol. Refer to the section Serial
Transport on page 26 for details.

● TCP/IP

Enables host communication using the TCP/IP protocol. Refer to the section TCP/IP
Transport on page 12 for details.

● SSL

The SSL (Secure Sockets Layer) protocol enables authenticated and encrypted
communication between clients and servers. Refer to the section SSL Transport
on page 23 for details.

4. Select the Connection type (currently only Telnet is supported) then click the Configure button
to specify settings.

5. Select the required terminal emulation in the Emulation list box then click the Configure button
to specify settings.

● VT Series

Enables emulation of a suite of DEC VT and VT-based terminals. Refer to the chapter VT
Series Emulation on page 67 and the section Setup Options on page 76.

● HP70092

Enables emulation of the Hewlett-Packard HP 700-92/96 terminal. Refer to the chapter HP
700-92/96 Emulation on page 90 and the section Setup Options on page 103.

● IBM 3151

Enables emulation of the IBM 3151 terminal. Refer to the chapter IBM 3151 Emulation
on page 112 and the section Setup Options on page 118.

● IBM3270 Display

Enables emulation of the IBM 3270 terminal. Refer to the chapter IBM 3270 Display
Emulation on page 126 and the section Setup Options on page 138.

● IBM3270 Printer

Enables emulation of the IBM 3270 printer. Refer to the chapter IBM 3270 Printer
Emulation on page 149 and the section Setup Options on page 150.

● IBM5250 Display

Enables emulation of the IBM 5250 terminal. Refer to the chapter IBM 5250 Display
Emulation on page 159and the section Setup Options on page 169.

● IBM5250 Printer
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Enables emulation of the IBM 5250 printer. Refer to the chapter IBM 5250 Printer
Emulation on page 180 and the section Setup Options on page 181.

● TA6530

Enables emulation of the Tandem TA 6530 terminal. Refer to the chapter TA6530
Emulation on page 192 and the section Setup Options on page 197.

● Wyse

Enables emulation of a suite of Wyse terminals and Wyse terminal emulations. Refer to the
chapter Wyse Emulations on page 204 and the section Setup Options on page 210.

● MD Prism

Enables emulation of the MDIS P8/P12 or P9 terminal. Refer to the chapter MDIS Prism
Emulations on page 220 and the section Setup Options on page 224.

6. Click Next to display the Advanced Options dialog.

● Auto Logon

Enables you to automate all or part of the host login process. Refer to the section Auto
Logon on page 28.

● Key Macros

Enables you to define the function of keys and key combinations on your keyboard. Refer
to the section Defining Key Functions on page 30.

● Mouse Actions

Enables you to define the function of the mouse buttons when clicked on their own or with
modifier keys. Refer to the section Defining Mouse Functions on page 38.

● Soft Buttons

Enables you to define the function of the soft buttons displayed at the bottom of the
TeemTalk window by default. Refer to the section Defining Soft Button Functions
on page 45.

● Attributes

Enables you to change the colors and text attributes displayed in the emulation workspace.
Refer to the chapter Display Attributes on page 48.
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7. Click Next to display the Finalization dialog.

8. If you want a shortcut icon for this session to be created on the desktop, click the checkbox
Create icon on desktop for session.

9. Check the information displayed in the Summary Session Information box is correct. If not,
click the <Back button to edit.

10. Click OK to create the session configuration file (with the filename extension .tts) and exit the
Wizard.

Running a Session Configuration
You can run a TeemTalk session configuration using one of the following methods

● Desktop Icon

If a desktop icon was created for the session configuration, double-clicking on it will
automatically run TeemTalk and cause it to load the settings contained in the session
configuration file.

● TeemTalk Menu

To run a session configuration file while TeemTalk is running, run TeemTalk either by double-
clicking on the TeemTalk icon displayed on the desktop, or from the Start menu by selecting All
Programs > HP > HP TeemTalk Terminal Emulator > TeemTalk, then display the File menu
and select Open Session. Select the name of the required .tts session file then click Open.

● Command Line Option

The command line for running the TeemTalk executable file can include a command to load the
settings stored in a specified session configuration file. The format of the command is as follows:

+lsf" sessionfile.tts "

The filename must include the extension .tts and must be enclosed within double-quote
characters. The command must be preceded by a space to separate it from the name of the
TeemTalk executable file or other command line options

For example, to run TeemTalk and load the settings stored in the session configuration file
mysettings.tts, you would enter the following on the command line:teemtalk.exe 
+lsf"mysettings.tts" Refer to the chapter Preferences and Command Line Options on page 236
for more information on command line options.
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The TeemTalk Window
The TeemTalk window display consists of various elements which are described below. The View
menu allows you to toggle the display of the configuration bar, status bar and soft buttons on and off.
Note that you can also remove individual display elements from the TeemTalk window using
command line options as described in the chapter Preferences and Command Line Options
on page 236.

Figure 2-1  The TeemTalk Window

Item Name Description

1 Title Bar  The title bar displays the name of the session currently being run in brackets.

2 Menu Bar  The menu bar provides access to a series of commands and setup dialogs that
enable you to perform various operations and configure TeemTalk and the
terminal emulation. Individual menus and menu items can be removed from the
display using command line options.

3 Configuration Bar  The configuration bar provides a quick way of creating or configuring a session by
clicking buttons or selecting from drop-down list boxes. Refer to the section The
Configuration Bar on page 8 for more details.
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Item Name Description

4 Emulation
Workspace      

The emulation workspace is theTeemTalk window area providing the terminal
emulation display. You can create multiple emulation workspaces in the TeemTalk
window on separate tabs by selecting New Tab in theFile menu. If you require a
new TeemTalk window rather than an emulation workspace tab, select New
Window in the File menu.

5 Emulation Status Line  Some terminal emulations use the last line of the display as a status line to
indicate the status of various operations.

6 Status Bar  The status bar shows the status of various TeemTalk operations. The information
displayed depends on the terminal emulation currently running. Refer to the
section The Status Bar on page 9 for more details.

7 Soft Buttons  A set of programmable soft buttons is displayed at the bottom of the TeemTalk
window by default. The soft buttons can be detached in a separate window.

There are four soft button levels. Each level consists of twelve buttons providing a
combined total of 48 programmable buttons. You can display all four levels at the
same time if required. All levels are accessible even if not all are displayed, levels
stored off-screen can be 'scrolled' into view by clicking the Level # button.

Refer to the chapter Soft Buttons on page 45 for more details.

The Configuration Bar
The configuration bar provides a quick way of creating or configuring a session by clicking buttons or
selecting from drop-down list boxes.

Figure 2-2  The Configuration Bar

You can remove the configuration bar from the TeemTalk window by selecting Toolbars >
Configuration from the Tools menu. This will toggle display of the configuration bar on and off.

Attempts to make a host connection using the current Transport, Telnet and Emulation
settings. On a successful connection this button performs a Disconnect from host when clicked.

Figure 2-3  The Transport Button

Enables you to select and configure the transport used to communicate with the host.

Figure 2-4  The Configure Telnet Button

Enables you to configure the Telnet host connection.

Figure 2-5  The Terminal Emulation Button

Enables you to select and configure the terminal emulation.
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Saving the Session Configuration
You can save the session configuration by selecting either Save Session (overwrite existing session
configuration file) or Save Session As (create a new session configuration file) from the File menu.

The Status Bar
The status bar shows the status of various TeemTalk operations and enables you to switch between
operating modes. You can remove the status bar from the TeemTalk window by selecting Status Bar
on the Tools menu. This will toggle display of the status bar on and off.

The information displayed on the status bar depends on the terminal emulation currently running.

Figure 2-6  The Status Bar

Item Description

1 This simulated LED indicates whether you are connected to the host. It will appear red when not connected
and green when you are connected.

2 This simulated LED indicates whether data is being sent to or from the host. It will appear dull green when
there is no activity, red when data is being sent to the host, and bright green when data is being received
from the host.

3 This button enables you to switch between Local and Online mode. The label indicates the mode you will
switch to when the button is clicked.

4 This button enables you to Pause or Resume scrolling data in the window. The label indicates the action
that will be taken when the button is clicked.

5 Indicates the current terminal emulation.
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3 Host Connection

This chapter describes how to configure TeemTalk to communicate with the host.

Introduction
Host connection settings are specified using the Transport and Connection options which can be
found in three locations:

● TeemTalk Session Wizard:

● TeemTalk configuration bar:
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● TeemTalk Session menu:

The Transport setting specifies the physical method by which the host connection is made.
TeemTalk supports four transport protocols for communication with the host:

● TCP/IP  

For host communication using the internet protocol suite TCP (Transport Control Protocol) and
IP (Internet Protocol). See TCP/IP Transport on page 12.

● SSH2  

A secure shell client/server protocol used to encrypt and transmit data securely over a network,
with authentication provided by a password and/or key. See SSH2 Transport on page 13.

● Serial  

For host communication requiring data to be sent sequentially, one bit at a time, see Serial
Transport on page 26.

● SSL  

For host connection using the Secure Sockets Layer protocol to encrypt communications and
validate the host/client. See SSL Transport on page 23.

The Connection setting specifies the host connection protocol. Currently only Telnet is supported.

TeemTalk also provides an Auto Logon feature which enables you to automate all or part of the host
logon procedure by specifying what is sent to the host in response to prompts displayed on the
screen. See Auto Logon on page 28.

Telnet Settings
The settings for a Telnet host connection are specified using the Telnet Settings dialog which can be
displayed using one of the following three methods:

Using the Session Wizard

◦ In Step 1 set Connection to Telnet then click Configure.

Using the TeemTalk Window

◦ On the Session menu, select Connection > Telnet then select Configure Connection....

◦ On the configuration bar, click Configure Telnet.
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Specify the settings required by the host using the options described below, then click the Connect
button.

● Terminal Id

Factory default: Depends on the selected terminal emulation

This specifies the terminal identification string that is passed to the host.

● Send Echo

Factory default: nchecked

When this option is unchecked the emulator is prevented generating the Telnet echo option on
connection.

● Send CR with Break

Factory default: Unchecked

This determines whether a Carriage Return is sent with a Telnet break packet.

● Send TM with Break

Factory default: Unchecked

This determines whether a Timing Mark is sent with a Telnet break packet.

TCP/IP Transport
A host connection using the TCP/IP protocol is made using the TCP/ IP Settings dialog which can be
displayed using one of the following three methods:

Using the Session Wizard

◦ In Step 1 set Transport to TCP/IP then click the Configure button.

Using the TeemTalk Window

◦ On the Session menu, select Transport > TCP/IP then select Configure Transport....

◦ On the configuration bar, select TCP/IP in the Transport list box then click Configure
Transport.

12 Chapter 3   Host Connection ENWW



1. In the Host box enter the URL or IP address of the host to connect to.

2. In the Port box specify the number of the host port to connect to (default is 23).

3. Click the Connect button.

SSH2 Transport
The SSH2 (Secure Shell) client/server protocol is used to encrypt and transmit data securely over a
network, with authentication provided by a password and/or key.

Making a Host Connection
A host connection using the SSH2 protocol is made using the SSH Settings dialog which can be
displayed using one of the following three methods:

Using the Session Wizard:

◦ In Step 1 set Transport to SSH2 then click the Configure button.

Using the TeemTalk Window

◦ On the Session menu, select Transport > SSH2 then select Configure Transport....

◦ On the configuration bar, select SSH2 in the Transport list box then click Configure
Transport.
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The basic procedure for making an SSH2 connection is as follows:

1. Specify the IP Address of the host to which you wish to connect.

2. Specify the host's SSH Port number (default is 22).

3. Select an Authentication profile (refer to the following sections for information on creating
profiles).

4. Click the Connect button.

Creating an Authentication Profile using a Password
To create an authentication profile using a password:

1. Select SSH2 Profile... on the Tools menu.
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2. Click the Add button.

3. Enter a User name. The Profile name will automatically display the User name entered, but
you can change it if required. Click Next >
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4. Select Use a password for authentication then click Next >

5. Enter and confirm the password then click Next >.
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6. Check the summary. If it is incorrect you can go back and make changes by clicking the < Back
button, otherwise click Finish to generate the authentication profile. The new profile will now be
listed in the SSH2 Profile Settings dialog.

7. To use the new profile, display the SSH2 Settings dialog (see Making a Host Connection
on page 23) and select the name of the profile from the Authentication profile list box.
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Creating an Authentication Profile using a New Public Key
To create an authentication profile using a new public key:

1. Select SSH2 Profile... on the Tools menu.

2. Click the Add button.
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3. Enter a User name. The Profile name will automatically display the User name entered, but you
can change it if required. Click Next >.

4. Select Use a public key for authentication then click Next >.
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5. Select Create a new key then click Next >.

6. Enter a Key filename. If necessary, check the Find a new seed prime number box. Click Next
>.
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7. Select either RSA algorithm or DSA algorithm then click Next >.

8. Enter and confirm the passphrase to use for your new key file then click Next >.
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9. Check the summary. If it is incorrect you can go back and make changes by clicking the < Back
button, otherwise click Finish to generate the authentication profile. The new profile will now be
listed in the SSH2 Profile Settings dialog.

To make use of your key you need to copy it on to the server as follows:

10. Select the name of the profile in the SSH2 Profile Settings dialog then click the Edit button.

11. Select and copy everything displayed in the new window.

12. Logon to your server using username and password.

13. In your home directory you need to have a sub-directory called .ssh. You may have to create
this directory yourself. Within the .ssh directory you need a file called authorized_keys. Again if
it is not there you will have to create it.

14. Using whatever editor is available on your server, paste the key into the file and save it.
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15. To use the new profile, display the SSH2 Settings dialog (see Making a Host Connection
on page 23) and select the name of the profile from the Authentication profile list box.

SSL Transport
The SSL (Secure Sockets Layer) protocol enables authenticated and encrypted communication
between clients and servers.

Before anyone can connect to a server the system administrator must make available a copy of the
root certificate used to sign the server's identity certificate and the number of the telnet port the server
is listening on (the default for secure telnet is 992).

Additionally the system administrator may issue each user or terminal with their own password
protected client certificate.

Making a Host Connection
A host connection using the SSL protocol is made using the SSL Settings dialog which can be
displayed using one of the following three methods:

Using the Session Wizard

◦ In Step 1 set Transport to SSL then click Configure.

Using the TeemTalk Window

◦ On the Session menu, select Transport > SSL then select Configure Transport....

◦ On the configuration bar, select SSL in the Transport list box then click Configure
Transport.
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The basic procedure for making an SSL connection is as follows:

1. Add Server Root Certificate.

If you have been given a certificate to verify the server to which you are connecting, you will
need to add this to the TeemTalk list of root certificates.

To do this, click Add below the Root Certificates list and then use the file chooser to locate,
select and open the file containing the certificate. This will add the certificate name to the list.

Alternatively, if you have configured a CA certificate text database locally, you can select the
option for Set database location and specify the folder containing the CA certificate database
below this option.

If you do not need to verify the server, then select the option for Do not verify host's
certificate.

2. Select Client Certificate

If the server you are going to connect to requires you to have a client certificate, choose the
relevant certificate from the Client Certificate drop down list.

If you have not already installed your client certificate, click Add under the Client Certificate
drop down list, and choose the file containing the certificate. This will import the certificate and
add its name to the list.

You may optionally enter your password for the client certificate. If you check Save Password,
the password will be encrypted and stored along with the certificate itself.

NOTE: Saving the password is a security risk as anyone who can access the local system will
be able to connect to the host.
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3. Specify the Encoding format for the certificates by selecting either Pem (ASCII Text file Base64
encoded) or Der (binary file).

4. Specify the host name or IP address in the IP Address field.

5. Specify the host's SSH Port number (the default is 992).

6. Click Connect.

7. Login as usual when the telnet login prompt appears.

Error Messages
Connection Failed SSL to host : port

The most likely cause of this error is that the service is not running on the server, or the port
number is incorrect.

This message can also be returned if the server refuses the SSL connection. The most likely
causes are that the server is expecting a client certificate but none has been specified or the
client certificate specified is invalid for some reason. This error may also be seen if the server is
running an incompatible version of SSL. TeemTalk currently supports SSL2, SSL3 and TLS.

No Root Certificate assigned

This is caused when no Root Certificate or no CACertificate Databse was specified in the SSL
Settings dialog for the connection. If no root certificate is available, the server certificate check
can be bypassed by selecting the Do not verify host's certificate option.

The issuer certificate of a locally looked u certificate could not be found. / No certificates
could be verified.

The server's identity certificate was not signed by any of the root certificates installed in
TeemTalk. TeemTalk will not connect to a host it cannot verify.

The host name did not match any of the valid hosts for this certificate

The common name is part of the server's certificate. SSL assumes this will match the host name
given in the IP Address box in the SSL Settings dialog. If they do not match TeemTalk will not
connect to the host.

Notes About Certificates
The SSL Protocol uses three types of certificates:

● Server certificates. These are always sent by the server to the client to validate the server's
identity. SSL handles them internally and they are never saved on the client.

● Client certificates. These are sent by the client, only if the server requests them, and validate
the client's identity. The client will need to store these locally. Usually a client will only have one
certificate to validate it on a particular server but different servers may require different client
certificates.

● CA (Certificate Authority) or root certificates. These are used to authenticate the other two
types. The client will need to store these locally.
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Storage of Certificates
Unlike previous versions of TeemTalk, certificates are no longer imported and stored in the local
system registry. TeemTalk now pulls the certificate values as needed from their original container file.
If the certificate file is moved or deleted, the SSL connection will fail until the certificate information is
corrected in the SSL Settings dialog.

Serial Transport
A serial host connection is made using the Serial Settings dialog which can be displayed using one
of the following three methods:

Using the Session Wizard

◦ In Step 1 set Transport to Serial then click the Configure button.

Using the TeemTalk Window

◦ On the Session menu, select Transport > Serial then select Configure Transport....

◦ On the configuration bar, select Serial in the Transport list box then click Configure
Transport.
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Specify the settings required by the host using the options described below, then click the Connect
button.

● Communications Port

Factory default: COM3

This specifies the port used to communicate with the host.

● Baud Rate

Factory default: 9600

Specifies the connection speed in the range 110 to 115200 baud.

● Parity

Factory default: None

This option specifies the parity mode for each transmitted character. If the number of data bits
specified by Word Length is 8, set this option to None.

Selecting Odd will cause an eighth bit to be added with a value of 1 if the previous 7 bits add up
to an even number, and 0 if the previous 7 bits add up to an odd number. Selecting Even will
cause an eighth bit to be added with a value of 1 if the previous 7 bits add up to an odd number,
and 0 if the previous 7 bits add up to an even number. Mark parity will set every eighth bit to 1
and Space parity every bit to 0.

● Word Length

Factory default: 8

This option specifies the number of data bits sent for each transmitted character.

● Stop Bits

Factory default: 1

This specifies the number of stop bits sent for each transmitted character.

● Flow Control

Factory default: Both

This option specifies the type of flow control used by the line port to communicate readiness to
transmit or receive data from the host.

Flow control setting Effect on flow control

None No flow control.

Input XON/XOFF on received data.

Output XON/XOFF on transmitted data.

Both XON/XOFF on transmitted and received

Hardware RTS/CTS hardware flow control.

● Half Duplex

Factory default: Unchecked
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The setting of this option determines whether keyboard entered characters are immediately
displayed on the screen when transmitted to the host (otherwise known as local echo). When
unchecked, characters are not displayed locally when they are transmitted unless the host
'echoes' them back.

● Buffer Size

Factory default: 4096

This specifies the size of the buffer used for temporary storage of input and output data.

● Block on Full

Factory default: Unchecked

This determines what happens when the buffer becomes full. Checking this option will cause
TeemTalk to block all actions until the buffer is ready to receive new data.

Auto Logon
TeemTalk enables you to automate all or part of the host logon procedure. Settings in the Auto
Logon Options dialog enable you to specify what is sent to the host in response to prompts
displayed on the screen.

The Auto Logon Options dialog can be displayed using one of the following methods:

Using the Session Wizard

◦ Click on the Auto Logon... button in Step 2.

Using the TeemTalk Window

◦ Select Auto Logon... on the Tools menu.
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To specify auto logon settings:

1. If an initiation string is required by the host when you first make a connection, check the Set
initiation string box, enter the required characters in the Initiate with box (the Respond With
box in the illustration above), then click the Add button. The initiation string will be added to the
Script window on the right.

2. The Wait For options enable you to specify the prompt or keyboard locked or unlocked
command that the automatic login process is to wait for before proceeding. Some systems are
case Host Connection Auto Logon 35 sensitive, so make sure your Text entries follow the
correct conventions for your system.

NOTE: When running the IBM 3270 or IBM 5250 emulation, Text entries are only applicable in
NVT mode.

3. Enter the response required in the Respond With box. In order for a text entry to be sent to the
host it must be followed by a carriage return command. This is specified by selecting C. Return
in the list of predefined commands in the list box below then clicking the Insert button. A <CR>
will appear in the Respond With box.

You can also enter a predefined key function in the Respond With box by selecting Key
Definition in the list of predefined commands in the list box below, selecting one of the virtual
key names listed in the box below that, then clicking the Insert button.

The list of predefined commands that can be inserted include UserName (indicated by <UN>)
and Password (indicated by <PW>). Selecting either of these will cause a dialog box to popup
when logging on to the host prompting the user to enter a name or password, respectively. You
can also delay the script response by 2 seconds by inserting Delay (2s) (indicated by <D>) or
0.255 seconds by inserting Pause (0.255) (indicated by <P>).

4. When you have finished specifying the response to a particular prompt, click the Add button to
add the definition to the Script window on the right.

The script will perform the actions in the order displayed in the Script window. To change the
order of the script lines, use the up and down arrow buttons to the right of the Script window.

5. Repeat this procedure for each prompt as required.

If you want to edit one of the script lines, select the line in the Script window then click Remove
to send it to the edit boxes on the left. Make the change(s) then click Add to send it back to the
script. Note that this will now be the last line of the script.

6. When the Script window contains all the required responses to the relevant prompts in the
correct order, click Finish.
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4 Keyboard Configuration

This chapter describes how to configure the keyboard, define key functions and compose special
characters.

Keyboard Mapping
The functions of the computer keyboard are mapped as closely as possible to the terminal being
emulated. The mapping of key functions can be determined by referring to the Emulation Keys list
box in the Key Macro Settings dialog, which is displayed by selecting Key Macros... on the Tools
menu.

The information in brackets in the right column indicates the default mapping of the key function
named in the left column. In the list, S+ indicates the Shift key, C+ indicates the Control key and A+
indicates the Alt key. For example:

WY_INSLINE (S+C+VK_INSERT)

indicates that the Wyse emulation Insert Line function is mapped to the key combination Shift +
Control + Insert.

Special key functions supported by each terminal emulation can be mapped to keys using the
predefined macros listed in the Key Macro Settings dialog.

Defining Key Functions
You can redefine the function of keys on the keyboard using the Key Macro Settings dialog. The
options in this dialog enable you to redefine the function of most of the keys on your keyboard
including the key combinations listed below:

● Key

● Shift + Key

● Control + Key

● Control + Shift + Key

● Alt + Key

● Alt + Shift + Key

● Alt + Control + Key

● Alt + Control + Shift + Key
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The Key Macro Settings dialog can be displayed using one of the following methods:

Session Wizard

◦ Click on the Key Macros... button in Step 2.

TeemTalk Window

◦ Select Key Macros... on the Tools menu.

The top right panel is used to display information about keys that have been programmed and
enables you to select them in order to edit or delete. The Key column identifies the programmed key
using its virtual key name. The Type column specifies how the macro is to be processed. The Macro
column displays the function definition.

The Emulation Keys list box enables you to select from a list of standard key functions specific to the
currently selected terminal emulation. The information in brackets in the right column indicates the
default mapping of the key function named in the left column. In the list, S+ indicates the Shift key, C
+ indicates the Control key and A+ indicates the Alt key.

For example:

WY_INSLINE (S+C+VK_INSERT)

indicates that the Wyse emulation Insert Line function is mapped to the key combination Shift +
Control + Insert.

The Virtual Keys list box enables you to select from a list of standard key functions available for all
terminal emulations.
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The procedure for programming a key is as follows:

1. On your keyboard, press the key or key combination you want to define. The Key to Program
box will display the corresponding virtual key name for each key pressed.

2. In the Macro box enter the function definition for the key or key combination.

The definition may contain a string of up to 127 characters. The combined total of all the
characters that may be programmed into keys is determined by the 127 character limit per
definition and the amount of memory available in your PC.

The definition can contain key functions and control characters to be actioned as well as normal
text. Refer to the appendix Programming Keys and Buttons on page 243 for details.

Double-clicking on an Emulation Key or Virtual Key will apply that key function to the key
definition.

You can clear the macro by clicking the Clear button.

3. Test the function definition by clicking the Play Macro button.

4. Specify how the macro is to be processed by selecting one of the following options in the Type
list box.

● Normal

The macro will be processed according to the current operating mode when the key or key
combination is pressed.

● Remote

The macro will be transmitted to the host.

● Local

The macro will be actioned locally.

● Startup

The macro will be processed automatically on startup.

5. If you want to program another key using the current macro definition, click the New Key button.

If you want to program another key with a different macro definition, click the New Macro button.

You can delete a key definition by selecting it in the list of defined keys (top right) then clicking
the Delete Macro button.

6. When you have finished defining key functions, click OK.

7. To save the key definitions, select File > Save Session.

Compose Character Sequences
Compose character sequences can be used to generate codes for characters not shown on your
keyboard. The characters that can be composed depend on whether the terminal emulation is in
National or Multinational character set mode. When the terminal emulation is in National character set
mode, only characters found in the character set that corresponds to the selected keyboard
nationality can be composed. When the terminal emulation is in Multinational character set mode,
characters from all national keyboard layouts can be composed.
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If a character is a diacritical symbol and this symbol does not appear on the keyboard, an equivalent
character can be used in some cases. The diacritical symbols and the possible substitutes are shown
below. There are no equivalents for the circumflex accent and tilde mark.

Diacritical Mark Equivalent Character

´ Acute accent ' Apostrophe

¨ Umlaut " Double quote

` Grave accent ' Single quote

° Ring mark * Asterisk or degree sign

To compose a character, first find the character you wish to compose in the left hand column of the
following tables. The two characters shown in the right hand column are the keys that are used to
create it. Several alternatives may be given for generating the same character. A compose sequence
is initiated by pressing the keys Alt + C together, followed by the key bearing the first character then
the key bearing the second character.

NOTE: The compose character sequence can also be initiated by pressing a key defined with the
COMPOSE virtual key name.

A compose character sequence may be abandoned before completion by pressing the Delete key.
Pressing Alt + C (or the key defined with the COMPOSE virtual key name) again before completing a
compose character sequence will cause it to be abandoned and a second sequence to be started. An
invalid compose character sequence will cause the bell to sound.

The following tables use several conventions:

● The keys bearing the characters used to compose a special character may be pressed in any
order unless (in order) is specified.

● (DEC Multinat.) indicates that the character can only be composed if the terminal emulation is in
Multinational mode and the Character Set option is set to Multinational.

● (Latin-1) indicates that the character can only be composed if the terminal emulation is in
Multinational mode and the Character Set option is set to ISO Latin-1.

● If a nationality is specified with the character description, for example (Dutch), then the
character can only be composed when the terminal emulation is in National mode and the
system is configured for the relevant language.

Table 4-1  Compose Character Sequences

" quotation mark ¨ space

# number sign + +

' apostrophe ' space

@ commercial at a a or A A (Multinational)

a a or A A or a A (National)

[ opening bracket ( (

\ back slash / / or / <
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Table 4-1  Compose Character Sequences (continued)

] closing bracket ) )

ˆ circumflex accent ^ space

` grave accent ` space

{ opening brace ( -

| vertical line / ^

} closing brace )- 

˜ tilde ~ space

¡ inverted ! ! !

¢ cent sign c / or C / or c | or C |

£ pound sign l - or L - or l = or L =

¥ yen sign y - or Y - or y = or Y =

§ section sign s o or S O or s ! or S ! or s 0 or S 0 (National and
Multinational)

National includes s O or S o

¤ currency sign x o or X O or x 0 or X 0

© copyright sign c o or C O or c 0 or C 0

ª feminine ordinal indicator a - or A _

« double open angle brackets < <

° degree sign 0 ^ (Multinational)

° space (National)

± plus or minus sign + -

² superscript 2 2 ^

³ superscript 3 3 ^

µ micro sign / u or / U (in order)

¶ paragraph sign p ! or P !

· middle dot . ^

¹ superscript 1 1 ^

º masculine ordinal indicator o _ or O _

» double closed angle brackets > >

¼ fraction one-quarter 1 4 (in order)

½ fraction one-half 1 2 (in order)

¾ fraction three-quarters (Dutch) 3 4 (in order)

ƒ Florin (Dutch) f l (in order)
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Table 4-1  Compose Character Sequences (continued)

i j sign (Dutch) i j (in order)

¿ inverted ? ? ?

À A grave A `

Á A acute A '

Â A circumflex A ^

Ã A tilde A ˜

Ä A umlaut A " or ¨ A

Å A ring A * or A ° (degree sign)

Æ A E dipthong A E (in order)

Ç C cedilla / u or / U (in order)

È E grave E `

É E acute E '

Ê E circumflex E ^

Ë E umlaut E " or ¨ E

Ì I grave I `

Í I acute I '

Î I circumflex I ^

Ï I umlaut I " or ¨ I

Ñ N tilde N ˜

Ò O grave O `

Ó O acute O '

Ô O circumflex O ^

Õ O tilde O ˜

Ö O umlaut O " or ¨ O

Œ O E dipthong (DEC Multinational) O E (in order)

Ø O slash O /

Ù U grave U `

Ú U acute U '

Û U circumflex U ^

Ü U umlaut U " or ¨ U

Ÿ Y umlaut (DEC Multinational) Y " or ¨ Y

ß German small sharp s s s

à a grave a `
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Table 4-1  Compose Character Sequences (continued)

á a acute a '

â a circumflex a ^

ã a tilde a ˜

ä a umlaut a " or ¨ a

å a ring a * or a ° (degree sign)

æ a e dipthong a e (in order)

ç c cedilla c , (comma)

è e grave e `

é e acute e '

ê e circumflex e ^

ë e umlaut e " or ¨ e

ì i grave i `

í i acute i '

î i circumflex i ^

ï i umlaut i " or ¨ i

ñ n tilde n ˜

ò o grave o `

ó o acute o '

ô o circumflex o ^

õ o tilde o ˜

ö o umlaut

œ o e dipthong (DEC Multinational) o E (in order)

ø o slash o /

ù u grave u `

ú u acute u '

û u circumflex u ^

ü u umlaut u " or ¨ u

ÿ y umlaut y ' or ¨ y

nbsp non-breaking space space space

¦ broken vertical bar (latin-1) | | or ! ^

¬ logical not (Latin-1) - , (in order)

soft (syllable) hyphen (Latin-1) - -

® registered trade-mark (Latin-1) R O
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Table 4-1  Compose Character Sequences (continued)

¯ macron (Latin-1) - ^ or _ ^

¾ three-quarters (Latin-1) 3 4

÷ division sign (Latin-1) - :

× multiplication sign (Latin-1) x x

´ acute accent (Latin-1) ' '

¨ dieresis (umlaut) (Latin-1) " " or " space

Ý Y acute (Latin-1) Y '

ý y acute (Latin-1) y '

Þ capital Icelandic thorn (Latin-1) T H (in order)

þ small Icelandic thorn (Latin-1) t h (in order)

Ð capital Icelandic Eth (Latin-1) - D

ð small Icelandic Eth (Latin-1) - d
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5 Mouse Functions

Default Mouse Functions
You can assign up to sixteen functions to each of the mouse buttons when used in conjunction with
modifier keys. The following functions are defined by default:

Button Modifier Keys Click Double-Click

Left Button  Select Move Cursor

 Shift+ Extend Selection  

 Control+ Paste  

 Shift+Control+ Copy Paste  

 Alt+ Select Rect  

Right Button  Copy  

 Shift+  Select Word

 Shift+Control+  Select Line

 Alt+ Send CR  

Middle Button  Paste Move Cursor

Defining Mouse Functions
You can redefine the functions assigned to the mouse buttons using the Mouse Action Settings
dialog. This enables you to specify the functions of the mouse buttons when single or double-clicked
on their own or in conjunction with modifier keys.

The Mouse Action Settings dialog can be displayed using one of the following methods:

Using the Session Wizard

◦ Click on the Mouse Actions... button in Step 2.

Using the TeemTalk Window

◦ Select Mouse Actions... on the Tools menu.
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You can assign up to sixteen functions to each button by selecting from a list of standard
functions described in the next section or defining macros as described in the section Defining a
Macro on page 40.

Standard Mouse Functions
● Select 

This will select all text from the start position (mouse button held down) to the finish position
(mouse button released), working left to right across the entire width of the display.

● Extend Selection 

Enables the current selection to be extended.

● Copy 

This will copy the current selection to the Clipboard.

● Paste 

This will paste the contents of the Clipboard at the current cursor position.

● Move Cursor 

When the emulator is in any of the local block modes you can use the mouse instead of the
cursor keys to position the text cursor using this function.

● Select Rect 

This will only select text contained within the rectangular area defined by the start position
(mouse button held down) which sets the top left corner, and the finish position (mouse button
released) which sets the bottom right corner of the rectangular area.

● Select Word 

This will select the word under the mouse cursor.

● Select Line 

This will select the entire line under the mouse cursor

● Copy Paste 
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Copies the current selection and sends it to the host.

● Macro 

Actions a user-defined macro. See Defining a Macro on page 40.

● Send CR 

Sends a carriage return command.

● Paste Rect 

This will paste the contents of the Clipboard into the rectangular area selected by the Select
Rect function.

● Cursor Select 

This does the same as Move Cursor, but when running the IBM 3270 or IBM 5250 emulation it
also performs a cursor select.

Defining a Macro
You can assign a macro to a mouse button or button and modifier key combination as follows:

1. In the Mouse Action Settings dialog select the Macro option from the drop-down list for the
button or button and modifier key combination required. Click OK to close the dialog.

2. Display the Key Macro Settings dialog.
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3. In the Virtual Keys box, scroll down to the bottom of the list and you will see six virtual key
names for the three mouse buttons when clicked (VK_MSE_B#_CLK) or double-clicked
(VK_MSE_B#_DBL). Note that the middle mouse button is number 4.

4. If you are defining a button and modifier key combination, hold down the modifier key(s).

5. Double-click on the virtual key name of the button to be programmed (then release the modifier
key(s) if pressed).

The Key to Program field will display the virtual key name(s) of the button and modifier key(s)
pressed.

6. Enter the macro definition in the Macro box, either by entering your own definition as described
in the appendix Programming Keys and Buttons on page 243, or selecting standard key
functions in the Emulation Keys and Virtual Keys list boxes.

TIP: For more information about using the Key Macro Settings dialog, refer to the section
Defining Key Functions on page 30.

7. Click OK when you have finished.
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6 Hotspots

This chapter describes the hotspot facility and how to use the Hotspot Editor to define hotspots.

Introduction
A hotspot facility is provided which enables you to invoke a function with a mouse click on a keyword
displayed in the emulation workspace. For example, an application may display information relating to
keys you can press to perform a particular function. Instead of pressing the key on the keyboard, you
could invoke the function by clicking on the key name on the display using the mouse button or key +
mouse button combination which was assigned to the Action Hostspot function.

Hotspots are supported in all terminal emulation modes. A set of default keywords is provided for
each mode. These keywords relate to key functions specific to the emulation. For example, in VT500
mode you can click on the word Help displayed on the screen and the emulator will execute the
function associated with the Help key.

Using Hotspots
In order to use hotspots, you must first assign the Action Hotspot function to a mouse button or key +
mouse button combination in the Mouse Action Settings dialog (refer to the chapter Mouse
Functions on page 38 for details).

You can also identify hotspots that are currently present in display memory by assigning the Show
Hotspots function to any mouse button or key + mouse button combination in the Mouse Action
Settings dialog. When the assigned mouse button or key + mouse button combination is clicked, all
color attributes will be temporarily removed from the display and the hotspot's text color will be
changed to red. Releasing the mouse button or key + mouse button combination will return the
display to its original state.

The Hotspot Editor
The Hotspot Editor enables you to customize the hotspots available for the current TeemTalk
session. To display the Hotspot Editor, select Hotspots... from the File menu.
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Defining a Hotspot
At the top of the Hotspots Settings dialog is an editable text box containing the hotspot details. The
details are divided into two sections, the [Separators] and the [Definitions,emulation], where
emulation is the current selected emulation mode.

The Separators section specifies the displayed characters which delimit a hotspot definition.

NOTE: Delimiter characters include SPACE and NULL as well as the characters shown.

The start and end delimiter characters do not have to be the same character. Delimiters are
necessary to prevent hotspots from occurring within words that happen to contain the same sequence
of characters. For example, if you have a hotspot defined for the keyword end, the separators would
prevent a hotspot from appearing in the word append.

The Definitions section lists the hotspot definitions. Each hotspot definition appears one per line in
the form Keyword=Action, where Keyword is the display text that will form the hotspot, and Action is
the function that will be performed when the hotspot is clicked with the mouse button or key + mouse
button combination defined as Action Hotspot. The action for the hotspot definition can contain a
single key function (virtual key name). Please refer to Virtual Key Names on page 245 for a list of
valid keys for the selected emulation mode.

Saving the Hotspots
Hotspot definitions are saved with your sessions by selecting Save Session or Save Session As
from the File menu. The hotspot definitions are stored in the session file along with other session
details.

Exporting Hotspots
If you wish to use your hotspot definitions in another session or just want a backup of your hotspot
definitions, you can export the current hotspot definitions by clicking Export in the Hotspot Editor. A
standard Windows Save As dialog will assist you in specifying the path and file into which you wish to
save the definitions. TeemTalk will save the definitions in XML format if the file name ends with
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the .xml extension; otherwise the hotspot definitions will be exported in plain text format. When
providing the file name, you must specify the extension. Enter the file name and click Save.

Importing Hotspots
You can import hotspot definitions from previous exported definitions or directly from another
TeemTalk session file by clicking Import in the Hotspot Editor. Use the file browser to locate and
select the file containing the hotspot definitions you want imported and then click Open.

NOTE: Only definitions that match the currently selected emulation will be imported and the import
will replace all current definitions.
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7 Soft Buttons

This chapter describes how to use the soft buttons.

Introduction
A set of soft buttons are provided which can be programmed to perform a wide variety of functions
when clicked. By default they are displayed at the bottom of the TeemTalk window.

There are four soft button levels. Each level consists of twelve buttons providing a combined total of
48 programmable buttons. You can display all four levels at the same time if required. All levels are
accessible even if not all are displayed, levels stored off-screen can be 'scrolled' into view by clicking
the Level # button.

The button below the Level # button on each level cannot be programmed, but it has two uses. It can
be used to scroll through the available levels in reverse order, and you can specify text to be
displayed on it as a label describing the buttons on that level.

You can detach the soft buttons so that they are displayed in a separate window either by clicking the
Restore Down button above the top-right soft button, or by unchecking the Attached to the window
option in the Soft Button Settings dialog.

To re-attach the soft buttons to the TeemTalk window, either double-click on the title bar of the Soft
Buttons window, or select the Attached to the window option in the Soft Button Settings dialog.

You can remove the soft buttons from the display either by selecting Windows > Soft Buttons from
the View menu so that it is unchecked, or in the Soft Button Settings dialog by setting the Visible
Levels option to 0.

To re-display the soft buttons, either select Windows > Soft Buttons from the View menu so that it
is checked, or in the Soft Button Settings dialog, set the Visible Levels option to any number other
than 0.

Defining Soft Button Functions
Soft button functions are defined using the Soft Button Settings dialog which can be displayed using
one of the following methods:

Using the Session Wizard

◦ Click on Soft Buttons... in Step 2

Using the TeemTalk Window

◦ Select Soft Buttons... on the Tools menu.
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The top right panel is used to display information about soft buttons that have been programmed and
enables you to select them in order to edit or delete. The Title column displays the text that will
appear on the soft button. An asterisk in the Lcl column indicates that the function will be actioned
locally. The Macro column displays the function definition.

The Emulation Keys list box enables you to select from a list of standard key functions specific to the
currently selected terminal emulation. The information in brackets in the right column indicates the
default mapping of the key function by TeemTalk. For example:

WY_INSLINE (S+C+VK_INSERT)

indicates that the Wyse emulation Insert Line function is mapped to the key combination Shift +
Control + Insert on a standard Enhanced AT keyboard.

The Virtual Keys list box enables you to select from a list of standard key functions available for all
terminal emulations.

The procedure for defining a soft button is as follows:

1. In the top-right panel, select the button number (B1 - B12) on the required level (Lvl1 - Lvl4).

Note that selecting one of the Lvl# button levels will enable you to specify a title for that group of
buttons. The title will be displayed on the button immediately below the Level # button, but you
cannot program this button.

2. In the Title box enter the text to be displayed on the button (up to twenty characters).
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3. In the Macro box enter the function definition for the button.

The definition can contain key functions and control characters to be actioned as well as normal
text. Refer to the appendix Programming Keys and Buttons on page 243 for details.

Double-clicking on an Emulation Key or Virtual Key will apply that key function to the button
definition.

4. Test the function definition by clicking the Play Macro button.

5. If you want the function to be performed locally only, check the Local box.

6. Specify how many soft button levels you want to be displayed at any one time using the Visible
Levels selection list. You can display up to four levels at a time with each level containing twelve
programmable soft buttons. Selecting 0 will remove the soft buttons from the display.

7. If you want the soft buttons displayed in a separate window, uncheck the Attached to the
window option.

8. When you have finished defining soft button functions, click OK.

9. To save the soft button settings, select File > Save Session.
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8 Display Attributes

This chapter describes how to change the colors used in the emulation workspace and specify how
text with attributes is displayed.

Introduction
TeemTalk provides a variety of options for you to customize how the display appears in the emulation
workspace. You can change the color of the screen background and the foreground text. You can
assign different colors to text with specific attributes or attribute combinations, and you can change
the default text attributes.

Text with attributes can be displayed in various ways. For example, characters with the underline
attribute can be displayed as standard (e.g. underlined only), as a particular color only (e.g. green
without the underline), or with both attribute and a specific color (e.g. underlined and green).

This chapter describes how to use the Attributes dialog to specify the display settings you prefer.

The Attributes Dialog
The Attributes dialog can be displayed using one of the following methods:

Using the Session Wizard

◦ Click on the Attributes... button in Step 2.

Using the TeemTalk Window

◦ Select Attributes... on the Tools menu.
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The Screen Element list box enables you to select the display element you want to modify. This
includes each character attribute (such as bold or underline) and attribute combination (such as bold
+underline).

The Foreground and Background color palettes enable you to specify the colors for the selected
Screen Element. You can select different colors for the palettes by clicking the Set Colour button.

The Active Attribute options allow you to enable or disable the attributes assigned to text by default.
For example, if you want characters normally displayed with the underline attribute to be displayed
without the underline, select the Underline (UL) option in the Screen Element list box then uncheck
the Underline (UL) option under Active Attribute.

The Sample Text box is used to show how the attribute settings currently applied to the selected
screen element will appear on the display.

The Preferences list box enables you to select additional display options, some of which are terminal
emulation specific. For example, the AutoColour Mode option is only applicable to DEC VT terminal
emulations and when selected will cause displayed characters to be color coded according to type
(numeric, alphabetic, etc.).
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Changing the Screen Background Color
To change the color of the screen background:

1. Select Screen Background in the Screen Element list box. The Sample Text box will show the
current color assigned.

2. Click on the desired color in either the Foreground or Background color palettes. The Sample
Text box will show the new color selection.

Changing Text Foreground and Background Colors
To change text foreground and background colors:

1. In the Screen Element list box, select Normal Text or one of the character with attributes(s)
options such as Underline (UL) or IN+UL for inverse+underline (see note below). The Sample
Text box will show the current colors assigned.

2. Click on the desired color for the text character in the Foreground color palette, and click on the
desired color for the character cell background in the Background color palette. The Sample
Text box will show the new color selection.

NOTE: Each character attribute and attribute combination has its own color foreground and
background setting. The Normal Text option will only affect text with no attributes.

Disabling an Attribute
To disable an attribute assigned to text (e.g. turning off the blinking attribute):

1. In the Screen Element list box, select the text attribute or attribute combination containing the
attribute you want to disable.

2. In the Active Attribute list, uncheck the box next to the attribute you want to disable.

Preferences
The Preferences options in the Attributes dialog enable you to select additional display options,
some of which are terminal emulation specific.

● Attribute implies a colour

Factory default: Unchecked

This option allows you to enable or disable the color associated with an attribute.

● Inverse Colours

Factory default: Unchecked

When this option is checked, characters with the inverse attribute will have the text (foreground)
color swapped with that of the text cell (background).

● Swap Black/White

Factory default: Unchecked

When checked, anything that has the white attribute will be displayed as black, and vice versa.
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● Autocolour Mode

Factory default: Unchecked

This option is only applicable to the DEC VT terminal emulations. When checked, displayed
characters are color coded according to type. For example, all numeric characters are displayed
in one color while all alphabetic characters are displayed in another. Unchecking this option will
cause characters to be displayed using the settings in this dialog.

● Ansi Colours Disabled

Factory default: Unchecked

Selecting this option will cause ANSI color commands to be ignored.

● Colours Clear with Attributes

Factory default: Checked

The setting of this option determines whether the foreground and background colors are cleared
to the default colors when an ANSI clear attributes command is received.

● Start Fields use Normal BG

Factory default: Unchecked

This option only applies to the IBM 3270 Display emulation. If attribute indicators take up
character positions on the screen, you can force those positions to display the normal
background color instead of the attributes by selecting this option.

● Use Italic with Intensity

Factory default: Unchecked

Selecting this option will cause any characters that have the intensity (bold) attribute to be
italicized.

● Use Font with Intensity

Factory default: Unchecked

Selecting this option will cause all characters to be displayed using a bold font.

● Blink Underline

Factory default: Unchecked

Selecting this option will cause characters with the underline attribute to blink.

● Blink Column Separators

Factory default: Unchecked

Selecting this option will cause column separators to blink.

● Blink Foreground/Background

Factory default: Unchecked

Selecting this option will cause the foreground and background colors to alternate.
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9 Editing Options

This chapter describes how to use the editing options provided on the Edit menu.

The Edit Menu
The Edit menu provides a range of editing options.

● Clipboard Options 

This displays the Clipboard Options dialog that enables you to specify how data is copied. The
options in this dialog are described in the section Clipboard Options on page 53.

● Clear Buffer 

This will erase the contents of the window and the scroll buffer.

● Copy 

The Copy command becomes available when data has been selected. It will cause the currently
selected text to be copied to the Clipboard in the format specified in the Clipboard Options
dialog. The data can then be inserted in a different location using the Paste command. The next
block of data that is copied will delete the previous block on the Clipboard.

● Paste 

This will cause data that has been copied to the Clipboard to be pasted at the current cursor
position. The same block of data may be pasted repeatedly as the Clipboard stores it until the
Copy command is used again.

● Paste Rect 

This will paste the contents of the Clipboard into the rectangular area selected by the Select
Rect function.

By default the Select Rect function is actioned by holding down the Alt key and pressing the left
mouse button. It will only select text contained within the rectangular area defined by the start
position (mouse button held down) which sets the top left corner, and the finish position (mouse
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button released) which sets the bottom right corner of the rectangular area. Refer to the chapter
Mouse Functions on page 38 for more details.

● Select All 

This will select the contents of the window (not the entire buffer)

Clipboard Options

The Clipboard Options dialog is displayed by selecting Clipboard Options... on the Edit menu.

● Format

Factory default: Text

This setting determines the format in which data is copied.

Selecting Text will enable a standard copy of selected text.

Selecting Bitmap will enable graphics to be copied in device independent bitmap format.

● Parse On

Factory default: None

This option enables you to specify that copied text is tab delimited either at the end of each word
or at the end of each field. This is useful when you want to paste data into cells.

● Field Element

Factory default: Both

This option enables you to specify that only text in protected fields is copied, only text in
unprotected fields, or both.
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10 Printing

This chapter describes the printing options supported by TeemTalk.

File Menu Printing Options
This section describes the printing options available via the File menu.

Print Screen
Selecting Print Screen... in the File menu will display a dialog that enables you to produce a
hardcopy of the current screen data.

The default printing options are to print plain text by default with the Fit to Page and Inverse options
disabled.

● Graphics

Factory default: Unchecked

Causes all data in the emulation workspace to be printed as a bitmap image. The hardcopy
output will be an almost exact representation of the emulation workspace. Note that a graphics
print will take a lot longer than a text print.

● Fit to Page

Factory default: Checked

This option is enabled only when the Graphics print option is selected. Selecting this option will
cause the emulator to print as large an image as possible on the printer’s paper. When this
option is not selected, a pixel-by-pixel print of the screen will be printed which will generally be
smaller, depending on the printer's resolution.

● Inverse

Factory default: Unchecked
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This option is enabled only when the Graphics print option is selected. Selecting this option will
cause the bitmap printed to be a negative image of the display.

● Swap Black White

Factory default: Checked

This option is enabled only when the Graphics option is not selected. Selecting this option will
cause white to be printed as black and black to be printed as white. Other colors are unaffected
by this option.

● Monochrome

Factory default: Unchecked

Printing will be in black and white only.

● Horizontal position

Factory default: Left

Causes the print output to be positioned on the left or right side of the page or to be centered on
the page.

● Vertical position

Factory default: Top

Causes the print output to be positioned on the top or bottom of the page or to be centered on
the page.

Clicking OK causes the screen printing to occur without using the emulation printer functionality.
Clicking Emulation Printer will cause the print output to be processed through the Emulation Printer.

Print Buffer
Selecting Print Buffer in the File menu will send a copy of all the data contained in the window buffer
to the currently selected printer.

Auto Print
Selecting Auto Print in the File menu will toggle auto print mode on and off, as indicated in the File
menu when auto print mode is on. Auto print mode causes each line of data to be transmitted to the
printer when the cursor moves to a new line as a result of a carriage return, line feed, vertical tab, or
form feed.

Eject Page
Selecting Eject Page in the File menu will enable data that has been spooled to the printer to be
printed.

Emulation Printer Settings
The Emulation Printer Settings dialog is displayed by selecting Emulation Printer... in the File
menu. The following sections describe the functions of the tabs that appear in the dialog.
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Status
The Status tab will indicate the current status of the printer. This tab also provides buttons which
allow you to perform several print operations.

● Screen Print

Print a fast print of the screen using Unicode.

● Print Buffer

Send a copy of all the data contained in the window buffer to the currently selected printer.

● Start/End Auto Print

Ttoggle auto print mode on and off. Auto print mode causes each line of data to be transmitted
to the printer when the cursor moves to a new line as a result of a carriage return, line feed,
vertical tab, or form feed.

● Eject Page

Cause data that has been spooled to the printer to be printed.

● Close Now

Close the printer.

● Abort Print

Cancel a Print Screen or Print Buffer function.

Settings
The Settings tab provides controls to adjust the details of how the data is sent to the printer.
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● Printer Method

Factory default: Print to System Printer

◦ Print to File Send print data to a file.

◦ Print to System Printer Send print data to the printer connected to your system.

◦ Print to Serial Device Send print data to a serial device.

◦ Print to LinePrinter Device Send print data to a line printer (LPT) device.

◦ Print to LPR Send print data to a network printer.

● Throw page on close

Factory default: Unchecked

When this option is checked, a form feed will be issued when closing the printer. This is required
for most page printers.

● Remove Trailing Spaces

Factory default: Unchecked

When this option is checked, any trailing spaces will be removed before the line is sent to the
printer.

● Wait for printer to close

Factory default: Unchecked

This option is only available when either the Print to Serial Device or the Print to LinePrinter
Device printer method is selected. When this option is checked, all other processing will be
blocked during printing. Please note that the application will be locked during a close if the
buffers require flushing.

● Close delay
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Factory default: 0 (zero)

Specifies the time (in tenths of a second) to wait before closing. Note that the printer will not be
closed if a new open is requested before time out. The application will be blocked during a close
if the buffers require flushing. Specifying a large value can avoid blocking.

● Output Character Set

Factory default: Iso Latin-1

The character translation used by the printer.

● PC Ansi Codepage

Factory default: PC Multinational (437)

The codepage value when the Output Character Set is set to PC Ansi.

Advanced
The following sections describe the options available in the Advanced tab of the Emulation Printer
Settings dialog box. The options available vary depending on the current Printer Method setting in
the Settings tab.

Print to File

The following are the options available when the Printer Method option on the Settings tab is set to
Print to File.
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● File Name

Factory default: Unspecified

The name of the file to which the print data should be sent.

● Mode

Factory default: Write (destroy existing)

The mode in which the file is opened.

◦ Write Causes the contents of an existing file to be replaced with new print data.

◦ Append Causes print data to be appended to existing file contents.

◦ User Defined Mode Enables the User Defined Mode option.

● User Defined Mode

Factory default: wb+

When Mode is set to User Defined, this settings allows you to specify the mode in which the file
is opened.

● Process CR/LF/FF

Factory default: Unchecked

When checked, a Carriage Return or Line Feed command will output a new line, and a Form
Feed command will output a new page.
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● Extended string value for new line

Factory default: \r\n

You can specify an extended string value for a new line using any of the following entries: \a, \b,
\f, \n, \r, \t, \v, or \(decimal), \(0octal), \(0xHexadecimal).

● Extended string value for new page

Factory default: \f

You can specify an extended string value for a new page using any of the following entries: \a,
\b, \f, \n, \r, \t, \v, or \(decimal), \(0octal), \(0xHexadecimal).

Print to System Printer

The following are the options available when the Printer Method option on the Settings tab is set to
Print to System Printer.

● Setup System Printer

Clicking this button will display the standard Windows Print dialog for specifying printer settings.

● System Printer

Displays the name of the currently selected system printer.

● Paper Orientation

Factory default: Use printer default
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Determines the paper orientation of the print output.

◦ Use printer default the paper orientation is determined by the setting in the standard
Windows Print dialog.

◦ Landscape Output prints in landscape mode.

◦ Portrait

Output prints in portrait mode.

● Process CR/LL/FF

Factory default: Unchecked

When checked, a Carriage Return or Line Feed command will output a new line, and a Form
Feed command will output a new page.

Print to Serial Device

The following are the options available when the Printer Method option on the Settings tab is set to
Print to Serial Device.
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● Communications Port

Factory default: COM1

Specifies the COM port to use for printer communication.

● Baud Rate

Factory default: 9600

Specifies the connection speed in the range 110 to 115200 baud.

● Parity

Factory default: None

This option specifies the parity mode for each transmitted character. If the number of data bits
specified by Word Length is 8, set this option to None.

Selecting Odd will cause an eighth bit to be added with a value of 1 if the previous 7 bits add up
to an even number, and 0 if the previous 7 bits add up to an odd number.

Selecting Even will cause an eighth bit to be added with a value of 1 if the previous 7 bits add up
to an odd number, and 0 if the previous 7 bits add up to an even number.

Mark parity will set every eighth bit to 1.

Space parity will set every bit to 0.

● Word Length
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Factory default: 8

Specifies the number of data bits sent for each transmitted character.

● Stop Bits

Factory default: 1

Specifies the number of stop bits sent for each transmitted character.

● Flow Control

Factory default: Both

This option specifies the type of flow control used by the line port to communicate readiness to
transmit or receive data from the host.

◦ None No flow control.

◦ Input XON/XOFF on received data.

◦ Output XON/XOFF on transmitted data.

◦ Both XON/XOFF on transmitted andreceived data.

◦ Hardware RTS/CTS hardware flow control.

● Buffer Size

Factory default: 4096

Specifies the size of the buffer used for temporary storage of input and output data.

● Block on Full

Factory default: Unchecked

Determines the action to take when the print buffer becomes full. Checking this option will cause
all actions to be blocked until the print buffer is ready to receive new data.

● Process CR/LF/FF

Factory default: Unchecked

When checked, a Carriage Return or Line Feed command will output a new line, and a Form
Feed command will output a new page.

● Extended string value for new line

Factory default: \r\n

You can specify an extended string value for a new page using any of the following entries: \a,
\b, \f, \n, \r, \t, \v, or \(decimal), \(0octal), \(0xHexadecimal).

● Extended string value for new page

Factory default: \f

You can specify an extended string value for a new page using any of the following entries: \a,
\b, \f, \n, \r, \t, \v, or \(decimal), \(0octal), \(0xHexadecimal).
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Print to LinePrinter Device

The following are the options available when the Printer Method option on the Settings tab is set to
Print to LinePrinter Device.

● Printer Port

Factory default: LPT1

Specifies the LPT port to use for printer communication.

● Size

Factory default: 4096

Specifies the size of the buffer used for temporary storage of input and output data.

● Process CR/LF/FF

Factory default: \r\n

When checked, a Carriage Return or Line Feed command will output a new line, and a Form
Feed command will output a new page.

● Extended string value for new line

Factory default: \f
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You can specify an extended string value for a new page using any of the following entries: \a,
\b, \f, \n, \r, \t, \v, or \(decimal), \(0octal), \(0xHexadecimal).

● Extended string value for new line

Factory default: Unchecked

You can specify an extended string value for a new page using any of the following entries: \a,
\b, \f, \n, \r, \t, \v, or \(decimal), \(0octal), \(0xHexadecimal).

Print to LPR

The following are the options available when the Printer Method option on the Settings tab is set to
Print to LPR.

● LPR Host Name

Factory default: Unspecified

The name or IP address of the printer host.

● LPR Printer Name

Factory default: Unspecified

The name of the LPR printer.

● Extended string value for LPR Header

Factory default: Unspecified
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You can specify an extended string value to be sent to initialize LPR using any of the following
entries: \a, \b, \f, \n, \r, \t, \v, or \(decimal), \(0octal), \(0xHexadecimal).

● Extended string value for LPR Trailer

Factory default: Unspecified

You can specify an extended string value to be sent to trail LPR using any of the following
entries: \a, \b, \f, \n, \r, \t, \v, or \(decimal), \(0octal), \(0xHexadecimal).

● Process CR/LF/FF

Factory default: Unchecked

When checked, a Carriage Return or Line Feed command will output a new line, and a Form
Feed command will output a new page.

● Extended string value for new line

Factory default: \r\n

You can specify an extended string value for a new page using any of the following entries: \a,
\b, \f, \n, \r, \t, \v, or \(decimal), \(0octal), \(0xHexadecimal).

● Extended string value for new page

Factory default: \f

You can specify an extended string value for a new page using any of the following entries: \a,
\b, \f, \n, \r, \t, \v, or \(decimal), \(0octal), \(0xHexadecimal).
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11 VT Series Emulation

This chapter describes features of the Digital Equipment Corporation VT suite of terminal emulations.

Introduction
The VT Series suite of terminal emulations consists of the following emulations which can be selected
using the Emulation mode option in the VT Series Settings dialog:

● AIXTerm  

Provides compatibility with software designed to drive an X terminal using X Windows.

● Ansi BBS  

This emulation is a derivative of the ANSI device driver ANSI.SYS supplied with all DOS based
PCs and which provides the screen management for the DOS console screen. PC based UNIX
systems and Bulletin Board Systems (BBS) often rely on the ANSI emulation when being
accessed by a PC. In ANSI BBS mode the screen size is adjusted to 25 lines and the preferred
character set is set to ANSI.

● AT 386  

Provides compatibility with software designed to drive the AT&T AT 386 terminal.

● ATT4410  

Provides compatibility with software designed to drive the AT&T Dataspeed 4410 terminal. Refer
to the section AT&T 4410 Emulation on page 74 for details.

● Sco Console  

This is an emulation of the SCO UNIX box.

● VT PCTerm  

Provides compatibility with software designed for the PC Term mode supported by DEC.

● VT52 and VT100

These emulations enable you to run applications written for the DEC VT52 and VT100 terminals,
respectively.

● VT100+  

This emulation is an enhanced version of the VT100 emulation that provides additional
functionality such as colors. It is the same as the VT-UTF8 emulation except that it only supports
ASCII characters 0-127 (decimal).

● VT+HP220  

This emulation is based on the VT500 terminal series and includes the HP function keys F1 - F8
(not user programmable). The terminal ID is set to VT220.
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● VT510 7-Bit and VT510 8-Bit

These emulations enable you to run applications written for the DEC VT320 terminal, the
difference is in their treatment of 8-bit control codes. When VT510 7-Bit is selected, all 8-bit
codes are converted to their 7-bit equivalents, whereas VT510 8- Bit leaves 8-bit codes
unchanged. If you are using VT200 applications, select VT510 7-Bit.

● VT-UTF8  

This emulation is an enhanced version of the VT100 emulation that supports non-English and
drawing characters. It supports localization of the single-byte and double-byte character sets and
all other languages supported by Windows. Additional functionality, such as colours, is also
provided.

Creating a VT Series Emulation Session
You can create a session either using the TeemTalk Session Wizard or while TeemTalk is running.

Using the TeemTalk Session Wizard
This section describes how to use the TeemTalk Session Wizard to create an VT Series emulation
session.

1. To run the TeemTalk Session Wizard from the Start menu, select All Programs > HP > HP
TeemTalk Terminal Emulator > Session Wizard.

2. In the Session Name field, enter a unique name that will identify this session configuration for
future selection.

3. Select the Transport method then click the Configure button to specify settings.

4. Select the Connection type then click the Configure button to specify settings.

5. Select VT Series in the Emulation list box then click the Configure button to specify settings.
(The options are described in the section Setup Options on page 76.)

6. Click Next to display the Advanced Options dialog.

7. Click Next to display the Finalization dialog.

8. If you want a shortcut icon for this session to be created on the desktop, click the checkbox
Create icon on desktop for session.

9. Click OK to create the session and exit.

10. To run the session, either double-click on the desktop icon if one was created for the session, or
run TeemTalk, display the File menu and select Open Session. Select the name of the
required .tts session file then click Open.
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Using the TeemTalk Emulator Window
This section describes the procedure for creating a VT Series emulation session from the TeemTalk
emulator window.

1. Display the Session menu from the menu bar and select Transport... to set the transport
method.

2. Display the Session menu and select Connection... to set the connection method.

3. Display the Session menu and select Emulation.... Set the emulation to VT Series.

4. You can configure the transport, connection and emulation settings by selecting the relevant
Configure options in the Session menu. The options displayed by selecting Configure
emulation are described in the section Setup Options on page 76.

5. To save the session, display the File menu and select Save session as. In the File Name field,
enter a unique name that will identify this session configuration for future selection, then click
Save. Note that session files have the filename extension .tts.

6. To run the session, display the File menu and select Open Session. Select the name of the .tts
session file then click Open.

Keyboard Mapping
The functions of the computer keyboard are mapped as closely as possible to the terminal being
emulated. The mapping of key functions can be determined by referring to the Emulation Keys list
box in the Key Macro Settings dialog, which is displayed by selecting Key Macros... on the Tools
menu.

The information in brackets in the right column indicates the default mapping of the key function
named in the left column. In the list, S+ indicates the Shift key, C+ indicates the Control key and A+
indicates the Alt key. For example:

VT_F20 (A+VK_F10)

indicates that the F20 function is mapped to the key combination Alt + F10.

The keyboard has operating two modes, Normal or DEC. You can toggle between the two modes by
pressing the keys Alt + Num Lock together. The 9th item on the status bar will display DEC when the
keyboard is in DEC mode.

Special key functions usually found on a DEC VT keyboard can be mapped to any key on your
keyboard using the VT virtual key names listed in the Key Macro Settings dialog.

The illustrations on the following pages show where DEC VT510 keyboard functions are mapped to
keys on a 101/102 key keyboard.
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101/102 Keyboard Layout/Normal Mode
Figure 11-1  101/102 Key Keyboard Layout Normal Mode

Table 11-1  VT Series keyboard layout: Normal mode.

Key Key Modifier Result  Key Key Modifier Result

1
none

Alt +

PF1

F11

 
14

 
BREAK

2
none

Alt +

PF2

F12

 
15

none

Shift +

DELETE

BACKSPACE

3
none

Alt +

PF3

F13

 
16

 
FIND

4
none

Alt +

PF4

F14

 
17

 
INSERT HERE

5 Alt + HELP  18  REMOVE

6
none

Alt +

F6

DO

 
19

 
SELECT

7
none

Alt +

F7

F17

 
20

 
PREVIOUS SCREEN

8
none

Alt +

F8

F18

 
21

 
NEXT SCREEN

9
none

Alt +

F9

F19

 

22

none

Alt +

Ctrl +

UP

COMPOSE CHARACTER

SCROLL UP

10
none

Alt +

F10

F20

 
23

none

Ctrl +

LEFT

SCROLL LEFT
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Table 11-1  VT Series keyboard layout: Normal mode. (continued)

Key Key Modifier Result  Key Key Modifier Result

11

 

F11

 

24

none

Alt +

Ctrl +

DOWN

DATATALK

SCROLL DOWN

12
 

F12
 

25
none

Ctrl +

RIGHT

SCROLL RIGHT

13

Alt +

Shift + Alt +

PRINT

PRINT SCROLLING
REGION

 

26
none

Alt +

NUMLOCK

normal/DEC mode

NOTE: All unmarked keys function as indicated by the legends on the keycaps.

NOTE: Pressing Alt + NumLock toggles between normal and DEC mode.
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101/102 Keyboard Layout/DEC Mode
Figure 11-2  101/102 Key Keyboard Layout DEC Mode

Table 11-2  VT Series keyboard layout in DEC mode.

Key Key Modifier Result  Key Key Modifier Result

1
none

Alt +

PF1

F11

 
13

none

Alt +

BACKSPACE

DELETE

2
none

Alt +

PF2

F12

 
14

 
FIND

3
none

Alt +

PF3

F13

 
15

 
INSERT HERE

4
none

Alt +

PF4

F14

 
16

 
REMOVE

5
none

Alt +

BREAK

HELP

 
17

 
SELECT

6
none

Alt +

F6

DO

 
18

 
PREVIOUS SCREEN

7
none

Alt +

F7

F17

 
19

 
NEXT SCREEN

8
none

Alt +

F8

F18

 
20

none

Alt +

PF1

Normal/DEC mode

9
none

Alt +

F9

F19

 
21

 
PF2
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Table 11-2  VT Series keyboard layout in DEC mode. (continued)

Key Key Modifier Result  Key Key Modifier Result

10
none

Alt +

F10

F20

 
22

 
PF3

11
 

F11
 

23
none

Alt +

PF4

-

12
 

F12
 

24
none

Alt +

+

,

NOTE: All unmarked keys function as indicated by the legends on the keycaps.

NOTE: Pressing Alt + NumLock toggles between normal and DEC mode.

The Status Bar
Below the emulation workspace in the TeemTalk window is a status bar that indicates the status of
various operations and provides buttons for switching between modes. The information displayed in
the status bar depends on the current terminal emulation.

Item Description

1 This LED indicates whether you are connected to the host. It will appear red when not connected
and green when you are connected.

2 This LED indicates whether data is being sent to or from the host. It will appear dull green when
there is no activity, red when data is being sent to the host, and bright green when data is being
received from the host.

3 This button enables you to switch between Local and Online mode. The label indicates the mode
you will switch to when the button is clicked.

4 This button enables you to Pause or Resume scrolling data in the window. The label indicates the
action that will be taken when the button is clicked.

5 Indicates the current terminal emulation.

6 Displays the active session and current page number (always 1), and the line:column location of
the text cursor.

7 This indicates whether Overstrike mode or Insert mode is currently active. In Overstrike mode
(default), new characters will replace already existing characters at the cursor position. When
Insert mode is active, new characters will be inserted at the cursor position without deleting
existing characters, which will move to the right.
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Item Description

8 This will display the time in 24 hour format when in DEC VT500 mode if the VT525 set time
command has been received from the host.

9 This indicates the current keyboard mode. It will be blank when the keyboard is in Normal mode,
and display DEC when the keyboard is in DEC mode. You can toggle between Normal and DEC
keyboard mode by pressing the keys Alt + Num Lock.

Scrolling the Display
You can scroll the display vertically by holding down the Ctrl key and pressing the Up or Down
Cursor keys.

It is possible to make the width of display memory larger than the width of the window by changing
the Columns per page setting in the VT Series Settings dialog. When you want to view columns
stored off-screen, you can scroll horizontally by holding down the Ctrl key and pressing the Left or
Right Cursor keys.

Typing Direction for Hebrew Language
When ISO Hebrew or Ansi PC Hebrew 862 is selected as the Preferred character set in the VT
Series settings dialog, the following key functions will be enabled:

● Ctrl + Alt + F1

Select Multinational 8-bit mode and left-to-right typing.

● Ctrl + Alt + F2

Select National 7-bit mode (lowercase English characters will be displayed as Hebrew) and
right-to-left typing.

● Ctrl + Alt + F3

Toggle between left-to-right and right-to-left typing.

TTY Print Mode
When the emulation is in TTY Print mode, all incoming screen data (but not control codes except CR
and LF) are sent to the printer. TTY Print mode is toggled on and off by pressing the keys Shift + F4
on an Enhanced AT Keyboard by default. The key function can be mapped to a different key using
the virtual key nameVT_PRINTTTY.

AT&T 4410 Emulation
Keyboard Mapping

Special key functions normally found on the AT&T 4410 keyboard can be mapped to any key on your
keyboard using the AT virtual key names listed in the Key Macro Settings dialog. This dialog is
displayed by selecting Key Macros... on the Tools menu. Refer to the section Defining Key
Functions on page 30 for details.
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Display
When running the AT&T 4410 emulation, the display size is 80 (or 132) columns by 25 lines, with a
scroll region of 24 lines.

A row of function buttons is displayed along the bottom of the window. These correspond to the
function keys F1 through F8 on the keyboard.

You can action a programmed function either by pressing the function key, or clicking the equivalent
button displayed on the screen. The middle button has no function when clicked.

Programming the Function Keys & Buttons
To program the function keys and buttons, hold down a Shift key and press any F1 - F8 key. The
Program Function Keys menu will be displayed.

Each line relates to one particular function key and its button. The two fields following the f-key
number allow you to enter a two line label of up to sixteen characters for the equivalent button on the
display. These are followed by the definition line which contains an escape sequence by default.
Each definition can contain up to 50 ASCII characters.

To program an f-key, press the F1 key to move the cursor to the relevant line and use the cursor keys
to move from one section of the line to another. You must press the F1 key to end each definition line
entry so that extra space characters are not sent to the host. Note that using the cursor keys to move
to the next line will cause the remainder of the definition line to be sent as spaces.

When you have finished defining the f-keys, press F7 to save the definitions and exit from the menu.
If you want to exit without saving the settings, press F8.
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Setup Options
The VT Series emulation is configured using setup options in the VT Series Settings dialog which
can be displayed using one of the following three methods:

Using the Session Wizard:

◦ In Step 1 set Emulation to VT Series then click the Configure button.

Using the TeemTalk Window:

◦ On the Session menu, select Emulation > VT Series then select Configure Emulation....

◦ On the configuration bar, select VT Series in the Emulation list box then click Configure
Emulation.

The setup options are grouped on three tabs labelled General, Display and Preferences.
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General Settings

● Emulation mode

Factory default: VT510 7-Bit
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This specifies the particular VT Series terminal to emulate. Select from the following:

◦ AIXTerm

Provides compatibility with software designed to drive an X terminal using X Windows.

◦ Ansi BBS

This emulation is a derivative of the ANSI device driver ANSI.SYS supplied with all DOS
based PCs and which provides the screen management for the DOS console screen. PC
based UNIX systems and Bulletin Board Systems (BBS) often rely on the ANSI emulation
when being accessed by a PC. In ANSI BBS mode the screen size is adjusted to 25 lines
and the preferred character set is set to ANSI.

◦ AT 386

Provides compatibility with software designed to drive the AT&T AT 386 terminal.

◦ ATT4410

Provides compatibility with software designed to drive the AT&T Dataspeed 4410 terminal.
Refer to the section AT&T 4410 Emulation on page 74 for details.

◦ Sco Console

This is an emulation of the SCO UNIX box.

◦ VT PCTerm

Provides compatibility with software designed for the PC Term mode supported by DEC.

◦ VT52 and VT100

These emulations enable you to run applications written for the DEC VT52 and VT100
terminals, respectively.

◦ VT100+

This emulation is an enhanced version of the VT100 emulation that provides additional
functionality such as colours. It is the same as the VT-UTF8 emulation except that it only
supports ASCII characters 0-127 (decimal).

◦ VT+HP220

This emulation is based on the VT500 terminal series and includes the HP function keys F1
- F8 (not user programmable). The terminal ID is set to VT220.

◦ VT510 7-Bit and VT510 8-Bit

These emulations enable you to run applications written for the DEC VT320 terminal, the
difference is in their treatment of 8-bit control codes. When VT510 7-Bit is selected, all 8-bit
codes are converted to their 7-bit equivalents, whereas VT510 8- Bit leaves 8-bit codes
unchanged. If you are using VT200 applications, select VT510 7-Bit.

◦ VT-UTF8

This emulation is an enhanced version of the VT100 emulation that supports non-English
and drawing characters. It supports localization of the single-byte and double-byte
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character sets and all other languages supported by Windows. Additional functionality, such
as colors, is also provided.

● Terminal ID

Factory default: VT420

This specifies what is reported back to the host in response to a terminal ID request. Note that
not all features of the specified terminal may be supported.

● Font

Factory default: Courier New

This enables you to specify the font to use for displaying characters. The available settings
depend on the fonts installed on your system.

● Character set

Factory default: Multinational

This specifies the character set used for displaying characters.

When Iso Hebrew is selected, the following key functions will be enabled:

◦ Ctrl + Alt + F1

Select Multinational 8-bit mode and left-to-right typing.

◦ Ctrl + Alt + F2

Select National 7-bit mode (lowercase English characters will be displayed as Hebrew) and
right-to-left typing.

◦ Ctrl + Alt + F3

Toggle between left-to-right and right-to-left typing.

● Ansi codepage

Factory default: PC Multinational (437)

This option specifies the character set used for display when the Character set option is set to
PC Ansi. Note that selecting the ANSI BBS emulation will automatically set the preferred font to
PC Ansi.

Each code page consists of two tables of characters. The first table is the standard ASCII
character set. The second table contains special characters which differ between the code
pages.

When PC Hebrew (862) is selected, the following key functions will be enabled:

◦ Ctrl + Alt + F1

Select Multinational 8-bit mode and left-to-right typing.

◦ Ctrl + Alt + F2

Select National 7-bit mode (lowercase English characters will be displayed as Hebrew) and
right-to-left typing.

◦ Ctrl + Alt + F3
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Toggle between left-to-right and right-to-left typing.

● Multinational mode

Factory default: Checked

This option will only be available if the system is configured for a language that supports national
replacement character sets.

The setting of this option determines the type of character set used to generate characters.
When unchecked, TeemTalk is in National mode in which a character set specific to the selected
keyboard nationality is used. When checked (default) TeemTalk is in Multinational mode in
which a character set consisting of two tables of characters is used. This enables characters
from any keyboard nationality to be generated.

● Lines per screen

Factory default: 24

This specifies the number of text rows that can be viewed in the workspace at any one time out
of the total number stored in memory. This can be set to a maximum of 64. Note that the number
of rows stored in memory is specified by the Buffer lines option.

● Buffer lines

Factory default: 144

This option determines the number of text rows that are stored in memory. This can be set from
0 to 528 rows by default. The Display Rows option specifies the number of memory rows that
can be viewed in the workspace at any one time.

● Lines per page

Factory default: 24

When TeemTalk is in VT420 mode, the display memory of 144 lines can be divided into several
pages, up to a maximum of six pages of 24 lines each. The setting of this option determines the
number of lines on a page and therefore how many pages are available. Note that the page size
can be larger than the Lines per screen setting, in which case you can scroll the page up or
down in the window by holding down the Ctrl key and pressing the Up or Down Cursor keys.
When TeemTalk is in any mode other than VT420, the page size is the same as the Lines per
screen setting.

● Columns per screen

Factory default: 80

This option enables you to specify a width of 80 or 132 columns for the workspace. When set to
132, the setting of the Use 80 Column Font option determines whether all 132 columns are
displayed using a narrow font, or only 80 columns at a time using the normal (80 column) font,
with the ability to scroll horizontally to view the remaining columns.

● Columns per page

Factory default: 80

This option specifies the width of display memory for DEC VT modes, in the range 80 to 132
columns. When the number of Columns per screen is less than the page width specified here,
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you can scroll horizontally to view the hidden columns by holding down the Ctrl key and
pressing the Left or Right Cursor keys.

● Answerback

Factory default: Unspecified

This enables you to specify the Answerback string that is sent to the host in response to an
ANSI mode enquiry command. The string can be up to 30 characters long.

● Answerback concealed

Factory default: Unchecked

Selecting this option will cause the Answerback string specified in the text box above to be
locked from change and displayed as asterisks. Note that unchecking this option will cause the
Answerback string to be deleted.

● Tertiary device attribute

Factory default: Unspecified

When TeemTalk is in VT420 mode (Emulation mode set to VT510 and Terminal ID set to
VT420), this option enables you to specify the tertiary device attribute report that is sent in
response to a request from the host.
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Display Settings

● Cursor style

Factory default: Block

This enables you to specify how the text cursor is displayed. Select from Block, Underline,
Static block, Static underline or None.

● Status line

Factory default: Unavailable

This option determines whether or not the 25th screen line is used as a status line when
TeemTalk is in any DEC VT terminal emulation mode. When Unavailable or Host Writable is
selected, the host can write application-specific messages to the 25th line. Selecting None will
prevent this.

● Auto wrap

Factory default: Unchecked
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The setting of this option determines whether characters wrap to the next line when the right
margin is reached. When unchecked, on reaching the right margin, the last character position
will be overwritten by every new character received.

● Auto new line

Factory default: Unchecked

When checked, this will cause a carriage return command to be appended to every line feed
command received.

● Auto line feed

Factory default: Unchecked

When checked, this will cause a line feed command to be appended to every carriage return
command received.

● Display controls

Factory default: Unchecked

The setting of this option determines whether received control codes are actioned or displayed.
When checked, a representation of most control codes will be displayed on the screen.

● Display error codes

Factory default: Checked

This option determines whether a chequerboard symbol is displayed when the delete code is
received.

● Save scrolled lines

Factory default: Unchecked

If a scroll region is set, selecting this option will cause data scrolled out of the region to be stored
in a history buffer.

● Save screen before clearing

Factory default: Unchecked

This applies to all DEC VT emulations except VT340 and VT420. It determines the effect of a
clear screen command received from the host. When unchecked, the contents of the current
page will be cleared. When checked, the contents of the current page will be saved and the
display will scroll to the next page.

● Vertical coupling

Factory default: Checked

The setting of this VT420 mode option determines what happens when the application moves
the cursor to a line not currently displayed in the window when the number of displayed lines is
less than the page size. When checked, the display will automatically scroll vertically to keep the
cursor in view. When unchecked, the display will remain static and the cursor will move off-
screen to the relevant line stored in memory. You can scroll the display to view the lines stored
off-screen by holding down the Ctrl key and pressing the Up or Down Cursor keys.

● Horizontal coupling
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Factory default: Unchecked

The setting of this DEC VT mode option determines what happens when the cursor moves
beyond the last column displayed in the window when there are more columns stored off-screen.
When checked, the display will automatically scroll horizontally to keep the cursor in view. When
unchecked, the display will remain static and the cursor will move off-screen. To scroll
horizontally to view the hidden columns, hold down the Ctrl key and press the Left or Right
Cursor keys.

● Page coupling

Factory default: Checked

The setting of this VT420 mode option determines the effect of a remote command to move the
cursor to another page. When checked, the page to which the cursor is moved is automatically
displayed. When unchecked, the display remains unchanged and the cursor moves off-screen to
the relevant page stored in memory.

● Ignore nulls

Factory default: Unchecked

The setting of this option determines whether Null characters received from the host are
actioned or ignored.

● Cursor moves right to left

Factory default: Unchecked

This applies to the DEC VT, AIXTerm, Ansi BBS, AT 386 and Sco Console emulations. It
enables you change the direction in which the text cursor moves across the display.

● Copy right to left

Factory default: Unchecked

This applies to the DEC VT, AIXTerm, Ansi BBS, AT 386 and Sco Console emulations. It
enables the copy commands to function in right to left display mode.
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Preferences

● High function terminal

Factory default: Checked

This applies to the AIXTerm emulation. It enables you to switch between HFT (High Function
Terminal) mode (default) and VT100 mode.

● Keyboard sends scan codes

Factory default: Unchecked

This applies to the DEC VT520 and VT PC-Term emulations. It determines whether keyboard
scan codes or ASCII codes are sent to the host on key press/release. Note that this cannot be
selected at the same time as the Keyboard sends position codes option.

● Keyboard sends position codes

Factory default: Unchecked

This applies to the DEC VT520 and VT PC-Term emulations. It determines whether keyboard
position codes or ASCII codes are sent to the host on key press/release. Note that this cannot
be selected at the same time as the Keyboard sends scan codes option.

● Auto resize
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Factory default: Unchecked

This applies to the DEC VT520 emulation only. When this option is checked, the window size will
automatically be adjusted each time the buffer size is changed either by the host or through
setup. The following table indicates the window size (lines per screen) that is used for the
specified number of lines per page.

Lines per Page: 24 25 36 42 43 48 52 72

Lines per Screen: 26 26 43 43 43 52 52 52

● Dec key mode

Factory default: Unchecked

The keyboard can be used in one of two modes, Normal (default) or DEC. This option allows you
to change its default mode. You can toggle between the two modes by pressing the keys Alt +
Num Lock together. The 10th item on the status bar will display DEC when the keyboard is in
DEC mode. The field will be blank when in normal mode.

● Send key state codes

Factory default: Unchecked

When this option is checked, escape sequences for modifier key presses will be sent to the host.

● Application keypad

Factory default: Unchecked

The setting of this option determines the effect of pressing keys in the keypad on the right side of
the keyboard.

When unchecked, the keypad is in numeric mode and keys will generate the characters shown
on the key caps. When checked, the keypad is in application mode and keys will generate
control functions when pressed. The top row of four keys act as the equivalent DEC function
keys PF1 through PF4.

● Application cursor keys

Factory default: Unchecked

When this option is checked the cursor keys will generate application program codes when
pressed. unchecked, the keys will generate normal cursor movement commands.

● Jump scroll

Factory default: Checked

The setting of this option determines whether data is scrolled one or several lines at a time when
the window becomes full.

When checked, data will scroll up several lines at a time as determined by the Scroll rate setting
below.

● Scroll rate

Factory default: 24

86 Chapter 11   VT Series Emulation ENWW



This determines the number of lines that are scrolled when the Jump scroll option above is
selected.

● 80/132 clears screen

Factory default: Checked

This option determines whether or not data is cleared from the display when the number of
columns is changed.

● Use 80 column font

Factory default: Unchecked

When this option is checked, the font used in 132 column writing mode will be the same as that
used in 80 column mode.

● Backspace = DEL

Factory default: Unchecked

The setting of this option determines whether or not a backspace command performs a delete.

Tab Settings

Clicking the Set Tabs... button at the bottom of the VT Series Settings dialog will display the Tab
Settings dialog which enables you to set tab stops for the DEC VT, ANSI and SCO Console
emulations.

Tab stops are set every eight columns by default, as indicated by the T character below the relevant
column numbers. If you want tab stops to be set at regular intervals other than every 8th column,
enter the number of columns required between each tab stop in the box next to the Set Every button,
then click the button.

Individual tab stops can be toggled on or off by clicking the mouse pointer above or below the
relevant column number.

To remove all the tab stops, click Clear All.

To save the current tab stops, select Save Session in the File menu.

Auxiliary Port Setup
This dialog is only available when VT Series emulation mode is selected and can be displayed by
selecting Auxiliary Ports...from theFile menu. It enables you to specify a COM or LPT port for
bidirectional output when in any VT Series emulation.
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Specify the settings required by the auxiliary port device using the options described below and click
OK.

● Aux Port

Factory default: AUX1

This specifies the auxiliary port device used for which to apply settings. This drop list will only
show configured Auxiliary ports with at least 1 showing. Clicking on the Apply button will save
the shown parameters to the currently selected Aux port and advance to the next available Aux
port for configuration. A maximum of 16 Aux ports can be configured.

● Mapped to Com Port

Factory default: COM3

This specifies the port used to communicate with the auxiliary port device.

● Baud Rate

Factory default: 9600

Specifies the connection speed in the range 110 to 115200 baud.

● Word Length

Factory default: 8

This option specifies the number of data bits sent for each transmitted character.

● Parity

Factory default: None

This option specifies the parity mode for each transmitted character. If the number of data bits
specified by Word Length is 8, set this option to None.
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Selecting Odd will cause an eighth bit to be added with a value of 1 if the previous 7 bits add up
to an even number, and 0 if the previous 7 bits add up to an odd number.

Selecting Even will cause an eighth bit to be added with a value of 1 if the previous 7 bits add up
to an odd number, and 0 if the previous 7 bits add up to an even number.

Mark parity will set every eighth bit to 1 and Space parity every bit to 0.

● Stop Bits

Factory default: 1

This specifies the number of stop bits sent for each transmitted character.

● Flow Control

Factory default: Both

This option specifies the type of flow control used by the line port to communicate readiness to
transmit or receive data from the auxiliary port device.

◦ None

No flow control.

◦ Input

XON/XOFF on received data.

◦ Output

XON/XOFF on transmitted data.

◦ Both

XON/XOFF on transmitted and received data.

◦ Hardware

RTS/CTS hardware flow control.

● Enable Bidirectional

Factory default: Checked

The setting of this option determines whether data from the auxiliary port device can be
transmitted to the host as well as received from the host through the TeemTalk session.

● Open at Session Startup

Factory default: Unchecked

Selecting this option will cause the Aux port to be opened as soon as the TeemTalk session is
started.
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12 HP 700-92/96 Emulation

This chapter describes features of the Hewlett-Packard 700-92/96 terminal emulation.

Creating a HP 700-92/96 Emulation Session
You can create a session either using the TeemTalk Session Wizard or while TeemTalk is running.

Using the TeemTalk Session Wizard
This section describes how to use the TeemTalk Session Wizard to create an HP 700-92/96
emulation session.

1. To run the TeemTalk Session Wizard from the Start menu, select All Programs > HP > HP
TeemTalk Terminal Emulator > Session Wizard.

2. In the Session Name field, enter a unique name that will identify this session configuration for
future selection.

3. Select the Transport method then click the Configure button to specify settings.

4. Select the Connection type then click the Configure button to specify settings.

5. Select HP70092 in the Emulation list box then click the Configure button to specify settings.
(The options are described in the section Setup Options on page 103.)

6. Click Next to display the Advanced Options dialog.

7. Click Next to display the Finalization dialog.

8. If you want a shortcut icon for this session to be created on the desktop, click the checkbox
Create icon on desktop for session.

9. Click OK to create the session and exit.

10. To run the session, either double-click on the desktop icon if one was created for the session, or
run TeemTalk, display the File menu and select Open Session. Select the name of the
required .tts session file then click Open.

Using the TeemTalk Emulator Window
This section describes the procedure for creating a HP 700-92/96 emulation session from the
TeemTalk emulator window.

1. Display the Session menu from the menu bar and select Transport... to set the transport
method.

2. Display the Session menu and select Connection... to set the connection method.

3. Display the Session menu and select Emulation.... Set the emulation to HP70092.
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4. You can configure the transport, connection and emulation settings by selecting the relevant
Configure options in the Session menu. The options displayed by selecting Configure
emulation are described in the section Setup Options on page 103.

5. To save the session, display the File menu and select Save session as. In the File Name field,
enter a unique name that will identify this session configuration for future selection, then click
Save. Note that session files have the filename extension .tts.

6. To run the session, display the File menu and select Open Session. Select the name of the .tts
session file then click Open.

Keyboard Mapping
The functions of the computer keyboard are mapped as closely as possible to the terminal being
emulated. The mapping of key functions can be determined by referring to the Emulation Keys list
box in the Key Macro Settings dialog, which is displayed by selecting Key Macros... on the Tools
menu.

The information in brackets in the right column indicates the default mapping of the key function
named in the left column. In the list, S+ indicates the Shift key, C+ indicates the Control key and A+
indicates the Alt key. For example:

HP_SOFTRESET (C+VK_F7)

indicates that the Soft Reset function is mapped to the key combination Control + F7.

Special key functions usually found on an HP 700-92/96 keyboard can be mapped to any key on your
keyboard using the HP virtual key names listed in the Key Macro Settings dialog.

The illustrations on the following pages show where HP 700-92/96 keyboard functions are mapped to
keys on a 101/102 key keyboard.

Figure 12-1  101/102 Key Keyboard Layout for the HP 700-92/96 Emaulation
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Table 12-1  HP 700-92/96 Keyboard Mapping

Key Key
Modifier

Result  Key Result

1
Ctrl +

none

F1

INSERT LINE

 
11 INSERT MODE

2
none

Ctrl +

F2

DELETE LINE

 
12 HOME UP

3
none

Ctrl +

F3

CLEAR LINE

 
13 PREVIOUS PAGE

4
none

Ctrl +

F4

CLEAR DISPLAY

 
14 DELETE CHAR

5
none

Ctrl +

F5

SELECT

 
15 HOME DOWN

6  F6  16 NEXT PAGE

7
none

Ctrl +

F7

SOFT RESET

 
17 CURSOR UP

8
none

Ctrl +

F8

HARD RESET

 
18 CURSOR LEFT

9
none

Shift +

USER SYSTEM

MENU

 
19 CURSOR DOWN

10
none

Shift +

USER KEYS MODE

USER KEY DEF. MODE

 
20 CURSOR RIGHT

    21 ENTER

NOTE: All unmarked keys function as indicated by the legends on the keycaps.

Display Configuration
When you run the HP 700-92/96 emulation a row of buttons will be displayed along the bottom of the
TeemTalk window.

The buttons indicate the current function of keys F1 through F8 on the keyboard and these functions
are described in the next section. The two numbers in the middle indicate the current line and column
position of the cursor.

The display area is 80 columns by 24 lines by default, and 168 lines are stored off-screen. You can
toggle between 80 and 132 column display by pressing the function key F12. The display memory

92 Chapter 12   HP 700-92/96 Emulation ENWW



can be divided into 2, 4, 6 or 8 pages using the Display pages option in the HP70092 Settings
dialog (see Setup Options on page 103).

Function Keys & Buttons
The buttons along the bottom of the HP 700-92/96 window indicate the current function of keys F1
through F8 on the keyboard. The buttons and equivalent function keys enable selection of various
operating modes and display configurations. Clicking a button has the same effect as pressing the
equivalent F# key. When a key or button is attributed an on/off toggle action, the button will display an
asterisk when the function is selected.

When you run the HP 700-92/96 emulation, the initial configuration of the buttons and function keys
enable various operating modes to be selected. The buttons will show the Mode Selection
configuration.

Mode Selection
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The Mode Selection functions are assigned to the buttons and function keys when you first run the
HP 700-92/96 emulation. If the functions are changed while using the emulation, you can reassert
them by pressing the F9 key (equivalent to the User System key), then F4.

● Line Modify - F1

This function enables you to edit and retransmit an incorrectly entered command string when the
emulation is in Remote mode and Character mode and you are communicating interactively with
the host. This saves you having to retype the entire string again.

NOTE: This will not function when the emulation is in Block or Format mode.

When the host causes an error message to be displayed indicating that the string has been
incorrectly entered, press the F1 key or click the equivalent button. An asterisk will appear on the
button indicating that the function is selected. Move the cursor to the line containing the error,
edit the line then press Return or Enter. This will cause the edited string to be transmitted and
Line Modify mode to be exited.

If after activating Line Modify mode you wish to cancel it, just press F1 or click the button again.

● Modify All - F2

This is similar to the Line Modify F1 function described previously, the only difference being that
the editing mode is not exited when Return or Enter is pressed. F2 and its equivalent button
acts as a toggle key, switching the mode on or off. The setting may be saved by selecting Save
Session in the File menu.

The F2 Modify All key and button enables you to edit and retransmit an incorrectly entered
command string when the emulation is in Character mode. This saves you having to retype the
entire string again.

NOTE: This will not function when the emulation is in Block or Format mode.

When the host causes an error message to be displayed indicating that the string has been
incorrectly entered, press the F2 key. An asterisk will appear on the button indicating that the
function is selected. Move the cursor to the line containing the error, edit the line then press
Return or Enter. This will cause the edited string to be transmitted. To exit Modify All mode,
press F2 or click the button again.

NOTE: Even though this function is a special form of Block mode it is completely separate from
it and you do not need to enable Block mode before using the Modify All function.

● Block Mode - F3

Data may be transmitted to the host a character at a time or as a block of characters. The F3
key and equivalent button toggles the form of data transmission between Character mode and
Block mode. The setting may be saved by selecting Save Session in the File menu.

The emulation is in Character mode when the button does not display an asterisk. Each
character will be sent to the host as it is entered at the keyboard.

When Block mode is activated (as indicated by an asterisk), data entered at the keyboard will
not be sent to the host until the Enter key is pressed. In this mode, displayed text may be edited
locally before it is transmitted to the host. Control codes such as CR (carriage return) and LF
(line feed) are acted upon locally and are not transmitted to the host when Enter is pressed.

● Remote Mode - F4
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The current setting of this button determines whether pressing an alphanumeric key causes a
character to be sent to the host (remote) or only to the display (local). The button and F4 key
toggles between Remote mode and Local mode. The setting may be saved by selecting Save
Session in the File menu.

The emulation is in Local mode when the button does not display an asterisk. Pressing
alphanumeric keys will cause characters to be sent to the display only.

When Remote mode is activated (as indicated by an asterisk), pressing alphanumeric keys will
cause characters to be sent to the host.

● Terminal Test - F5

When this button or F5 key is pressed, the HP 700-92/96 emulation will perform a self-test and
display a test screen showing all the displayable characters.

● Memory Lock - F6

This enables data to be locked on the display so that it is not scrolled off the top of the window
when display memory is full. Once enabled, it can only be disabled if this button or F6 key is
pressed again, a reset is performed, or the emulation is exited.

Placing the cursor on the first line and enabling Memory Lock will prevent data from
automatically scrolling off the top of the display when display memory is full. Instead, the
message 'MEMORY FULL Press RETURN to clear' will be displayed. You may use the cursor
keys to edit data already displayed. To disable the Memory Lock and continue entering new
data, press F6 or click the button again and position the cursor immediately below the last line.

The Memory Lock function may also be used to lock a specific number of lines from the top of
the display, leaving the remaining lines to scroll past them. This is useful when you want column
headings or instructions to remain on the display. To lock a specific number of lines, place the
cursor on the last line to be locked and press F6 or click the button. The lines from the top of the
display down to the cursor line will now be locked.

NOTE: You can edit data contained in locked lines but if new data is inserted it may cause
data on the last line of the locked region to be pushed down into the scrolling region.

● Display Functions - F7

This button and the F7 key toggles the Display Functions mode on or off. The effect of activating
Display Functions mode depends on whether the emulation is in Local or Remote mode. In
Local mode, activating Display Functions mode will cause subsequently received control codes
and escape sequences to be displayed on the screen but not actioned. Exceptions to this rule
are the commands issued when the button or F7 key is pressed and the carriage return and line
feed commands, which will be executed.

In Remote mode, activating Display Functions mode will cause subsequently received control
codes and escape sequences to be transmitted to the host but not actioned locally. Exceptions
to this rule are the commands issued when the button or F7 key is pressed and the carriage
return and line feed commands, which will be executed. If the Local Echo option is enabled in
the HP70092 Settings dialog, commands will be displayed on the screen as well as transmitted
to the host.
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NOTE: If the XmitFnctn (A) option is selected in the HP70092 Settings dialog (see Setup
Options on page 103 for details), the button and F7 key will not deactivate Display Functions
mode.

● Auto LF - F8

This button and the F8 key enables or disables Auto Line Feed mode. When enabled, a line feed
command is automatically appended to every carriage return command generated from the
keyboard. The setting may be saved by selecting Save Session in the File menu.

Configuration Selection

This set of functions is asserted by pressing the F9 key (equivalent to the User System key). This
enables you to access three sets of function configurations.

● Device Control - F1

Clicking this button or pressing F1 will cause the Device Control functions to be asserted. The
buttons and keys F1 through F8 will function as described in the section Device Control
on page 96.

● Margins/Tabs/Col - F2

Clicking this button or pressing F2 will cause the Margins/Tabs/Col functions to be asserted.
The buttons and keys F1 through F8 will function as described in the section Margins, Tabs &
Start Column on page 98.

● Modes - F4

Clicking this button or pressing F4 will cause the Mode Selection functions to be asserted. The
buttons and keys F1 through F8 will function as described in the section Mode Selection
on page 93.

Device Control

This set of functions is asserted by pressing the F9 key (equivalent to the User System key) then F1.
These functions enable you to select the device(s) to which data is sent and also to copy portions of
data from display memory to the printer.

● Device Modes - F1

Clicking this button or pressing F1 will cause the Device Modes functions to be asserted. The
keys F1 through F8 will function as described in the section Device Modes on page 97.

● To Ext Dev - F2

This toggle function determines whether data is sent to the printer or not. Data will be sent to the
printer when an asterisk is displayed on this button.

● To Display - F3

This toggle function determines whether data is sent to the display or not. Data will be sent to
the display when an asterisk is displayed on this button.
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● Advance Page - F4

When a printer is connected and enabled by the To Ext Dev function, clicking this button or
pressing F4 will cause paper in the printer to be advanced to the top of the next page.

● Advance Line - F5

When a printer is connected and enabled by the To Ext Dev function, clicking this button or
pressing F5 will cause paper in the printer to be advanced by one line.

● Copy All - F6

When a printer is connected and enabled by the To Ext Dev function, clicking this button or
pressing F6 will cause a copy of all lines from and including the cursor line to the last line in
display memory to be sent to the printer.

The cursor will move to the leftmost column on the next line when the current line has been
printed. You can cancel printing at the end of the current line by pressing Return.

NOTE: If the cursor is positioned on a line below the last displayable line of data, nothing will
be sent to the printer.

● Copy Page - F7

When a printer is connected and enabled by the To Ext Dev function, clicking this button or
pressing F7 will cause a copy of all lines from and including the cursor line to the last line
displayed on the screen to be sent to the printer.

The cursor will move to the leftmost column on the next line when the current line has been
printed. You can cancel printing at the end of the current line by pressing Return.

NOTE: If the cursor is positioned on a line below the last displayable line of data, nothing will
be sent to the printer.

● Copy Line - F8

When a printer is connected and enabled by the To Ext Dev function, clicking this button or
pressing F8 will cause a copy of the line containing the cursor to be sent to the printer. The
cursor will move to the leftmost column on the next line when the line has been printed.

NOTE: If the cursor is positioned on a line below the last displayable line of data, nothing will
be sent to the printer. If the cursor is positioned on an empty line between two blocks of data, the
printer will perform a carriage return and line feed.

Device Modes
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This set of functions is asserted by pressing the F9 key (equivalent to the User System key) then F1
and F1 again.

● Device Control - F1

Clicking this button or pressing F1 will cause the Device Control functions to be asserted. These
enable you to select the device(s) to which data is sent and also to copy portions of data from
display memory to the printer. The buttons and keys F1 through F8 will function as described in
the section Device Control on page 96.

● Record Mode - F2

This is used to copy data received from the host to the printer and/or display, depending on the
setting of the To Ext Dev and To Display labels in the Device Control menu.

NOTE: This function does not take effect when the emulation is in Local mode. In Remote
mode, received data is sent directly to the selected device(s).

The keyboard will be disabled when Record mode is activated except for the F2 key which is
used to exit the mode.

● Log Bottom - F3

When the cursor moves to the next line as a result of an explicit line feed or end-of-line
wraparound, the line of data which the cursor has just moved from will be sent to the printer
when this function is activated. This enables you to create a hardcopy of all the lines in the order
in which they were entered via the keyboard or received from the host.

NOTE: The terminal emulation and the host must both be using the ENQ/ACK or Xon/Xoff
handshakes, or a baud rate that is no higher than the rate supported by the printer.

Log Bottom remains activated until either this button or F3 is pressed again, Log Top is
activated, a reset is performed, or the emulation is exited.

● Log Top - F4

When the display memory becomes full and more data is received from the host or keyboard,
lines of data from the top of the display are deleted to make way for the new data. The Log Top
function enables the data that is removed from the top of the display to be sent to the printer
when the To Ext Dev function is activated in the Device Control menu.

NOTE: The terminal emulation and the host must both be using the ENQ/ACK or Xon/Xoff
handshakes, or a baud rate that is no higher than the rate supported by the printer.

Log Top remains activated until either this button or F4 is pressed again, Log Bottom is
activated, a reset is performed, or the emulation is exited.

NOTE: This function does not take effect when Memory Lock is activated.

Margins, Tabs & Start Column
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This set of functions is asserted by pressing the F9 key (equivalent to the User System key) then F2.
These functions enable you to redefine the start column, set tabs, and specify the left and right
margins.

● Start Column - F1

This function is used to temporarily redefine the start column for transmitted data when no
logical start-of-text pointer is present and the Return or Enter keys are pressed in Modify Line
or Modify All mode.

NOTE: The default start column is specified in the HP70092 Settings dialog (see Setup
Options on page 103).

Usually a start-of-text pointer is automatically generated to designate the leftmost character in
the current line if it is the last line of data in display memory. The pointer will remain in display
memory until the line is deleted. If the line has no start-of-text pointer, data transmission will
begin at the start column specified by this option. The column range that can be specified is from
1 to 80, inclusive.

To change the current start column, move the cursor to the new starting point and click this
button or press the F1 key. The start column will revert to that specified within setup when the
emulation is reset or re-entered.

● Set Tab - F2

This function enables tab stops to be defined. To define a tab stop, move the cursor to the
column to contain the tab then click this button or press F2.

NOTE: Tab stops that do not lie within the left and right margins will be ignored when the Tab
key is pressed. All tab stops will be ignored when the emulation is in Format mode.

● Clear Tab - F3

This function enables an individual tab stop to be cleared. To clear a tab stop, move the cursor
to the column containing it then click this button or press F3.

● Clr All Tabs - F4

Clicking this button or pressing F4 will cause all defined tab stops to be cleared (except the left
margin which is an implicit tab stop).

● Left Margin - F5

This function enables you to define the left margin. Margins determine the boundary for certain
cursor movement commands (such as carriage return and cursor home), and insert character
and delete character functions. Data to the left of this margin will still be accessible. The left
margin is an implicit tab stop.

When data received from the host or entered through the keyboard reaches the right margin, the
cursor will move to the specified left margin on the next line down (as long as InhEolWrp is not
selected in the HP70092 Settings dialog (see Setup Options on page 103), and, in the case of
keyboard-entered data, auto line feed mode is enabled).

To specify the left margin, place the cursor in the column for the margin location and click this
button or press F5. The left margin can be reset to column 1 by pressing F7 (this will also reset
the right margin to column 80).
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NOTE: Margins are disregarded when data is transferred from display memory to the host. The
margins will be cleared when Format mode is enabled.

● Right Margin - F6

This function enables you to define the right margin. Margins determine the boundary for certain
cursor movement commands (such as carriage return and cursor home), and insert character
and delete character functions. Data to the right of this margin will still be accessible.

When data received from the host or entered through the keyboard reaches the specified right
margin, the cursor will move to the left margin on the next line down (as long as InhEolWrp is
not selected in the HP70092 Settings dialog (see Setup Options on page 103), and, in the case
of keyboard-entered data, auto line feed mode is enabled).

To specify the right margin, place the cursor in the column for the margin location and click this
button or press F6. The right margin can be reset to column 80 by pressing F7 (this will also
reset the left margin to column 1).

NOTE: Margins are disregarded when data is transferred from display memory to the host. The
margins will be cleared when Format mode is enabled.

● Clr All Margins - F7

This function will reset both left and right margin settings so that the left margin is in column 1
and the right margin in column 80.

Programming Function Keys & Buttons
The keys F1 through F8 and their equivalent buttons can be programmed by the host or user to
perform additional functions to those described earlier. The keys may be assigned a string of
alphanumeric characters and/or control codes, and you can define whether the key string is executed
locally or transmitted to the host, or both. The buttons can also be programmed to display the new
functions when in User Keys mode.

User Keys Mode
User Keys mode is entered by pressing the F10 key. The f-key buttons displayed on the screen will
change to display the current User Key definitions. If no definitions have been assigned, either by you
or the host, the buttons will just display the legends of each f-key.

User Key Definitions
To define the function of an f-key or equivalent button locally, press the keys Shift + F10 to display
the User Key Definition screen. The screen can be exited by pressing F9.
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Default Definitions
While this screen is displayed the f-keys and equivalent buttons have the functions shown by the
buttons at the bottom of the TeemTalk window, so pressing F4 or the Default Values button will
cause the default key and button definitions to be asserted. The default definitions will take effect
when the User Key Definition screen is exited.

Key String Treatment
Each f-key and button definition displayed in the User Key Definition screen consists of two lines. The
first line begins with the f-key number followed by space then a one-character attribute field. This field
will contain either an uppercase L, T or N. These characters indicate the following:

● L The key string is executed locally.

● T The key string is transmitted to the host only.

● N The key string is treated as keyboard-entered data.

The default selection is T for all f-keys. To change this setting, use the Tab or Shift + Tab keys to
move the cursor over the field then press F2 (Next Choice button) or F3 (Previous Choice button) to
cycle through the options until the one required is displayed.

Function Indicator
The remainder of the first line is used to specify what is displayed on the screen button to indicate its
function. The default display shows the numbers of the f-keys.

The two fields following LABEL represent the upper and lower lines that can be displayed on the
button. To change the current definition, use the Tab or Shift + Tab keys to move the cursor into the
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relevant field and type in the new definition which can consist of a maximum of 16 characters, eight
characters per field.

Key String Definition
The second line of each f-key definition contains the character string that is to be displayed,
executed, and/or transmitted to the host when the key or button is pressed. The string may contain
alphanumeric characters, control characters, and explicit escape sequence characters entered when
Display Functions mode is enabled by pressing F7 or the Display Functions button.

The default f-key string begins with the characters EC which represent the escape code that is used
to begin each escape sequence. The EC characters are displayed in the key definition line by
pressing the Esc key or the keys Ctrl + [ together when Display Functions mode is enabled. Note
that you must enter the entire escape sequence before disabling Display Functions mode (by
pressing F7 again).

When Display Functions is enabled, the Return key may be used to insert carriage return codes (CR)
in the string. If Auto LF mode is selected in the Mode Selection function menu, Return will generate
a line feed (LF) code as well as carriage return.

To change an f-key/button string definition, use the Tab or Shift + Tab keys to move the cursor onto
the second line (the line following LABEL definition for that key/button) and type in the new definition
which can consist of a maximum of 80 characters.

When you have finished defining f-key/button strings, press the F9 key to exit the menu. To enable
the new definitions and display the relevant functions on the buttons, press the F10 key.

NOTE: The host may reset the f-key definitions to their default values if required by the application.

Character Display Attributes
The HP 700-92/96 emulation incorporates various display attributes that can be enabled either by
host commands, or from the keyboard by the user. When an attribute or set of attributes are enabled,
they affect all subsequently displayed characters until an end attribute command or another attribute
command is received, or the end of the line is reached. Attributes remain at the display location
where they were enabled and will not move when characters are inserted or deleted.

You can configure the f-keys and buttons so that they will enable these attributes when pressed. The
procedure is as follows.

1. Display the User Key Definition screen by pressing the keys Shift + F10 together.

2. Press the Tab or Shift + Tab keys to position the cursor in the first field next to the number of
the f-key to be defined.

3. Press F2 until the letter L for Local is displayed.

4. Press Tab and type in the text that will appear in the display label for the key, for example,
Under in the first field and Line in the second for Under Line. Press Tab to move down to the
next line.

5. Press F7 to enable Display Functions mode
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6. Press Ctrl + [ together or the Esc key, followed by the characters &d and the attribute character,
which for underline is D.

The key definition should look like this if the F1 key was defined to enable the underline attribute:

For any other attribute or combination of attributes, substitute the last character in the second
line (D in the example above) with the relevant character from the following table.

7. When you have finished, press F9 to exit from the User Key Definition menu, then F10 to enable
the User Keys and display the defined attribute labels.

Setup Options
The HP 700-92/96 emulation is configured using setup options in the HP70092 Settings dialog which
can be displayed using one of the following three methods:

Using the Session Wizard:

◦ In Step 1 set Emulation to HP 700-92/96 then click the Configure button.

Using the TeemTalk Window:

◦ On the Session menu, select Emulation > HP 700-92/96 then select Configure
Emulation....

◦ On the configuration bar, select HP 700-92/96 in the Emulation list box then click
Configure Emulation.

The setup options are grouped on three tabs labelled General, Configuration and Preferences.
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General Settings

● Personality

Factory default: 70092

This specifies what is reported back to the host in response to a terminal identification request.
(Note that not all features of the specified terminal may be supported.)

The available personalities are 2392A, 2622A, 70092, 70094 or 70096. You can either select
from this list or enter a custom terminal identity in the Custom ID text box below.

● Custom ID

Factory default: Unspecified

This enables you to specify a custom terminal identity which will be reported back to the host in
response to a terminal identification request.

● Font

Factory default: Courier New
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This enables you to specify the font to use for displaying characters. The available settings
depend on the fonts installed on your system.

● Character set

Factory default: Roman 8

This specifies the character set used for displaying characters.

● Multinational mode

Factory default: Checked

This option will only be available if the system is configured for a language that supports national
replacement character sets.

The setting of this option determines the type of character set used to generate characters.
When unchecked, TeemTalk is in National mode in which a character set specific to the selected
keyboard nationality is used. When checked (default) TeemTalk is in Multinational mode in
which a character set consisting of two tables of characters is used. This enables characters
from any keyboard nationality to be generated.

● Display pages

Factory default: 4

In HP 700-92/96 mode the display area is 80 or 132 columns by 24 lines with 168 lines stored
off-screen, giving a total display memory of 192 lines. This option enables you to specify whether
display memory is divided into 2, 4, 6 or 8 pages.

● Form feeds

Factory default: Displayed

This determines whether form feeds are Displayed, Actioned or Ignored.

Selecting Displayed will cause form feeds to be represented on the display as FF characters.

When TeemTalk receives a form feed command from the host it normally results in a line feed
on the display. Selecting Ignored will cause TeemTalk to ignore all form feed commands.

● Cursor style

Factory default: Block

This enables you to specify how the text cursor is displayed. Select from Block, Underline,
Static block, Static underline or None.
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Configuration Settings

● XmitFnctn (A)

Factory default: Unchecked

This option determines whether escape sequences generated by control and function keys are
sent to the host or only to the terminal emulation.

When unchecked, escape sequences are only sent to the terminal emulation. When checked,
escape sequences are sent to the host. If the Local Echo option is checked, the sequences will
also be sent to the terminal emulation.

● SPOW (B)

Factory default: Unchecked

The setting of the SPace OverWrite option determines whether or not keyboard entered spaces
overwrite existing characters. When unchecked, keyboard entered spaces will overwrite existing
characters.

Checking this option will cause the SPOW latch to be enabled. The latch can then be activated
by a carriage return. When activated, keyboard entered spaces will cause the cursor to move
forward without deleting characters that already exist. The latch can be deactivated by a tab, line
feed or home-up command. This will cause spaces to overwrite existing characters as normal.
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● InhEolWrp (C)

Factory default: Unchecked

The Inhibit End of line Wrap option determines whether characters wrap to the next line when
the right margin is reached. When checked (i.e. inhibited), on reaching the right margin, the last
character position will be overwritten with every new character received until a carriage return or
other cursor movement command is issued.

● Line/Page (D)

Factory default: Unchecked

The setting of this option determines whether data is sent a line or a page at a time when in Edit
mode.

When this option is checked, data will be transmitted a line at a time.

When unchecked, data will be transmitted a page at a time. Page data will either be from the
beginning of display memory or from the current cursor position.

● InhHndShk (G) InhDC2 (H)

Factory default: Unchecked

The combined setting of these two options determine the type of handshaking used when blocks
of data are transmitted to the host.

One of three types of handshake may be used:

◦ No handshake. Blocks of data are sent immediately when the relevant transmit key is
pressed.

◦ DC1 handshake. Data is only sent to the host when the host sends an ASCII DC1 control
code to request it.

◦ DC1/DC2/DC1 handshake. The host sends an ASCII DC1 control code, to which TeemTalk
replies by sending a DC2 code if ready to transmit. The host sends the DC1 code again to
cause the data block to be transmitted.

The type of handshake used for block transfers is determined by the type of block transfer to be
performed, the mode that the HP70092 emulation currently operating in (character, block line,
block page, or modify mode), and the setting of these two options.

The setting of these two options will have the following general effect:

◦ InhHndShk only selected: The DC1/DC2/DC1 handshake or no handshake will be used.

◦ InhDC2 only selected: The DC1 handshake or no handshake will be used.

◦ InhHndShk and InhDC2 selected: No handshake will be used.

● Enq/ack pacing

Factory default: Checked

The setting of this option determines whether the Hewlett Packard ENQ ACK handshake is
used.

When checked, the host can send an ASCII ENQ (enquiry) control code at the end of
transmission asking if the data has been processed, to which TeemTalk will reply by sending an
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ACK (acknowledge) code when it has. Note that this form of handshaking has tthe lowest priority
after hardware and XON/XOFF handshaking.

● EscXfer

Factory default: Unchecked

This option determines whether escape sequences relating to the display are sent when the
display memory is transferred to the printer.

When unchecked, escape sequences relating to the display are not sent to the printer.

When checked, each line transferred to the printer will begin with an escape sequence to select
the primary character set and stop any character enhancements. When escape sequences
relating to the display are encountered within the data (for example, to change the character
set), they will be sent to the printer.

● Jump scroll

Factory default: Checked

The setting of this option determines whether data is scrolled one or several lines at a time when
the window becomes full.

When checked, data will scroll up several lines at a time as determined by the Scroll rate setting
below.

● Scroll rate

Factory default: 24

This determines the number of lines that are scrolled when the Jump scroll option above is
selected.
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Preferences

● Backspace = DEL

Factory default: Checked

The setting of this option determines whether a backspace command also performs a delete.

● Destructive backspace

Factory default: Unchecked

The setting of this option determines whether pressing the Backspace key will cause characters
to be deleted.

● CR = CR/NULL

Factory default: Unchecked

This option must only be selected if you are going to use the QEDIT application. It overcomes a
bug within QEDIT that ignores the LF character if the terminal transmits CR/LF. Inserting a
NULL after the CR character cures the problem.

● Start column
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Factory default: 1

This enables you to specify the start column for transmitted data when no logical start-of-text
pointer is present and the Return or Enter keys are pressed in Modify Line or Modify All
mode.

Usually a start-of-text pointer is automatically generated to designate the leftmost character in
the current line if it is the last line of data in display memory. This pointer will remain in display
memory until the line is deleted. If the line has no start-of-text pointer, data transmission will
begin at the start column specified by this option. The column range is from 1 to 80 inclusive.

NOTE: The setting of this option may be temporarily redefined using one of the Margin/Tab/
Col function keys. Refer to the section Margins, Tabs & Start Column on page 98 for details.

● Return definition

Factory default: ^M (i.e. CR)

This enables you to define the function of the Return key. Up to two characters may be used to
define the key. If a second character is a space, it will be ignored.

To change the current definition, delete the definition displayed in the text box and type in the
new one, either as the control key character equivalent or the decimal value of the ASCII
character.

For example, the default code for the Return key function, CR (carriage return), can be entered
by typing the characters ^ and M, representing the keys Ctrl + M which, when pressed together
would generate the CR code.

Decimal values are entered as three-digit numbers immediately preceded by an underscore
character. Values with only two digits must be preceded by a zero. For example, the decimal
value of CR is 13, so this would be entered as _013.

● Field separator

Factory default: ^_ (i.e. US)

This specifies the ASCII character used to indicate the end of each protected field (except the
last) that is sent in Edit mode.

To change the current definition, delete the definition displayed in the text box and type in the
new one, either as the control key character equivalent or the decimal value of the ASCII
character. For example, the default ASCII character US can be entered by typing the characters
^ and _, representing the keys Ctrl + _ which, when pressed together would generate the US
code.

Decimal values are entered as three-digit numbers immediately preceded by an underscore
character. Values with only two digits must be preceded by a zero. For example, the decimal
value of US is 31, so this would be entered as _031.

● Block terminator

Factory default: ^^ (i.e. RS)

This specifies the ASCII character sent to the host to indicate the end of a data block
transmission.

To change the current definition, delete the definition displayed in the text box and type in the
new one, either as the control key character equivalent or the decimal value of the ASCII
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character. For example, the default ASCII character RS can be entered by typing the character ^
twice, representing the keys Ctrl + ^ which, when pressed together would generate the RS
code.

Decimal values are entered as three-digit numbers immediately preceded by an underscore
character. Values with only two digits must be preceded by a zero. For example, the decimal
value of RS is 30, so this would be entered as _030.

● Typeahead enabled

Factory default: Unchecked

When TeemTalk is connected to an HP 3000, you normally have to wait for the host to send a
prompt before you can enter new data at the keyboard, otherwise the data is ignored. Selecting
this option will enable you to type continuously without waiting for the prompt. Data is stored in
the keyboard buffer and each time TeemTalk receives a prompt it will send a line of data to the
host. Block mode also supports typeahead.

● Host prompt character

Factory default: ^Q (i.e. DC1)

Some hosts send a prompt character to the terminal to indicate that they are ready to receive the
next line or block of data. This option enables you to specify the prompt character for your
particular host. Most hosts either use the DC1 (^Q) character (e.g. HP 3000) or no prompt (^@)
character.

When the Typeahead enabled option is checked, TeemTalk will wait for the specified prompt
character from the host before transmitting the next line from the keyboard buffer.
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13 IBM 3151 Emulation

This chapter describes features of the IBM 3151 terminal emulation.

Creating a IBM 3151 Emulation Session
You can create a session either using the TeemTalk Session Wizard or while TeemTalk is running.

Using the TeemTalk Session Wizard
This section describes how to use the TeemTalk Session Wizard to create an IBM 3151 emulation
session.

1. To run the TeemTalk Session Wizard from the Start menu, select All Programs > HP > HP
TeemTalk Terminal Emulator > Session Wizard.

2. In the Session Name field, enter a unique name that will identify this session configuration for
future selection.

3. Select the Transport method then click the Configure button to specify settings.

4. Select the Connection type then click the Configure button to specify settings.

5. Select IBM 3151 in the Emulation list box then click the Configure button to specify settings.
(The options are described in the section Setup Options on page 118.)

6. Click Next to display the Advanced Options dialog.

7. Click Next to display the Finalization dialog.

8. If you want a shortcut icon for this session to be created on the desktop, click the checkbox
Create icon on desktop for session.

9. Click OK to create the session and exit.

10. To run the session, either double-click on the desktop icon if one was created for the session, or
run TeemTalk, display the File menu and select Open Session. Select the name of the
required .tts session file then click Open.

Using the TeemTalk Emulator Window
This section describes the procedure for creating a IBM 3151 emulation session from the TeemTalk
emulator window.

1. Display the Session menu from the menu bar and select Transport... to set the transport
method.

2. Display the Session menu and select Connection... to set the connection method.

3. Display the Session menu and select Emulation.... Set the emulation to IBM 3151.
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4. You can configure the transport, connection and emulation settings by selecting the relevant
Configure options in the Session menu. The options displayed by selecting Configure
emulation are described in the section Setup Options on page 118.

5. To save the session, display the File menu and select Save session as. In the File Name field,
enter a unique name that will identify this session configuration for future selection, then click
Save. Note that session files have the filename extension .tts.

6. To run the session, display the File menu and select Open Session. Select the name of the .tts
session file then click Open.

Keyboard Mapping
The functions of the computer keyboard are mapped as closely as possible to the terminal being
emulated. The mapping of key functions can be determined by referring to the Emulation Keys list
box in the Key Macro Settings dialog, which is displayed by selecting Key Macros... on the Tools
menu.

The information in brackets in the right column indicates the default mapping of the key function
named in the left column. In the list, S+ indicates the Shift key, C+ indicates the Control key and A+
indicates the Alt key. For example:

I51_TRACE (C+VK_F1)

indicates that the Trace function is mapped to the key combination Control + F1.

Special key functions usually found on an IBM 3151 keyboard can be mapped to any key on your
keyboard using the I51 virtual key names listed in the Key Macro Settings dialog.

The illustrations on the following pages show where IBM 3151 keyboard functions are mapped to
keys on a 101/102 key keyboard.

Figure 13-1  101/102 Key Keyboard Layout for the IBM 3151 Emulation
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Table 13-1  IBM 3151 Keyboard Mapping

Key Key
Modifier

Result  Key Key
Modifier

Result

1
none

Shift +

ESC

F13

 
23

none

Ctrl +

BACK TAB

LOCAL

2

none

Shift +

Ctrl +

F1

F14

RESET

 

24
none

Ctrl +

ERASE EOF

ERASE EOP

3

none

Shift +

Ctrl +

F2

F15

PRINT MESSAGE

 

25

 

CURSOR UP

4

none

Shift +

Ctrl +

F3

F16

BREAK

 

26

 

CURSOR LEFT

5

none

Shift +

Ctrl +

F4

F17

Setup

 

27

 

CURSOR DOWN

6

none

Shift +

Ctrl +

F5

F18

JUMP

 

28

 

CURSOR RIGHT

7

none

Shift +

Ctrl +

F6

F19

PRINT SCREEN

 

29
none

Ctrl +

/

JUMP

8

none

Shift +

Ctrl +

F7

F20

SEND MESSAGE

 

30
none

Ctrl +

SEND LINE

SEND MESSAGE

9

none

Shift +

Ctrl +

F8

F21

SEND LINE

 

31
none

Ctrl +

-

SETUP

10

none

Shift +

Ctrl +

F9

F22

CURSOR SELECT

 

32
none

Ctrl +

7

SUP

11

none

Shift +

Ctrl +

F10

F23

DISPLAY MESSAGE

 

33
none

Ctrl +

8

CURSOR SELECT
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Table 13-1  IBM 3151 Keyboard Mapping (continued)

Key Key
Modifier

Result  Key Key
Modifier

Result

12
none

Ctrl +

F11

ALRM UP

 
34

none

Ctrl +

9

DISPLAY MESSAGE

13
none

Ctrl +

F12

ALRM DOWN

 

35

none

Ctrl +

Alt +

-

LOCAL

,

14
 

PRINT VIEW
 

36
none

Ctrl +

4

SUB

15  PRINT LINE  37  5

16  HOLD  38  6

17
none

Ctrl +

RETURN

LINE FEED

 
39

none

Ctrl +

1

PA1

18
 

SEND
 

40
none

Ctrl +

2

PA2

19

none

Ctrl +

Shift +

INSERT

INSERT LINE

Define PF Key

 

41
none

Ctrl +

3

PA3

20
none

Ctrl +

HOME

DEL

 
42

none

Ctrl +

ENTER

SEND

21
none

Ctrl +

CLEAR

ERASE INPUT

 
43

 
0

22
none

Ctrl +

DELETE

DELETE LINE

 
44

 
.

NOTE: All unmarked keys function as indicated by the legends on the keycaps.

The Status Line
The last line of the emulation display is used as a status line which indicates the status of various
operations.
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Field Description

1 Indicates the current operating mode.

● BLOCK

Data entered on the keyboard is displayed and processed locally, allowing you to edit it before
a block of data is sent to the host.

● CHAR

Data entered on the keyboard is sent simultaneously to the host and the display.

● ECHO

Data entered on the keyboard is sent only to the host. The host is then responsible for
returning the data to the display.

2 INSERT indicates that Insert mode is active when the Insert key is pressed or when the Insert
Character command is received. Note that the message will not be displayed if the Insert
character option in the IBM 3151 Settings dialog is not set to Mode. Insert mode is exited by
pressing the Insert or Reset key.
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Field Description

3 ● HOLD SCREEN

Indicates that the Hold Screen key has been pressed to suspend screen update. Press Hold
Screen again to enable screen update.

● INVALID KEY

Indicates that you have pressed an invalid key.

● KEYS LOCKED

Indicates that the keyboard is locked. The keys will be unlocked when the Keyboard Unlock
command is received or when the Cancel key is pressed.

● NUMERIC

Indicates that the cursor is located in an unprotected numeric field.

● PRINTING

Indicates that data is being sent to the printer.

● SENDING

Indicates that data is being sent to the host

● WRONG PLACE

Indicates that you have pressed an invalid key in a protected field or field attribute character
position. It is also displayed when you try to insert a character or line in a screen already full
when the Forcing insert option in the IBM 3151 Settings dialog is set to Off.

If two or more messages are sent to a particular field, then the message with the highest priority will
be displayed. Messages are displayed in the following order:

HOLD SCREEN

SENDING

PRINTING

KEYS LOCKED

INVALID KEY

WRONG PLACE

NUMERIC

4 (rrr,ccc) indicates the current row and column position of the cursor.

Defining Function Keys
The keys mapped as F1 through F12 can be redefined from the keyboard or by the host. The function
keys can store up to 128 characters between them and can include escape sequences and ASCII
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control characters in addition to character strings. Here we describe how to define a function key from
the keyboard.

1. Press the keys Shift + Esc. to display the Define F key line along the bottom of the screen.

The line has two user-entry fields. The small first field specifies the F key to be defined, and the
second field is where the programmed contents is entered and displayed.

2. Specify the function key to be defined by entering a two-digit number in the first field, for
example, 01 for F1, 12 for F12, then press Enter. The second field will display the current
definition of the function key.

3. In the second field, enter the new definition for the function key. This can include a character
string, escape sequence or control characters.

A control character is entered by typing its keyboard equivalent. For example, the CR (carriage
return) character is entered by pressing Ctrl + M.

You can erase the character at the current cursor position by pressing the keys Ctrl + 2. If you
want to restore the default definition, press the Clear key.

4. Press the Send key to store the key definition. The Define F key line will be cleared to allow you
to enter the next key definition. If you do not want to save the definition, press Shift + Esc
instead of Enter.

NOTE: The function keys can store a maximum of 128 characters between them. When this
number is reached or exceeded, field A will start blinking and any characters following the 128th
character will be discarded.

5. Repeat steps 2 to 4 until you have finished defining function keys.

6. To exit from the Define F key display, press Shift + Esc.

Setup Options
The IBM 3151 emulation is configured using setup options in the IBM 3151 Settings dialog which can
be displayed using one of the following three methods:

Using the Session Wizard:

◦ In Step 1 set Emulation to IBM 3151 then click the Configure button.

Using the TeemTalk Window:

◦ On the Session menu, select Emulation > IBM 3151 then select Configure Emulation....

◦ On the configuration bar, select IBM 3151 in the Emulation list box then click Configure
Emulation.

The setup options are grouped on three tabs labelled General, Display and Preferences.
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General Settings

● Model

Factory default: 11

This option identifies the terminal model being emulated in response to a terminal identification
request from the host. Model 11 supports only one viewport containing 24 or 25 rows and 80
columns. Model 31 supports up to three viewports (80 or 132 columns wide) and pass-through
printing.

● Operating Mode

Factory default: Echo

The setting of this option determines how keyboard entered data is sent to the host and
displayed on the screen.

◦ Echo mode, keyboard entered data is sent only to the host. The host is then responsible for
returning the data to the display.

◦ Character mode, keyboard entered data is sent simultaneously to the host and the display.

◦ Block mode, keyboard entered data is displayed and processed locally, allowing you to edit
it before a block of data is sent to the host.
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● Terminal ID

Factory default: Unspecified

This specifies what is reported back to the host in response to a terminal identification request.
The terminal ID can be up to 20 characters long. Note that not all features of the specified
terminal may be supported.

● Font

Factory default: Courier New

This enables you to specify the font to be used for displaying characters. The available settings
depend on the fonts installed.

● Character set

Factory default: Multinational

This enables you to specify the character set to be used for displaying characters.

The PC Ansi setting will use the PC (ANSI) character set specified by the Ansi codepage
option.

When ISO Hebrew is selected, the following key functions will be enabled:

◦ Ctrl + Alt + F1 Select Multinational 8-bit mode and left-to-right typing.

◦ Ctrl + Alt + F2 Select National 7-bit mode (lowercase English characters will be displayed
as Hebrew) and right-to-left typing.

◦ Ctrl + Alt + F3 Toggle between left-to-right and right-to-left typing.

● Ansi codepage

Factory default: PC Multinational (437)

This option specifies the character set used for display when the Character set option is set to
PC Ansi.

Each code page consists of two tables of characters. The first table is the standard ASCII
character set. The second table contains special characters which differ between the code
pages.

When PC Hebrew (862) is selected, the following key functions will be enabled:

◦ Ctrl + Alt + F1 Select Multinational 8-bit mode and left-to-right typing.

◦ Ctrl + Alt + F2 Select National 7-bit mode (lowercase English characters will be displayed
as Hebrew) and right-to-left typing.

◦ Ctrl + Alt + F3 Toggle between left-to-right and right-to-left typing.

● Multinational mode

Factory default: Checked

The setting of this option determines the type of character set used to generate characters.

When unchecked, National mode is active in which a character set specific to the selected
keyboard nationality is used.
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When checked (default), Multinational mode is active in which a character set consisting of two
tables of characters is used. This enables characters from any keyboard nationality to be
generated.

Display Settings

● Row and column

Factory default: 24 x 80

This option enables you to select one of several display formats:

Row and column setting Effect on display

24 x 80 24 rows x 80 columns

24 x 80 25 rows x 80 columns

28 x 80 28 rows x 80 columns

24 x 132 24 rows x 132 columns

25 x 132 25 rows x 132 columns

28 x 132 28 rows x 132 columns
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NOTE: The contents of the display will be cleared when you change the display format.

● Auto wrap

Factory default: Checked

The setting of this option determines what happens to the cursor and data sent to the display
when the end of the current line is reached.

When checked, the cursor will automatically move to the beginning of the next line. Note that this
will always be the case in block mode or in a formatted page regardless of the setting of this
option.

When unchecked, the cursor will remain at the end of the current line and each new character
sent to the display will overwrite the character already occupying the cursor position.

● Auto line feed

Factory default: Unchecked

The setting of this option in conjunction with that of the Auto new line option determines the
destination of the cursor when the Return key is pressed or the CR character is received.

When both this and the Auto new line options are unchecked, the cursor will move to the first
position of the current line when the Return key is pressed or the CR character is received.

When this is unchecked and Auto new line is checked, the cursor will move to the first position
of the next line when the Return key is pressed.

When this is checked and Auto new line is unchecked, the cursor will move to the first position
of the next line when the Return key is pressed or the CR character is received.

When both this and the Auto new line options are checked, the cursor will move to the first
position of the line after the next line when the Return key is pressed.

● Auto new line

Factory default: Unchecked

The setting of this option determines the effect of pressing the Return key.

When unchecked, the Return key will generate a CR (carriage return) character.

When checked, the Return key will generate a CR and an LF (line feed) character.

● Cursor style

Factory default: Block

This enables you to specify how the text cursor is displayed. Select from Block, Underline,
Static block, Static underline or None.

● Jump scroll

Factory default: Checked

The setting of this option determines whether data is scrolled one or several lines at a time when
the window becomes full.

When checked, data will scroll up several lines at a time as determined by the Scroll rate setting
below.
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● Scroll rate

Factory default: 24

This determines the number of lines that are scrolled when the Jump scroll option above is
selected.

● Cursor moves right to left

Factory default: Unchecked

This enables you change the direction in which the text cursor moves across the display.

● Copy right to left

Factory default: Unchecked

This enables the copy commands to function in right to left display mode.
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Preferences

● Turnaround char

Factory default: CR

This option specifies the line turnaround character (LTC) that is generated when a Read
command is received or one of the block data transmission keys is pressed. Note that selecting
DC3 will disable the XON/XOFF inbound and outbound pacing characters.

● Forcing insert

Factory default: Both

This option specifies how an insert command affects displayed data when the screen is full.

When set to Off, you will not be able to perform an insert operation.

When set to Line, you will be able to insert one or more lines, using the Ins Ln key for example.
The contents of the current and all following lines will move down the number of lines inserted,
causing the lines originally at the bottom of the display to be discarded.

When set to Character, you will be able to insert one or more characters in the current line.
Characters to the right of the cursor position will move along. If the Auto Wrap option is set to
No, then characters originally at the end of the current line will be discarded. If set to Yes,
characters on all following lines will move along, forcing characters at the end of the last line to
be discarded.

When set to Both, the function of the Line and Character settings will be enabled.

● Insert character
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Factory default: Space

The setting of this option determines the effect of pressing the Insert key.

When set to Space, a space character will be inserted after the current cursor position.

When set to Mode, the emulation will enter Insert mode when the Insert key is pressed.

● Tab operation

Factory default: Field

The setting of this option determines whether tab stops are according to field attribute characters
or column-tab definitions.

When set to Field, tab stops in a formatted page are provided by field attribute characters.
Column-tab definitions are ignored.

When set to Column, tab stops are provided by column-tab definitions. Field attribute characters
are ignored.

When this is selected and Auto new line is unchecked, the cursor will move to the first position
of the next line when the Return key is pressed or the CR character is received.

When both this and the Auto new line options are selected, the cursor will move to the first
position of the line after the next line when the Return key is pressed.

● Enter key

Factory default: Return

This option enables you to specify whether the Enter key performs the same function as the
Return key or the Send key.

● Return key

Factory default: Field

This option specifies whether or not the cursor can enter a line within a protected field when the
Return key is pressed.

When set to Field, the result of pressing the Return key is determined by the setting of the Auto
new line option and the cursor will move to the next unprotected line.

When set to New Line, the result of pressing the Return key is determined by the setting of the
Auto new line option.

● Send operation

Factory default: Page

The setting of this option determines the effect of pressing the Send and Send Line keys.

When set to Page, the contents of the current page will be sent to the host when Send is
pressed, or the current line if Send Line is pressed.

When set to Line, the contents of the current line will be sent to the host when Send is pressed,
or the current page if Send Line is pressed.
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14 IBM 3270 Display Emulation

This chapter describes features of the IBM 3270 display emulation.

Creating a IBM 3270 Display Emulation Session
You can create a session either using the TeemTalk Session Wizard or while TeemTalk is running.

Using the TeemTalk Session Wizard
This section describes how to use the TeemTalk Session Wizard to create an IBM 3270 Display
emulation session.

1. To run the TeemTalk Session Wizard from the Start menu, select All Programs > HP > HP
TeemTalk Terminal Emulator > Session Wizard.

2. In the Session Name field, enter a unique name that will identify this session configuration for
future selection.

3. Select the Transport method then click the Configure button to specify settings.

4. Select the Connection type then click the Configure button to specify settings.

5. Select IBM3270 Display in the Emulation list box then click the Configure button to specify
settings. (The options are described in the section Setup Options on page 138.)

6. Click Next to display the Advanced Options dialog.

7. Click Next to display the Finalization dialog.

8. If you want a shortcut icon for this session to be created on the desktop, click the checkbox
Create icon on desktop for session.

9. Click OK to create the session and exit.

10. To run the session, either double-click on the desktop icon if one was created for the session, or
run TeemTalk, display the File menu and select Open Session. Select the name of the
required .tts session file then click Open.

Using the TeemTalk Emulator Window
This section describes the procedure for creating a IBM 3270 Display emulation session from the
TeemTalk emulator window.

1. Display the Session menu from the menu bar and select Transport... to set the transport
method.

2. Display the Session menu and select Connection... to set the connection method.

3. Display the Session menu and select Emulation.... Set the emulation to IBM3270 Display.
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4. You can configure the transport, connection and emulation settings by selecting the relevant
Configure options in the Session menu. The options displayed by selecting Configure
emulation are described in the section Setup Options on page 138.

5. To save the session, display the File menu and select Save session as. In the File Name field,
enter a unique name that will identify this session configuration for future selection, then click
Save. Note that session files have the filename extension .tts.

6. To run the session, display the File menu and select Open Session. Select the name of the .tts
session file then click Open.

IBM 3270 Display Emulation Capabilities
The IBM 3270 terminal emulation supports Extended Attribute mode which allows different
representation of highlighted fields and permits host definition of text colors. (Note that you can
modify colors using the Attribute Settings dialog, but they cannot be saved as colors are mapped
differently in this mode.) The emulation also includes typeahead capability so that you can continue to
enter data without waiting for a prompt from the host.

Keyboard Mapping
The functions of the computer keyboard are mapped as closely as possible to the terminal being
emulated. The mapping of key functions can be determined by referring to the Emulation Keys list
box in the Key Macro Settings dialog, which is displayed by selecting Key Macros... on the Tools
menu.

The information in brackets in the right column indicates the default mapping of the key function
named in the left column. In the list, S+ indicates the Shift key, C+ indicates the Control key and A+
indicates the Alt key. For example:

IB_ERASEINPUT (S+VK_PAUSE)

indicates that the Erase Input function is mapped to the key combination Shift + Pause.

Special key functions usually found on an IBM 3270 keyboard can be mapped to any key on your
keyboard using the IB virtual key names listed in the Key Macro Settings dialog.
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The illustrations on the following pages show where IBM 3270 keyboard functions are mapped to
keys on a 101/102 key keyboard.

Figure 14-1  101/102 Key Keyboard Layout for the IBM 3270 Display Emaulation

Table 14-1  IBM 3270 Display Keyboard Mapping

Key Key Modifier Result  Key Key Modifier Result

1

none

Shift +

Alt +

RESET

ATTN

QUIT

 

24

none

Shift +

Alt +

ERASE EOF

GO TO END OF LINE

ERASE INPUT

2
none

Shift +

F1

F13

 

25

none

Shift +

Alt +

PA2

COPY

RULE DISPLAY

3

none

Shift +

Alt +

F2

F14

NOTICE BOARD SETUP

 

26

 

CURSOR UP

4

none

Shift +

Alt +

F3

F15

FN EDIT

 

27
none

Alt +

CURSOR LEFT

PREVIOUS WORD

5

none

Shift +

Ctrl +

F4

F16

MONO CASE

 

28

 

CURSOR DOWN

6
none

Shift +

F5

F17

 
29

none

Alt +

CURSOR RIGHT

NEXT WORD

7

none

Shift +

F6

F18

 

30

none

Shift +

/

REVERSE INPUT
DIRECTION
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Table 14-1  IBM 3270 Display Keyboard Mapping (continued)

Key Key Modifier Result  Key Key Modifier Result

8

none

Shift +

Alt +

F7

F19

RECORD

 

31
none

Shift +

*

CLOSE (DELETE SPACE)

9

none

Shift +

Alt +

F8

F20

PLAY

 

32

none

Shift +

Shift + Ctrl +

Shift + Ctrl + Alt +

SELECTABLE FIELD TAB

LOCAL NATIONAL MAP

PUSH MODE ON/OFF

ALTERNATE CODE PAGE

10

none

Shift +

Shift + Alt +

F9

F21

CURSOR SELECT

 

33
none

Alt +

7

HOME

11

none

Shift +

Shift + Ctrl +

Alt +

F10

F22

CURSOR FLASH ON/OFF

DISPLAY ATTRIBUTES

 

34
none

Alt +

8

CURSOR UP

12

none

Shift +

Shift + Ctrl +

F11

F23

CURSOR LINE/BLOCK

 

35
none

Alt +

9

PA1

13
none

Shift +

F12

F24

 
36

 
+

14
none

Alt +

PRINT

SYSREQ

 
37

none

Alt +

4

CURSOR LEFT

15 Alt + TEST KEY TO HOST  38  5

16

none

Shift +

Alt +

Shift + Alt + Ctrl +

CLEAR

ERASE INPUT

PAUSE

DELAY 1 SECOND

 

39
none

Alt +

6

CURSOR RIGHT

17

none

Shift +

Ctrl +

TAB

BACK TAB

FIELD TAB

 

40
none

Alt +

1

E EOF

18
none

Shift +

BACKSPACE

REVERSE SCREEN

 
41

none

Alt +

2

CURSOR DOWN

19
 

RETURN
 

42
none

Alt +

3

PA2
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Table 14-1  IBM 3270 Display Keyboard Mapping (continued)

Key Key Modifier Result  Key Key Modifier Result

20
none

Shift +

INSERT

DUPLICATE

 
43

 
ENTER

21

none

Shift +

Ctrl +

HOME

FIELD MARK

JUMP

 

44
none

Alt +

0

INSERT

22

none

Shift +

Shift + Ctrl +

Ctrl +

Alt +

PA1

PA3

NOTICE BOARD COPY

NOTICE BOARD JUMP

NOTICE BOARD ZOOM

 

45

 

.

23
none

Alt +

DELETE CHARACTER

DELETE WORD

    

NOTE: All unmarked keys function as indicated by the legends on the keycaps.

SysReq Key Support
When the SysReq option in the Telnet Options dialog is selected, the key mapped with the SysReq
function enables you to toggle the display and keyboard entries between the host operating system
and the application. This enables you to switch to the operating system and issue a LOGOFF
command.

The status line will display the following symbol when communicating with the operating system:

NOTE: Not all TN3270E servers provide full support of the SysReq key.

Network Virtual Terminal Mode
Network Virtual Terminal (NVT) mode allows the operator to communicate in ASCII format with a
network gateway for routing, logon etc, before the full IBM terminal emulation protocol is established.

The following symbol is displayed on the status line when in NVT mode:

NVT mode displays an unformatted screen for data entry, allowing most of the keyboard functionality
for local editing. However, when the Enter key is pressed, the line that the cursor is positioned on will
be sent over Telnet as an ASCII string with CR/LF terminators. The cursor will then be positioned at
the start of the next line. ASCII data received over Telnet will also be displayed at the current cursor
position. A CR character will be actioned as a 'new line' character, causing the cursor to move to the
start of the next line, scrolling the display if necessary.
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Once the appropriate details have been entered to establish an IBM host session (which may be
automatic), the screen is cleared and switched into full IBM 3270 terminal emulation mode, as
indicated by the following status line symbol:

The Status Line
The last line of the IBM 3270 screen is used to display status information in the form of symbols and
alphanumeric characters.

Operating Mode & Communication

 Indicates that a Telnet session is running.

 Indicates that you are online but the communication protocol is not System Network

Architecture (SNA).

 Indicates that the current screen is a Network Virtual Terminal screen. This screen is

displayed when IBM 3270 mode is entered before a telnet session has been initiated with the remote
host. It enables you to enter login text in ASCII format. You will be returned to this screen when you
log off.

Indicates that the current screen is an IBM 3270 screen. This screen will be displayed when

you have initiated a Telnet session with the host.

 Indicates that you are currently communicating with the host operating system, not the

application.

Do Not Enter
A cross symbol will appear when input from the keyboard or mouse will not be accepted by the host
(except Reset and SysReq). Symbols to the right of this will indicate the reason. Pressing the Reset
key will remove some of these symbols from the status line.

Note that the emulation includes typeahead capability so that in most cases you can continue to enter
data without waiting for the Do Not Enter message to clear as the data will be stored until the host is
ready.

 Indicates that a programming error in the data from the host has been

detected, possibly due to incompatible application software. Press the Reset or SysReq key to
remove this indicator and unlock the keyboard.

 Indicates that you must wait while the requested function is performed.

 Indicates that you tried to enter an invalid character into a numeric field when the

numeric-lock feature was active. The keyboard numeric-lock feature can be overridden by using a
Shift key. The keyboard can be unlocked and the indicator removed by pressing the Reset key.
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 Indicates that you tried to enter data in the wrong location. This will occur when you

attempt to do any of the following:

● Enter, insert, erase, or delete a character when the cursor is in a protected field or at a field
attribute location.

● Perform a cursor-select operation when the cursor is not in a valid cursor-select field.

The keyboard can be unlocked and the indicator removed by pressing the Reset key.

 Indicates that you cannot enter any data because the application program has

disabled the keyboard following an entry.

 Indicates that you attempted to insert characters into an unprotected field when the cursor

was at the end of the field, or you attempted to word wrap to the next line when there was not enough
space to enable a word wrap.

The keyboard can be unlocked and the indicator removed by pressing the Reset key.

Typing Direction

  Indicates the direction in which characters are displayed on the screen when

typed. The direction is toggled between left-to-right (normal) and right-to-left by pressing the keys
Shift + / on the keypad.

Bilingual Keyboard Mode

  Indicates whether the National (N) or Latin (L) character set is active when a code

page that supports a bilingual keyboard is selected. Pressing the keys Shift + - on the keypad will
toggle between the two character sets.

Numeric Lock

 Indicates that the numeric lock function is enabled and the current cursor is in a numeric

field. When the numeric lock function is on, the current cursor is in an unprotected field and the
keyboard is in lowercase shift, you can only use the 0 to 9, decimal sign (.), minus (-), and Dup keys.

Insert Mode

 Indicates that the keyboard is in Insert mode. Existing characters to the right of the cursor

will move to make room for new characters that are entered. Insert mode can be disabled by pressing
the Reset or SysReq key, or by performing any action that sends data to the host, such as pressing
the Enter, Clear, PA, or PF keys.

Display Direction

  Indicates the orientation of the screen display. A right arrow indicates normal left-

to-right display, a left arrow indicates a right-to-left mirror image display. The display can be toggled
between the two directions by pressing the keys Shift + Backspace.
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Cursor Position

 Indicates the row and column position of the text cursor.

Text Display Options
Display Right-to-Left

The contents of the screen can be displayed in reverse, i.e. as a right-to- left mirror image, by
pressing the keys Shift + Backspace. This is a toggle function, so pressing the keys again will revert
to normal left-to-right display. An arrow will be displayed on the status line (next to the row/column
number) to indicate normal (right arrow) or mirror (left arrow) display.

Typing Direction
The direction in which characters are displayed on the screen when typed can be toggled between
normal left-to-right and right-to-left by pressing the keys Shift + / on the keypad. The following
symbols will be displayed on the status line to indicate the current typing direction:

Selecting the Symbol Swap option on the Display tab of the 3270 Display Settings dialog will
cause text symbols such as round or angle brackets to be displayedin the correct orientation when
typing right-to-left.

Close Key
If text has been typed using both typing direction modes in the same line or field, you can force the
right-hand text to join the left-hand text by pressing the keys Shift + * on the keypad.

Push Mode
Push mode allows you to edit text whose direction is opposite the screen orientation. In this mode the
cursor orientation is reversed and a Push segment is created. Push mode is toggled on/off by
pressing the keys Ctrl + Shift + - (keypad minus).

Push mode has two secondary modes, Boundary mode and Edit mode.

Boundary mode is activated when Push mode is entered. The cursor will remain at its current position
while you type additional characters, and text will be pushed in the opposite direction of the screen
orientation.

Edit mode is activated when the cursor is moved from its Boundary position into the Push segment
area. In this mode, text can be edited within the Push segment while typing in the field's natural
direction.

ENWW Text Display Options 133



Bilingual Keyboard Support
When a code page that supports a bilingual keyboard is selected, you can toggle between the
National and Latin character set by pressing the keys Shift + - on the keypad. The character N or L
will be displayed on the status line to indicate which character set is currently active.

Selecting the Numeral Swap option in the 3270 Display Settings dialog will cause all numbers to be
displayed using the National character set when in Latin character set mode.

Alternate Code Page
If a language supports two code pages (e.g. Hebrew New Code and Hebrew Old Code), you can
switch between the two by pressing the keys Ctrl + Shift + Alt + - on the numeric keypad. This
function can be assigned to a different key or key combination by using the IB_ALTCP virtual key
name.

Record & Playback Keystrokes Facility
The record/playback keystrokes facility enables you to eliminate repetitive operations by using the Fn
keys to store, retrieve and display data. The Fn keys can store a total of 1500 keystrokes. A
sequence of recorded keystrokes may be interrupted so that keystrokes can be entered manually
before continuing with the recording or playback. Note that local Fn key functions cannot be recorded.

The keys used to initiate recording and playback are shown below together with the equivalent virtual
key names that can be used to assign the functions to any key on the keyboard:

 101/102 Key Keyboard Virtual Key Names

Record: Alt + F7 IB_RECORD

Pause: Shift + Pause IB_PAUSE

Quit: Alt + Escape IB_QUIT

Play: Alt + F8 IB_PLAY

Edit: Alt + F3 IB_FEDIT

Recording Keystrokes
The following procedure describes how to record keystrokes.

1. Press Record to enter Record mode.

The status line will display RECRD and a number from 0-1500 indicating the number of new
keystrokes that may be stored. A series of boxes displayed to the right represent the Fn keys. A
solid box indicates that the Fn key in that position is currently storing recorded keystrokes.

134 Chapter 14   IBM 3270 Display Emulation ENWW



2. Press the Fn key that will store the keystrokes. (On 101/102 keyboards you can also use Shift +
Fn.)

The status line will display R**** F* where R indicates you are in Record mode, **** is the
number of keystrokes that may be stored, and F* is the number of the Fn key pressed.

NOTE: If you press a pre-recorded Fn key, its contents will be replaced with the following
keystrokes. You can also remove the contents of the Fn key before recording by pressing the
Delete key.

3. Enter the keystrokes to be recorded.

You may pause recording at any time to allow keystrokes to be entered manually when played
back by pressing Pause. To continue recording, press Pause again.

NOTE: You can cancel the newly recorded keystrokes by pressing the Quit key. This
cancellation does not affect the previously recorded keystrokes.

4. To finish and save the recording, press the Record key.

Playback Keystrokes
You can play back the contents of an Fn key as normal or one keystroke at a time. The following
procedure describes normal playback. For one keystroke playback, select Single Step Macros on
the Notice Board Settings tab of the 3270 Display Settings dialog.

1. Position the text cursor where the playback is to start.

2. Press the Play key to enter Play mode.

The status line will display PLAY and a series of boxes representing the Fn keys. A solid box
indicates that the Fn key in that position is currently storing recorded keystrokes.

3. Press the Fn key storing the recorded data to playback.

Playback will begin immediately, as indicated by a P on the status line. All the recorded
keystrokes will be played back automatically. When playback is completed the P will disappear.

If the recorded keystrokes included Pause, then playback will halt at that point to allow you to
enter keystrokes manually. Press Play to resume playback from where you stopped typing.

If you want to cancel during the playback operation, press the Quit key.

Editing Macros
1. Press Alt + F3.

2. Press the Fn key containing the macro to be edited.
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The status line will display information about the Fn key macro as follows:

● Displays EDIT or INSERT depending on the current mode.

● Number of new keystrokes that may be stored.

● Current Fn key number.

● Cursor position within the macro (i.e. the number of keystrokes from the start of the macro).

● Contents of the macro.

3. Use the Left or Right cursor keys to move the cursor one character position at a time through
the macro, or the Up or Down cursor keys to move 20 character positions at a time.

4. If required, press the Insert key to toggle between Insert and Edit mode, as indicated in the
status line.

5. Make the required changes to the macro.

6. To save the edit, press Alt + F3.

7. Press Quit to exit.

Error Codes
The following error codes may appear on the status line if an error occurs during recording or
playback.

Table 14-2  Recording/Playback Error Codes

9001 Exceeded the maximum number of allowed keystrokes.

Remedy: Press the Record key to exit Record mode. To record a new keystroke sequence, either:

● Press the Record key and the target Fn key that has erasable data, then enter the new data, or:

● Press the Record key and the target Fn key that has erasable data, then press the Delete key to erase
the recorded data for that key.

9003 You pressed an invalid Fn key while performing the Record or Play function.

Remedy: Press the Reset key.

9007 You pressed an invalid sequence key (e.g. Play) while performing the Record function.

Remedy: Press the Reset key.

9010 While performing the Play function, you pressed an Fn key that does not have a keystroke assigned to it.

Remedy: Press the Reset key.

9015 In communication mode, you pressed either the Quit or Pause key.

Remedy: Press the Reset key.

9019 In Record or Play mode. While the Record/play pause indicator was displayed on the status line you pressed
an invalid key (e.g. Play key in Record mode, or Record key in Play mode).

Remedy: Press the Reset key.
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Notice Board Facility
Introduction

The Notice Board is an area of the display in which copied data can be stored and manipulated. You
can display the Notice Board either by pressing the keys Alt + F2, or by selecting the Notice Board
Enabled option on the Notice Board Settings tab of the 3270 Display Settings dialog (see Notice
Board Settings on page 147).

When the Notice Board is enabled, pressing the Zoom key will toggle the display between full screen
(i.e. the screen currently containing the cursor) and split screen (host screen and Notice Board)
mode. The Zoom Settings options on the Notice Board Settings tab of the 3270 Display Settings
dialog determine which screen is displayed above the other. When viewing the display, pointers at
each end of the dividing line between the two screens indicate which is the host screen.

Key Functions
The keys used by default for Notice Board functions are shown below together with the equivalent
virtual key names that can be used to assign the functions to any key on the keyboard.

 101/102 Key Keyboard Virtual Key Names

NB Setup: Alt + F2 IB_NB_SETUP

Zoom: Alt + Page Up IB_NB_ZOOM

Jump: Ctrl + Page Up IB_NB_JUMP

NB Copy: Ctrl + Shift + Page Up IB_NB_COPY

Copy: Shift + Page Down IB_COPY

Copying Screen Data to the Display
1. Position the text cursor at the start of the area to be copied.

2. Press the Copy key to start the Copy function. Note that the status line will display the key
functions available.

3. Use the cursor keys to move the text cursor to the diagonally opposite corner of the display area
to be copied. The currently selected area will be highlighted in green. Note that you can toggle
the position of the text cursor between the two diagonally-opposite corners of the selected area
by pressing the Return key.

4. Press F13 to copy the selected area. The copied area (i.e. the target) will be highlighted in red.

5. Use the cursor keys to move the red target area to the required position on the display. You can
also use the Jump key to move the target area to the host screen or Notice Board.

6. Press Enter on the numeric keypad to save the copied area at the current position on the
display.
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Copying Screen Data to a Function Key
The following procedure describes how to copy screen data to a function key. Note that the 3270
Display Settings dialog has several options that determine whether this facility is enabled and
whether all screen data in the selected area is copied, or only data in user entry fields. See Notice
Board Settings on page 147 for details.

1. Position the text cursor at the start of the area to be copied.

2. Press the Copy key to start the Copy function. Note that the status line will display the key
functions available.

3. Use the cursor keys to move the text cursor to the diagonally opposite corner of the display area
to be copied. The currently selected area will be highlighted in green. Note that you can toggle
the position of the text cursor between the two diagonally-opposite corners of the selected area
by pressing the Return key.

4. Press F14 to copy the selected area.

5. Press the function key required to store the copied data.

6. Press Enter on the numeric keypad to store the copied data in the chosen function key.

Setup Options
The IBM 3270 Display emulation is configured using setup options in the 3270 Display Settings
dialog which can be displayed using one of the following three methods:

Using the Session Wizard:

◦ In Step 1 set Emulation to IBM 3270 Display then click the Configure button.

Using the TeemTalk Window:

◦ On the Session menu, select Emulation > IBM 3270 Display then select Configure
Emulation....

◦ On the configuration bar, select IBM 3270 Display in the Emulation list box then click
Configure Emulation.

The setup options are grouped on five tabs labelled Model, National, Display, Keyboard and Notice
Board.
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Model Settings

● Model

Factory default: IBM-3278-3-E (32x80 Colour)

This specifies what is reported back to the host in response to a terminal identification request.
Note that not all features of the specified terminal may be supported.

One of four display sizes can be selected:

3278/9-2 24 rows by 80 columns

3278/9-3 32 rows by 80 columns

3278/9-4 43 rows by 80 columns

3278/9-5 27 rows by 132 columns

3278 settings with the E extension provide support for the following extended attributes (these
are supported by the 3279 as standard):

◦ 3270 Field Attributes

◦ Extended Highlighting

◦ Foreground Color

◦ Query Reply Inbound Structured Fields

● Telnet 3270 Regime

Factory default: Unchecked

Check this box to enable support for the Telnet 3270 regime, otherwise it will be suppressed.

● Telnet 3270E

Factory default: Unchecked

Check this box to enable support for the Telnet 3270E regime, otherwise it will be suppressed.
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● LU Connect Name

This specifies the name of the device which the server will be requested to assign to the Telnet
session.

You can return the local host name by entering %s after the device name. To return the user
name, enter %u after the device name. You can specify how many characters of the name is
returned in each case. For example, %.3s will return the first three characters of the local host
name, and %-.3s will return the last three characters.

To automatically assign a new device name for each successive connection, either enter %dN%
after the name, where N is a decimal value, or %xN%, where N is a hexadecimal value. Each
time the host requests the device name a counter will be substituted into the device name. If the
host rejects the device name as in use the counter will be incremented modulus N and the name
retried until all possibilities have been tried, at which point the emulation will report a device
name rejected error.

For example, TEST%d4% will give TEST1 on all connections until the host rejects the name as
in use, in which case TEST2 will be used. If this is already in use then TEST3 is used, or if
already in use then TEST0. These values are preserved over power off, so the first connection
of any given power on may not be TEST1. Assume that the start point is random.

When you achieve a TN3270E connection, the LU device name that you are connected as will
be displayed on the status line. If the specified device is rejected by the server or host, then an
error message box will be displayed indicating the reason.

● Bind

Factory default: Unchecked

When this option is checked the server is allowed to send the SNA Bind image and Unbind
notification to the emulator.

● Responses

Factory default: Unchecked

Check this option to support positive and negative response handling. This allows the server to
reflect to the emulator any and all definite, exception, and no response requests sent by the host
application.

● SysReq

Factory default: Unchecked

Checking this option will enable the functions of the SysReq key. As some servers may not
support, or may only partially support SysReq, the level at which the SysReq key will function
will depend on the server.
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National Settings

These options enable you to select the character set to be used. There are separate entries for the
Single Byte Character Set (SBCS) and (if supported) Double Byte Character Set (DBCS). These
should only be changed by the System Administrator. If they have been changed and you wish to
restore the default settings, click the Defaults button at the bottom of the dialog. The table at the end
of this section shows the default settings.

● National Codepage Settings

Factory default: User Defined

This specifies the type of national codepage to be used. Selecting User Defined will enable
manual selection of the Codepage, Character Set and Character Set ID using the following
options.

● SBCS / DBCS Codepage

Factory default: SBCS 37 - DBCS 0

This is a numeric value specifying the codepage to use.

● SBCS / DBCS Character Set

Factory default: SBCS 697 - DBCS 0

This is a numeric value specifying the character set to use.

● SBCS / DBCS Character Set ID

Factory default: SBCS 37 - DBCS 0

This specifies character set ID.

● Font

Factory default: Courier New

This enables you to specify the font to be used for displaying characters. The available settings
depend on the fonts installed.
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Table 14-3  Default Language, Codepage & Character Set Settings

Language Type Codepage Char Set CCSID

English (US) SBCS 37 697 37

English (UK) SBCS 285 697 285

Belgian SBCS 500 697 500

Canadian French SBCS 37 697 37

Danish SBCS 277 697 277

Finnish SBCS 278 697 278

German SBCS 273 697 273

Dutch SBCS 37 697 37

Italian SBCS 280 697 280

Swiss French SBCS 500 697 500

Swiss German SBCS 500 697 500

Swedish SBCS 278 697 278

Norwegian SBCS 277 697 277

French SBCS 297 697 297

Spanish SBCS 284 697 284

Portuguese SBCS 37 697 37

Japanese Kanji + Katakana SBCS 290 1172 290

 DBCS 300 1001 930

Korean SBCS 833 1173 833

 DBCS 834 934 933

Simplified Chinese SBCS 836 1174 836

 DBCS 837 937 937

Traditional Chinese SBCS 37 1175 37

 DBCS 835 935 935

Hebrew New Code SBCS 424 941 424

Hebrew Old Code SBCS 803 941 424

Thai SBCS 838 1176 838

Greek SBCS 875 925 875

Cyrillic SBCS 880 960 880

Turkish SBCS 1026 1152 1026

Russian SBCS 1025 1150 1025
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Table 14-3  Default Language, Codepage & Character Set Settings (continued)

Language Type Codepage Char Set CCSID

Czech SBCS 870 959 870

Slovak SBCS 870 959 870

Polish SBCS 870 959 870

Icelandic SBCS 871 697 871

Arabic SBCS 420 697 285

Table 14-4  IBM EBCDIC Codepages Supplied

Codepage Type Countries

37 SBCS USA, Canada, Netherlands, Portugal, Brazil

273 SBCS Austria, Germany

274 SBCS Belgium (old)

277 SBCS Denmark, Norway

278 SBCS Finland, Sweden

280 SBCS Italy

284 SBCS Spain, Latin America (Spanish)

285 SBCS UK

290 SBCS Japanese - Katakana

297 SBCS France

300 DBCS Japanese - Kanji

420 SBCS Arabic

424 SBCS Hebrew New Code

500 SBCS (Latin 1) Belgium, Canada, Switzerland

803 SBCS Hebrew Old Code

833 SBCS Korean

834 DBCS Korean

835 SBCS Traditional Chinese

836 SBCS Simplified Chinese

837 DBCS Simplified Chinese

838 SBCS Thai

870 SBCS (Latin 2) Czech, Slovak, Polish

871 SBCS Icelandic
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Table 14-4  IBM EBCDIC Codepages Supplied (continued)

Codepage Type Countries

875 SBCS Greek

880 SBCS Cyrillic

905 SBCS (Latin 3) Turkish (old)

1025 SBCS Russian Cyrillic

1026 SBCS (Latin 5) Turkish

1027 SBCS Japanese - Latin extended

1140 SBCS [EURO] USA, Canada, Netherlands, Portugal, Brazil

1141 SBCS [EURO] Austria, Germany

1142 SBCS [EURO] Denmark, Norway

1143 SBCS [EURO] Finland, Sweden

1144 SBCS [EURO] Italy

1145 SBCS [EURO] Spain, Latin America

1146 SBCS [EURO] UK

1147 SBCS [EURO] France

1148 SBCS [EURO] Belgium, Canada, Switzerland

1149 SBCS [EURO] Icelandic
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Display Settings

● Monochrome

Factory default: Depends on the terminal type

By default the setting of this option will match the normal display characteristic of the particular
IBM 3270 model selected. In TeemTalk, all terminal types support both monochrome and color
display.

When monochrome is selected, characters will be displayed in green and intense fields will be
displayed in white. When monochrome is not selected, the settings specified in the Attributes
dialog will be used for the display. Refer to the chapter Display Attributes on page 48 for details.

● Show Rule Line

Factory default: Unchecked

This determines whether a rule line is displayed across the emulation workspace at the cursor
position. The setting of the Rule Line Style option determines whether it is displayed as a
horizontal rule, vertical rule or a cross.

NOTE: You can also toggle display of the rule line on and off by pressing the keys Alt + Page
Down.

● Rule Line Style

Factory default: Cross

The setting of this option determines whether the rule line is displayed as a horizontal rule,
vertical rule or a cross.

● Rule Line Follows Cursor

Factory default: Unchecked

When the rule is displayed in the emulation workspace, the setting of this option determines
whether or not the rule follows the cursor when it moves.

● Numeral Swap

Factory default: Unchecked
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When using a code page that supports a bilingual keyboard, this will cause all numbers to be
displayed using the National character set when in Latin mode.

● Symbol Swap

Factory default: Unchecked

Selecting this option will cause symbols such as brackets to be displayed the correct way round
when typing in right-to-left mode.

Keyboard Settings

● Keyboard Unlock Delay

Factory default: 0

When the keyboard is unlocked by the host, this specifies a delay in milliseconds before
characters are sent.

● Auto-repeat AID Keys

Factory default: Unchecked

This allows you to disable the auto-repeat key function just for AID keys.
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Notice Board Settings

● Notice Board Enabled

Factory default: Checked

When this option is checked, pressing the Zoom key will toggle the display between full screen
(i.e. the screen currently containing the cursor) and split screen (host screen and Notice Board)
mode. The following Zoom Settings options determine which is displayed above the other. Note
that the host screen contains the same number of rows and columns whether displayed full
screen or in split screen.

● Zoom Settings

Factory default: Notice Board Above Host

This determines whether the Notice Board is displayed above or below the host screen. When
viewing the display, pointers at each end of the dividing line between the two screens indicate
which is the host screen.

● Copy to F-Key Enabled

Factory default: Unchecked

This enables the facility for copying screen data to a function key. Refer to the section Copying
Screen Data to a Function Key on page 138 for details.

● F-Key Settings

Factory default: Copy Only User Fields to F-Key

Selecting Copy Only User Fields to F-Key will enable only data contained in user entry fields in
the selected area to be copied to a function key.

Selecting Copy All Data to F-Key will enable all screen data in the selected area (protected and
unprotected) to be copied.

Refer to the section Copying Screen Data to a Function Key on page 138 for details.

● Copy Function Enabled
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Factory default: Unchecked

This determines whether the copy functions are available for copying selected data to another
area of the display or to a function key.

● Single Step Macros

Factory default: Unchecked

Selecting this option will enable an Fn key macro to be played one keystroke at a time by
pressing the spacebar for each keystroke after issuing a play Fn key command. The status line
will display the contents of the macro and the cursor position in the status line indicates the point
that has been reached in the macro play back. Refer to the section Playback Keystrokes
on page 135 for details.
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15 IBM 3270 Printer Emulation

This chapter describes features of the IBM 3270 printer emulation.

Creating a IBM 3270 Printer Emulation Session
You can create a session either using the TeemTalk Session Wizard or while TeemTalk is running.

Using the TeemTalk Session Wizard
This section describes how to use the TeemTalk Session Wizard to create an IBM 3270 Printer
emulation session.

1. To run the TeemTalk Session Wizard from the Start menu, select All Programs > HP > HP
TeemTalk Terminal Emulator > Session Wizard.

2. In the Session Name field, enter a unique name that will identify this session configuration for
future selection.

3. Select the Transport method then click the Configure button to specify settings.

4. Select the Connection type then click the Configure button to specify settings.

5. Select IBM3270 Printer in the Emulation list box then click the Configure button to specify
settings. (The options are described in the section Setup Options on page 150.)

6. Click Next to display the Advanced Options dialog.

7. Click Next to display the Finalization dialog.

8. If you want a shortcut icon for this session to be created on the desktop, click the checkbox
Create icon on desktop for session.

9. Click OK to create the session and exit.

10. To run the session, either double-click on the desktop icon if one was created for the session, or
run TeemTalk, display the File menu and select Open Session. Select the name of the
required .tts session file then click Open.

Using the TeemTalk Emulator Window
This section describes the procedure for creating a IBM 3270 Printer emulation session from the
TeemTalk emulator window.

1. Display the Session menu from the menu bar and select Transport... to set the transport
method.

2. Display the Session menu and select Connection... to set the connection method.

3. Display the Session menu and select Emulation.... Set the emulation to IBM3270 Printer.
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4. You can configure the transport, connection and emulation settings by selecting the relevant
Configure options in the Session menu. The options displayed by selecting Configure
emulation are described in the section Setup Options on page 150.

5. To save the session, display the File menu and select Save session as. In the File Name field,
enter a unique name that will identify this session configuration for future selection, then click
Save. Note that session files have the filename extension .tts.

6. To run the session, display the File menu and select Open Session. Select the name of the .tts
session file then click Open.

IBM 3287-1 Printer Support
TN3287 printing is supported by setting the Model option in the 3270 Printer Settings dialog to
IBM-3287-1. When a new Telnet connection is made, the screen will display a message box
indicating the current printer status.

A Print Abort box will be displayed once printing commences, enabling you to cancel the print job.
Note that this will stop print data being sent but will not disconnect you from the host.

Setup Options
The IBM 3270 Printer emulation is configured using setup options in the 3270 Printer Settings dialog
which can be displayed using one of the following three methods:

Using the Session Wizard:

◦ In Step 1 set Emulation to IBM 3270 Printer then click the Configure button.

Using the TeemTalk Window:

◦ On the Session menu, select Emulation > IBM 3270 Printer then select Configure
Emulation....

◦ On the configuration bar, select IBM 3270 Printer in the Emulation list box then click
Configure Emulation.

The setup options are grouped on three tabs labelled Model, National and Print By Pass.
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Model Settings

● Model

Factory default: IBM-3287-1 (Printer)

This enables you to specify the particular printer model to emulate.

● Telnet 3270 Regime

Factory default: Unchecked

Selecting this option will suppress Telnet 3270 regime support.

● Telnet 3270E

Factory default: Unchecked

Selecting this option will suppress TN3270E support.

● LU Connect Name

Factory default: Unspecified

This specifies the name of the device which the server will be requested to assign to the Telnet
session. It may be used when requesting either a terminal or a printer session.

You can return the local host name by entering %s after the device name. To return the user
name, enter %u after the device name. You can specify how many characters of the name is
returned in each case. For example, %.3s will return the first three characters of the local host
name, and %-.3s will return the last three characters.

ENWW Setup Options 151



To automatically assign a new device name for each successive connection, either enter %dN%
after the name, where N is a decimal value, or %xN%, where N is a hexadecimal value. Each
time the host requests the device name a counter will be substituted into the device name. If the
host rejects the device name as in use the counter will be incremented modulus N and the name
retried until all possibilities have been tried, at which point the emulation will report a device
name rejected error.

For example, TEST%d4% will give TEST1 on all connections until the host rejects the name as
in use, in which case TEST2 will be used. If this is already in use then TEST3 is used, or if
already in use then TEST0. These values are preserved over power off, so the first connection
of any given power on may not be TEST1. Assume that the start point is random.

When you achieve a TN3270E connection, the LU device name that you are connected as will
be displayed on the status line. If the specified device is rejected by the server or host, then an
error message box will be displayed indicating the reason.

● Bind

Factory default: Unchecked

This determines whether the server is allowed to send the SNA Bind image and Unbind
notification to the emulator.

● Responses

Factory default: Unchecked

When this is selected, positive and negative response handling is supported. It allows the server
to reflect to the emulator any and all definite, exception, and no response requests sent by the
host application.

● SysReq

Factory default: Unchecked

When this is selected, some (or all, depending on the server) of the functions of the SysReq key
will be emulated and the server in an SNA environment.

● LU Associate Name

Factory default: Unspecified

This enables you to specify the name of the terminal with which a printer is associated so that its
printer device name is assigned to this Telnet session.

● LU1 & LU3 Printing

Factory default: Unchecked

These options apply when the 3287-1 printer is selected and they enable you to specify which
printer type(s) to support.
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National Settings

These options enable you to select the character set to be used. There are separate entries for the
Single Byte Character Set (SBCS) and (if supported) Double Byte Character Set (DBCS). These
should only be changed by the System Administrator. If they have been changed and you wish to
restore the default settings, click the Defaults button at the bottom of the dialog. The table at the end
of this section shows the default settings.

● National Codepage Settings

Factory default: User Defined

This specifies the type of national codepage to be used. Selecting User Defined will enable
manual selection of the Codepage, Character Set and Character Set ID using the following
options.

● SBCS / DBCS Codepage

Factory default: SBCS 37 - DBCS 0

This is a numeric value specifying the codepage to use.

● SBCS / DBCS Character Set

Factory default: SBCS 697 - DBCS 0

This is a numeric value specifying the character set to use.

● SBCS / DBCS Character Set ID
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Factory default: SBCS 37 - DBCS 0

This specifies character set ID.

● Font

Factory default: Courier New

This enables you to specify the font to be used for displaying characters. The available settings
depend on the fonts installed.

Table 15-1  Default Language, Codepage & Character Set Settings

Language Type Codepage Char Set CCSID

English (US) SBCS 37 697 37

English (UK) SBCS 285 697 285

Belgian SBCS 500 697 500

Canadian French SBCS 37 697 37

Danish SBCS 277 697 277

Finnish SBCS 278 697 278

German SBCS 273 697 273

Dutch SBCS 37 697 37

Italian SBCS 280 697 280

Swiss French SBCS 500 697 500

Swiss German SBCS 500 697 500

Swedish SBCS 278 697 278

Norwegian SBCS 277 697 277

French SBCS 297 697 297

Spanish SBCS 284 697 284

Portuguese SBCS 37 697 37

Japanese Kanji + Katakana SBCS 290 1172 290

 DBCS 300 1001 930

Korean SBCS 833 1173 833

 DBCS 834 934 933

Simplified Chinese SBCS 836 1174 836

 DBCS 837 937 937

Traditional Chinese SBCS 37 1175 37

 DBCS 835 935 935

Hebrew New Code SBCS 424 941 424

Hebrew Old Code SBCS 803 941 424
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Table 15-1  Default Language, Codepage & Character Set Settings (continued)

Language Type Codepage Char Set CCSID

Thai SBCS 838 1176 838

Greek SBCS 875 925 875

Cyrillic SBCS 880 960 880

Turkish SBCS 1026 1152 1026

Russian SBCS 1025 1150 1025

Czech SBCS 870 959 870

Slovak SBCS 870 959 870

Polish SBCS 870 959 870

Icelandic SBCS 871 697 871

Arabic SBCS 420 697 285

Table 15-2  IBM EBCDIC Codepages Supplied

Codepage Type Countries

37 SBCS USA, Canada, Netherlands, Portugal, Brazil

273 SBCS Austria, Germany

274 SBCS Belgium (old)

277 SBCS Denmark, Norway

278 SBCS Finland, Sweden

280 SBCS Italy

284 SBCS Spain, Latin America (Spanish)

285 SBCS UK

290 SBCS Japanese - Katakana

297 SBCS France

300 DBCS Japanese - Kanji

420 SBCS Arabic

424 SBCS Hebrew New Code

500 SBCS (Latin 1) Belgium, Canada, Switzerland

803 SBCS Hebrew Old Code

833 SBCS Korean

834 DBCS Korean

835 SBCS Traditional Chinese
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Table 15-2  IBM EBCDIC Codepages Supplied (continued)

Codepage Type Countries

836 SBCS Simplified Chinese

837 DBCS Simplified Chinese

838 SBCS Thai

870 SBCS (Latin 2) Czech, Slovak, Polish

871 SBCS Icelandic

875 SBCS Greek

880 SBCS Cyrillic

905 SBCS (Latin 3) Turkish (old)

1025 SBCS Russian Cyrillic

1026 SBCS (Latin 5) Turkish

1027 SBCS Japanese - Latin extended

1140 SBCS [EURO] USA, Canada, Netherlands, Portugal, Brazil

1141 SBCS [EURO] Austria, Germany

1142 SBCS [EURO] Denmark, Norway

1143 SBCS [EURO] Finland, Sweden

1144 SBCS [EURO] Italy

1145 SBCS [EURO] Spain, Latin America

1146 SBCS [EURO] UK

1147 SBCS [EURO] France

1148 SBCS [EURO] Belgium, Canada, Switzerland

1149 SBCS [EURO] Icelandic
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Print By Pass Settings

● Start Sequence

Factory default: Unspecified

This enables you to enter the character or sequence of characters that initiate a print bypass.

Characters can be entered in several ways. For example, to specify the ASCII escape character,
you can enter either _027, \u001B, \e, \033, or even ^[.

● By Pass End Method

Factory default: Specify Sequence

You can select from the following print bypass methods: Specify Sequence, Count in Header
or End on Non-Hex.

● End Sequence

Factory default: Unspecified

When the print bypass method is set to Specify Sequence, this enables you to specify the end
sequence.

End sequence characters can be entered in several ways. For example, to specify the ASCII
escape character, you can enter either _027, \u001B, \e, \033, or even ^[.

When an end sequence is specified, characters in the data stream between the start and end
are interpreted as encoded ASCII. For example, 1B0A becomes ASCII 27 10 (ESC LF).
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If no end sequence is specified, the bypass is assumed to be for a single pair of characters only.

● Length of End Sequence

Sequence

When the print bypass method is set to End on Non-Hex, this enables you to specify the
number of characters in the end sequence. The bypass will terminate as soon as a non-
hexadecimal character is received (any character except in the range 0 through 9 and A through
F) followed by the end sequence.
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16 IBM 5250 Display Emulation

This chapter describes features of the IBM 5250 display emulation.

Creating a IBM 5250 Display Emulation Session
You can create a session either using the TeemTalk Session Wizard or while TeemTalk is running.

Using the TeemTalk Session Wizard
This section describes how to use the TeemTalk Session Wizard to create an IBM 5250 Display
emulation session.

1. To run the TeemTalk Session Wizard from the Start menu, select All Programs > HP > HP
TeemTalk Terminal Emulator > Session Wizard.

2. In the Session Name field, enter a unique name that will identify this session configuration for
future selection.

3. Select the Transport method then click the Configure button to specify settings.

4. Select the Connection type then click the Configure button to specify settings.

5. Select IBM5250 Display in the Emulation list box then click the Configure button to specify
settings. (The options are described in the section Setup Options on page 169.)

6. Click Next to display the Advanced Options dialog.

7. Click Next to display the Finalization dialog.

8. If you want a shortcut icon for this session to be created on the desktop, click the checkbox
Create icon on desktop for session.

9. Click OK to create the session and exit.

10. To run the session, either double-click on the desktop icon if one was created for the session, or
run TeemTalk, display the File menu and select Open Session. Select the name of the
required .tts session file then click Open.

Using the TeemTalk Emulator Window
This section describes the procedure for creating a IBM 5250 Display emulation session from the
TeemTalk emulator window.

1. Display the Session menu from the menu bar and select Transport... to set the transport
method.

2. Display the Session menu and select Connection... to set the connection method.

3. Display the Session menu and select Emulation.... Set the emulation to IBM5250 Display.
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4. You can configure the transport, connection and emulation settings by selecting the relevant
Configure options in the Session menu. The options displayed by selecting Configure
emulation are described in the section Setup Options on page 169.

5. To save the session, display the File menu and select Save session as. In the File Name field,
enter a unique name that will identify this session configuration for future selection, then click
Save. Note that session files have the filename extension .tts.

6. To run the session, display the File menu and select Open Session. Select the name of the .tts
session file then click Open.

IBM 5250 Emulation Capabilities
The IBM 5250 terminal emulation provides emulation of 5250 type alphanumeric terminals, for
connection to an IBM AS/400, System/ 36 or System/38.

Monochrome (green/white plus attributes) and color is supported. Colors may be modified using the
Attribute Settings dialog.

A typeahead capability is provided so that you can continue to enter data without waiting for a prompt
from the host.

Keyboard Mapping
The functions of the computer keyboard are mapped as closely as possible to the terminal being
emulated. The mapping of key functions can be determined by referring to the Emulation Keys list
box in the Key Macro Settings dialog, which is displayed by selecting Key Macros... on the Tools
menu.

The information in brackets in the right column indicates the default mapping of the key function
named in the left column. In the list, S+ indicates the Shift key, C+ indicates the Control key and A+
indicates the Alt key. For example:

AS_ERASEINPUT (A+VK_PAUSE)

indicates that the Erase Input function is mapped to the key combination Alt + Pause.

Special key functions usually found on an IBM 5250 keyboard can be mapped to any key on your
keyboard using the AS virtual key names listed in the Key Macro Settings dialog.
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The illustrations on the following pages show where IBM 5250 keyboard functions are mapped to
keys on a 101/102 key keyboard.

Figure 16-1  101/102 Key Keyboard Layout for the IBM 5250 Display Emulation

Table 16-1  IBM 5250 Display Keyboard Mapping

Key Key
Modifiers

Result  Key Key
Modifiers

Result

1

none

Shift +

Alt +

RESET

ATTN

QUIT

 

17
none

Shift +

TAB

BACK TAB

2

none

Shift +

F1

F13

 

18

none

Shift +

Alt +

BACKSPACE

REVERSE DISP

BACKSPACE (Non destruct)

3
none

Shift +

F2

F14

 
19

none

Shift +

FIELD EXIT

NEWLINE

4

none

Shift +

F3

F15

 

20

none

Shift +

Alt +

INSERT MODE

DUPLICATE

PA1

5

none

Shift +

Alt +

Ctrl +

F4

F16

RECORD KEYSTROKES

MONO (Monochrome)

 

21

none

Shift +

Alt +

HOME

FIELD MARK

PA2

6

none

Shift +

Alt +

F5

F17

PLAY KEYSTROKES

 

22
none

Alt +

ROLL DOWN

PA3

7
none

Shift +

F6

F18

 
23

 
DELETE
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Table 16-1  IBM 5250 Display Keyboard Mapping (continued)

Key Key
Modifiers

Result  Key Key
Modifiers

Result

8
none

Shift +

F7

F19

 

24

none

Shift +

Alt +

ERASE EOF

END OF LINE

ERASE INPUT

9
none

Shift +

F8

F20

 
25

none

Alt +

ROLL UP

RULE DISPLAY

10

none

Shift +

Ctrl +

F9

F21

CURSOR SELECT

 

26  CURSOR UP

11
none

Shift +

F10

F22

 
27

none

Shift +

CURSOR LEFT

CURSOR FAST LEFT

12
none

Shift +

F11

F23

 
28  CURSOR DOWN

13
none

Shift +

F12

F24

 
29

none

Shift +

CURSOR RIGHT

CURSOR FAST RIGHT

14

none

Shift +

Ctrl +

PRINT

SYSREQ

LOCAL PRINT

 

30
none

Shift +

/

REVERSE/NORMAL
TOGGLE

15 Alt + TEST
 

31
none

Shift +

HELP

REVERSE CLOSE TEXT

16

none

Shift +

Shift + Ctrl +
Alt +

CLEAR

PAUSE

DELAY 1 SECOND

 

32

none

Shift +

Shift + Ctrl +

Shift + Ctrl +
Alt +

FIELD MINUS

LOCAL/GENERAL
KEYBOARD

PUSH MODE ON/OFF

ALTERNATE CODE PAGE

    
33

none

Shift +

ENTER

FIELD PLUS

NOTE: All unmarked keys function as indicated by the legends on the keycaps.

Network Virtual Terminal Mode
Network Virtual Terminal (NVT) mode allows the operator to communicate with a network gateway (in
ASCII) for routing, logon etc, before the full IBM terminal emulation protocol is established. NVT mode
is indicated by the absence of the following symbol on the status line:
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NVT mode displays an unformatted screen for data entry, allowing basic keyboard functionality as a
simple ASCII terminal. In addition to data keys, other recognized keys are:

● Clear

clears the screen

● Enter

sends CR to the host

● Newline

sends CR to the host

● Backspace

sends BS to the host

● Tab

sends HT to the host

Once the appropriate details have been entered to establish an IBM host session (which may be
automatic), the screen is cleared and switched into full IBM 5250 terminal emulation mode, as
indicated by the following symbol on the status line:

The Status Line
The last line of the IBM 5250 screen is used to display status information in the form of symbols and
alphanumeric characters.

Operating Mode & Communication

Indicates that a Telnet session is running.

Indicates that the current screen is an IBM 5250 screen. This screen will be displayed when

you have initiated a Telnet session with the host.

Indicates that the system has one or more messages waiting for you.

Do Not Enter

Indicates when input from the keyboard or mouse will not be accepted by the host. When

this is because an error has occured, as shown in the error line, pressing the Reset key will remove
the error. Alternatively, more information can be obtained by pressing the Help key. The only other
keys available are Attn, SysReq and Print. Note that the emulation includes typeahead capability so
that in most cases you can continue to enter data without waiting for the Do Not Enter message to
clear as the data will be stored until the host is ready.
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Typing Direction

 Indicates the direction in which characters are displayed on the screen when

typed. The direction is toggled between left-to-right (normal) and right-to-left by pressing the keys
Shift + / on the keypad.

Bilingual Keyboard Mode

 Indicates whether the National (N) or Latin (L) character set is active when a code

page that supports a bilingual keyboard is selected. Pressing the keys Shift + - on the keypad will
toggle between the two character sets.

Insert Mode

Indicates that the keyboard is in Insert mode. Already existing characters to the right of the

cursor will move to make room for new characters that are entered. Insert mode can be disabled by
pressing the Insert key again, pressing the Reset key, or by performing any action that sends data to
the host, such as pressing the Enter, Clear, or PF keys.

Display Direction

 Indicates the orientation of the screen display. A right arrow indicates normal left-

to-right display, a left arrow indicates a right-to-left mirror image display. The display can be toggled
between the two directions by pressing the keys Shift + Backspace.

Cursor Position

Indicates the row and column position of the text cursor.

Fax Image Support
● Scrollbars

These are displayed if the image is larger than the screen area allocated to it.

● EasyScroll

IBM term for scrolling by dragging the image with the mouse.

● Zoom

Enables you to highlight an area of the image to magnify it so that it fills the allocated space (the
aspect ratio is preserved).

Additional functions such as rotation and coloring are controlled by the host.
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Word Processing Mode
The following keyboard functions are available when the IBM 5250 emulation is in Word Processing
mode:

Symbols Command Alt + A

Begin Bold Alt + B

Centre Text Alt + C

Next Text Column Alt + D

Half-Index Down Alt + H

Required Tab Alt + I

End Attribute Alt + J

Find Stop Code Alt + N

Start New Page Alt + P

Required Page End Alt + R

Insert Stop Code Alt + S

Begin Underline Alt + U

Word Underline Alt + W

Half-Index Up Alt + Y

Beginning of Line Alt + Cursor Left

End of Line Alt + Cursor Right

Top of Page Alt + Cursor Up

End of Page Alt + Cursor Down

Insert Carrier Return Alt + Field Exit

Required Space Alt + Space

Text Display Options
Display Right-to-Left

The contents of the screen can be displayed in reverse, i.e. as a right-to- left mirror image, by
pressing the keys Shift + Backspace. This is a toggle function, so pressing the keys again will revert
to normal left-to-right display. An arrow will be displayed on the status line (next to the row/column
number) to indicate normal (right arrow) or mirror (left arrow) display.
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Typing Direction
The direction in which characters are displayed on the screen when typed can be toggled between
normal left-to-right and right-to-left by pressing the keys Shift + / on the keypad. The following
symbols will be displayed on the status line to indicate the current typing direction:

Selecting the Symbol Swap option on the Display tab of the 5250 Display Settings dialog will cause
text symbols such as round or angle brackets to be displayed the correct way round when typing
right-to-left.

Close Key
If text has been typed using both typing direction modes in the same line or field, you can force the
right-hand text to join the left-hand text by pressing the keys Shift + * on the keypad.

Push Mode
Push mode allows you to edit text whose direction is opposite the screen orientation. In this mode the
cursor orientation is reversed and a Push segment is created. Push mode is toggled on/off by
pressing the keys Ctrl + Shift + - (keypad minus).

Push mode has two secondary modes, Boundary mode and Edit mode.

Boundary mode is activated when Push mode is entered. The cursor will remain at its current position
while you type additional characters, and text will be pushed in the opposite direction of the screen
orientation.

Edit mode is activated when the cursor is moved from its Boundary position into the Push segment
area. In this mode, text can be edited within the Push segment while typing in the field's natural
direction.

Bilingual Keyboard Support
When a code page that supports a bilingual keyboard is selected, you can toggle between the
National and Latin character set by pressing the keys Shift + - on the keypad. The character N or L
will be displayed on the status line to indicate which character set is currently active.

Selecting the Numeral Swap option on the Display Settings tab of the 5250 Display Settings
dialog will cause all numbers to be displayed using the National character set when in Latin character
set mode.

Alternate Code Page
If a language supports two code pages (e.g. Hebrew New Code and Hebrew Old Code), you can
switch between the two by pressing the keys Ctrl + Shift + Alt + - on the numeric keypad. This
function can be assigned to a different key or key combination by using the AS_ALTCP virtual key
name.
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Record & Playback Keystrokes Facility
The record/playback keystrokes facility enables you to eliminate repetitive operations by using the Fn
keys to store, retrieve and display data. The Fn keys can store a total of 1500 keystrokes. A
sequence of recorded keystrokes may be interrupted so that keystrokes can be entered manually
before continuing with the recording or playback. Note that local Fn key functions cannot be recorded.

The keys used to initiate recording and playback are shown below together with the equivalent virtual
key names that can be used to assign the functions to any key on the keyboard:

 101/102 Key Keyboard Virtual Key Names

Record: Alt + F4 AS_RECORD

Pause: Shift + Pause AS_PAUSE

Quit: Alt + LControl AS_QUIT

Play: Alt + F5 AS_PLAY

NOTE:  Quit is Alt + Left Control if Left Control is defined as the Reset key.

Recording Keystrokes
The following procedure describes how to record keystrokes.

1. Press Record to enter Record mode.

The status line will display RECRD and a number from 0-1500 indicating the number of new
keystrokes that may be stored. A series of boxes displayed to the right represent the Fn keys. A
solid box indicates that the Fn key in that position is currently storing recorded keystrokes.

2. Press the Fn key that will store the keystrokes. (On 101/102 keyboards you can also use Shift +
Fn.)

The status line will display R**** F* where R indicates you are in Record mode, **** is the
number of keystrokes that may be stored, and F* is the number of the Fn key pressed.

NOTE: If you press a pre-recorded Fn key, its contents will be replaced with the following
keystrokes. You can also remove the contents of the Fn key before recording by pressing the
Delete key.
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3. Enter the keystrokes to be recorded.

You may pause recording at any time to allow keystrokes to be entered manually when played
back by pressing Pause. Pause mode is indicated by the following symbols on the status line.
To continue recording, press Pause again.

NOTE: You can cancel the newly recorded keystrokes by pressing the Quit key. This
cancellation does not affect the previously recorded keystrokes.

4. To finish and save the recording, press the Record key.

Playback Keystrokes
1. Position the text cursor where the playback is to start.

2. Press the Play key to enter Play mode.

The status line will display PLAY and a series of boxes representing the Fn keys. A solid box
indicates that the Fn key in that position is currently storing recorded keystrokes.

3. Press the Fn key storing the recorded data to play back.

Playback will begin immediately, as indicated by a P on the status line. All the recorded
keystrokes will be played back automatically. When playback is completed the P will disappear.

If the recorded keystrokes included Pause, then playback will halt at that point to allow you to
enter keystrokes manually. Press Play to resume playback from where you stopped typing.

If you want to cancel during the playback operation, press the Quit key.

Error Codes
The following error codes may appear on the status line if an error occurs during recording or
playback.

9001 Exceeded the maximum number of allowed keystrokes.

Remedy: Press the Record key to exit Record mode. To record a new keystroke sequence, either:

● Press the Record key and the target Fn key that has erasable data, then enter the new data,
or:

● Press the Record key and the target Fn key that has erasable data, then press the Delete
key to erase the recorded data for that key.

9003 You pressed an invalid Fn key while performing the Record or Play function.

9007 You pressed an invalid sequence key (e.g. Play) while performing the Record function.

Remedy: Press the Reset key.
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9010 While performing the Play function, you pressed an Fn key that does not have a keystroke
assigned to it.

Remedy: Press the Reset key.

9015 In communication mode, you pressed either the Quit or Pause key.

Remedy: Press the Reset key.

9019 In Record or Play mode. While the Record/play pause indicator was displayed on the status line
you pressed an invalid key (e.g. Play key in Record mode, or Record key in Play mode). Remedy:

Remedy: Press the Reset key.

Setup Options
The IBM 5250 Display emulation is configured using setup options in the 5250 Display Settings
dialog which can be displayed using one of the following three methods:

Using the Session Wizard:

◦ In Step 1 set Emulation to IBM 5250 Display then click the Configure button.

Using the TeemTalk Window:

◦ On the Session menu, select Emulation > IBM 5250 Display then select Configure
Emulation....

◦ On the configuration bar, select IBM 5250 Display in the Emulation list box then click
Configure Emulation.

The setup options are grouped on four tabs labelled Model, National, Display and Environment
Variables.
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Model Settings

● Model

Factory default: 3477-FC (27x132 Colour Msg)

This specifies what is reported back to the host in response to a terminal identification request.
Note that not all features of the specified terminal may be supported.

The terminal models and their display characteristics are as follows:

5291_1 Monochrome 24 x 80

5292_2 Color 24 x 80

5251_11 Monochrome 24 x 80

3179_2 Color 24 x 80 (default)

3196_A1 Monochrome 24 x 80

3180_2 Monochrome 24 x 80 and 27 x 132

3477_FC Color 24 x 80 and 27 x 132

3477_FG Monochrome 24 x 80 and 27 x 132

3486_BA Monochrome 24 x 80

3487_HA Monochrome 24 x 80

3487_HC Color 24 x 80

5555_B01 Monochrome 24 x 80

5555_C01 Color 24 x 80
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If double byte character sets (e.g. Japanese) are supported and you wish to use them, then
select either 5555_B01 (monochrome) or 5555_C01 (color).

● Enhanced UI

Factory default: Unchecked

Selecting this option will enable support of the IBM 5250 Extended User Interface for generating
windows on the screen. Note that menus and scroll bars are not supported.

● GUI Input Error Messages

Factory default: Unchecked

The setting of this option determines whether error messages sent from the host are displayed
on line 24 or in a pop-up error message box. Select this option to enable host error messages to
be displayed in a pop-up message box when line 24 is not visible on the display.

● Field Minus Justification

Factory default: Unchecked

The setting of this option determines whether pressing the Field Minus key affects the last digit
(unchecked) or the space following the last digit (selected).

● Keyboard Unlock Delay

Factory default: 0

When the keyboard is unlocked by the host, this specifies a delay in milliseconds before
characters are sent.

National Settings
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These options enable you to select the character set to be used. There are separate entries for the
Single Byte Character Set (SBCS) and (if supported) Double Byte Character Set (DBCS). These
should only be changed by the System Administrator. If they have been changed and you wish to
restore the default settings, click the Defaults button at the bottom of the dialog. The table at the end
of this section shows the default settings.

● National Codepage Settings

Factory default: User Defined

This specifies the type of national codepage to be used. Selecting User Defined will enable
manual selection of the Codepage and Character Set using the following options.

● SBCS Codepage

Factory default: 37

This is a numeric value specifying the single-byte character set codepage to use.

● SBCS Character Set

Factory default: 697

This is a numeric value specifying the single-byte character set to use.

● DBCS Codepage

Factory default: 0

This is a numeric value specifying the double-byte character set codepage to use.

● Font

Factory default: Courier New

This enables you to specify the font to be used for displaying characters. The available settings
depend on the fonts installed.

Table 16-2  Default Language, Character Set & Codepage Settings

Language KBDTYPE CHARSET SBCS CODEPAGE DBCS CODEPAGE

English (US) USB 697 37

English (UK) UKB 697 285

Belgian BLI 697 500

Canadian French CAI 697 500

Danish DMB 697 277

Finnish FNB 697 278

German AGB 697 273

Dutch NEB 697 37

Italian ITB 697 280

Swiss French SFI 697 500

Swiss German SGI 697 500
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Table 16-2  Default Language, Character Set & Codepage Settings (continued)

Language KBDTYPE CHARSET SBCS CODEPAGE DBCS CODEPAGE

Swedish SWB 697 278

Norwegian NWB 697 277

French FAB 697 297

Spanish SPB 697 284

Portuguese PRB 697 37

Japanese Kanji +
Katakana

JKB 1172 290 300

Korean KOB 1173 833 834

Simplified Chinese RCB 1174 836 837

Traditional Chinese TAB 1175 37 835

Hebrew New Code NCB 941 424

Hebrew Old Code  941 803

Thai THB 1176 838

Greek GNB 925 875

Cyrillic CYB 960 880

Turkish TRB 1152 1026

Russian RUB 1150 1025

Czech CSB 959 870

Slovak SKB 959 870

Polish POB 959 870

Icelandic ICB 697 871

Arabic  697 420

Table 16-3  IBM EBCDIC Codepages Supplied

Codepage Type Countries

37 SBCS USA, Canada, Netherlands, Portugal,
Brazil

273 SBCS Austria, Germany

274 SBCS Belgium (old)

277 SBCS Denmark, Norway

278 SBCS Finland, Sweden

280 SBCS Italy
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Table 16-3  IBM EBCDIC Codepages Supplied (continued)

Codepage Type Countries

284 SBCS Spain, Latin America (Spanish)

285 SBCS UK

290 SBCS Japanese - Katakana

297 SBCS France

300 DBCS Japanese - Kanji

420 SBCS Arabic

424 SBCS hebrew New Code

500 SBCS (Latin 1) Belgium, Canada, Switzerland

803 SBCS hebrew Old Code

833 SBCS Korean

834 DBCS Korean

835 DBCS Tradational Chinese

836 SBCS Simplified Chinese

837 DBCS Simplified Chinese

838 SBCS Thai

870 SBCS (Latin 2) Czech, Slovak, Polish

871 SBCS Icelandic

875 SBCS Greek

880 SBCS Cyrillic

905 SBCS (Latin 3) Turkish (old)

1025 SBCS Russian Cyrillic

1026 SBCS (Latin 5) Turkish

1027 SBCS Japanese - Latin extended

1140 SBCS [EURO] USA, Canada, Netherlands,
Portugal, Brazil

1141 SBCS [EURO] Austria, Germany

1142 SBCS [EURO] Denmark, Norway

1143 SBCS [EURO] Finland, Sweden

1144 SBCS [EURO] Italy

1145 SBCS [EURO] Spain, Latin America

1146 SBCS [EURO] UK

1147 SBCS [EURO] France
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Table 16-3  IBM EBCDIC Codepages Supplied (continued)

Codepage Type Countries

1148 SBCS [EURO] Belgium, Canada, Switzerland

1149 SBCS [EURO] Icelandic

Display Settings

● Monochrome

Factory default: Depends on the terminal type

By default the setting of this option will match the normal display characteristic of the particular
IBM 5250 model selected. In TeemTalk, all terminal types support both monochrome and color
display.

When monochrome is selected, characters will be displayed in green and intense fields will be
displayed in white. When monochrome is not selected, the settings specified in the Attributes
dialog will be used for the display. Refer to the chapter Display Attributes on page 48 for details.

● Show Rule Line

Factory default: Unchecked5

This determines whether a rule line is displayed across the emulation workspace at the cursor
position. The setting of the Rule Line Style option determines whether it is displayed as a
horizontal rule, vertical rule or a cross.

NOTE: You can also toggle display of the rule line on and off by pressing the keys Alt + Page
Down.
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● Rule Line Style

Factory default: Cross

The setting of this option determines whether the rule line is displayed as a horizontal rule,
vertical rule or a cross.

● Rule Line Follows Cursor

Factory default: Unchecked

When the rule is displayed in the emulation workspace, the setting of this option determines
whether or not the rule follows the cursor when it moves.

● Ignore Host Cursor Style

Factory default: Unchecked

Selecting this option will cause TeemTalk to ignore any commands from the host to change the
cursor style.

● Hide WP Control Characters

Factory default: Unchecked

This enables you to toggle the display of word processing characters on and off.

● Numeral Swap

Factory default: Unchecked

When using a code page that supports a bilingual keyboard, this will cause all numbers to be
displayed using the National character set when in Latin mode.

● Symbol Swap

Factory default: Unchecked

Selecting this option will cause symbols such as brackets to be displayed the correct way round
when typing in right-to-left mode.
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Environment Variables

● USER

Specifies the user or account name to use to log on to the remote system.t

● JOB

Specifies the job ID to use when logging into the remote system.

● ACCT

Specifies the account ID to use when logging into the remote system.

● PRINTER

Specifies the default location for printer output.\

● SYSTEMTYPE

Specifies the type of operating system used by the system sending this variable.

● DISPLAY

Specifies the X display location of the client.

● DEVNAME

This enables you to enter the name of the device which the server will be requested to assign to
this Telnet session.

You can return the local host name by entering %s after the device name. To return the user
name, enter %u after the device name. You can specify how many characters of the name is
returned in each case. For example, %.3s will return the first three characters of the local host
name, and %-.3s will return the last three characters.
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To automatically assign a new device name for each successive connection, either enter %dN%
after the name, where N is a decimal value, or %xN%, where N is a hexadecimal value. Each
time the host requests the device name a counter will be incremented modulus N and
substituted into the device name.o

For example, TEST%d4% will give TEST1 on first connect, TEST2 on second, TEST3 on third,
TEST0 on fourth, TEST1 on fifth and so on.

TEST%d100% will give TEST1 on first connect, TEST2 on second, ... TEST99 on 99th, TEST0
on 100th, TEST1 on 101st and so on.

These values are preserved over power off, so the first connection of any given power on may
not be TEST1. Assume that the start point is random. In addition there is a single counter for the
unit so concurrent sessions will start from subsequent values. For example, if session one uses
TEST1 then session two will use TEST2.

Where a device name collision occurs (i.e. the device name is already in use on the host) the
host will ask again for the device name during the same connection. In this case TEST1,
TEST2, ... may all be tried in one connection until the host accepts one, or all possibilities have
been tried. In the latter case the same name is sent twice in succession to indicate to the host all
names have been tried.

If concurrent 5250 sessions are started before a previous session has negotiated an acceptable
device name, it is possible that the two sessions will access the counter simultaneously and not
all possible names will be tried by each session. This should not cause a problem unless the
separate sessions use different modulo values (for example, session one device name TEST
%d4% and session two device name ANOTHER%d100%) or are connecting to different hosts.

● IBMSUBSPW

This enables you to specify the initial Password entry required on the standard startup screen so
that it can be bypassed. The entry can be a maximum of ten characters.

● IBMCURLIB

This enables you to specify the initial Library entry required on the standard startup screen so
that it can be bypassed. The entry can be a maximum of ten characters.

● IBMMENU

This enables you to specify the initial Menu entry required on the standard startup screen so that
it can be bypassed. The entry can be a maximum of ten characters.

● IBMPROGRAM

This enables you to specify the name of the initial program to run. The entry can be a maximum
of ten characters.

● KBDTYPE

This specifies the type of keyboard being used.

● Advanced Settings

Factory default: Unchecked

Displays a Refresh button and Value for Do Not Report option when checked.

● Value for Do Not Report
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Factory default: [!

This specifies the character string used to indicate that the Environment Variable is not to be
reported.
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17 IBM 5250 Printer Emulation

This chapter describes features of the IBM 5250 printer emulation.

Creating a IBM 5250 Printer Emulation Session
You can create a session either using the TeemTalk Session Wizard or while TeemTalk is running.

Using the TeemTalk Session Wizard
This section describes how to use the TeemTalk Session Wizard to create an IBM 5250 Printer
emulation session.

1. To run the TeemTalk Session Wizard from the Start menu, select All Programs > HP > HP
TeemTalk Terminal Emulator > Session Wizard.

2. In the Session Name field, enter a unique name that will identify this session configuration for
future selection.

3. Select the Transport method then click the Configure button to specify settings.

4. Select the Connection type then click the Configure button to specify settings.

5. Select IBM5250 Printer in the Emulation list box then click the Configure button to specify
settings. (The options are described in the section Setup Options on page 181.)

6. Click Next to display the Advanced Options dialog.

7. Click Next to display the Finalization dialog.

8. If you want a shortcut icon for this session to be created on the desktop, click the checkbox
Create icon on desktop for session.

9. Click OK to create the session and exit.

10. To run the session, either double-click on the desktop icon if one was created for the session, or
run TeemTalk, display the File menu and select Open Session. Select the name of the
required .tts session file then click Open.

Using the TeemTalk Emulator Window
This section describes the procedure for creating a IBM 5250 Printer emulation session from the
TeemTalk emulator window.

1. Display the Session menu from the menu bar and select Transport... to set the transport
method.

2. Display the Session menu and select Connection... to set the connection method.

3. Display the Session menu and select Emulation.... Set the emulation to IBM5250 Printer.
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4. You can configure the transport, connection and emulation settings by selecting the relevant
Configure options in the Session menu. The options displayed by selecting Configure
emulation are described in the section Setup Options on page 181.

5. To save the session, display the File menu and select Save session as. In the File Name field,
enter a unique name that will identify this session configuration for future selection, then click
Save. Note that session files have the filename extension .tts.

6. To run the session, display the File menu and select Open Session. Select the name of the .tts
session file then click Open.

Setup Options
The IBM 5250 Printer emulation is configured using setup options in the 5250 Printer Settings dialog
which can be displayed using one of the following three methods:

Using the Session Wizard:

◦ In Step 1 set Emulation to IBM 5250 Printer then click the Configure button.

Using the TeemTalk Window:

◦ On the Session menu, select Emulation > IBM 5250 Printer then select Configure
Emulation....

◦ On the configuration bar, select IBM 5250 Printer in the Emulation list box then click
Configure Emulation.

The setup options are grouped on three tabs labelled Model, National and Print By Pass.
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Model Settings

● Model

Factory default: 3812-1 (Printer)

This enables you to specify the printer model to emulate. There are two options:

◦ 3812-14

Single-byte printer.

◦ 5553-B01

Double-byte printer.

Select the double-byte printer when using double-byte character sets such as Japanese.
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National Settings

These options enable you to select the character set to be used. There are separate entries for the
Single Byte Character Set (SBCS) and (if supported) Double Byte Character Set (DBCS). These
should only be changed by the System Administrator. If they have been changed and you wish to
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restore the default settings, click the Defaults button at the bottom of the dialog. The table at the end
of this section shows the default settings.

● National Codepage Settings

Factory default: User Defined

This specifies the type of national codepage to be used. Selecting User Defined will enable
manual selection of the Codepage and Character Set using the following options.

● SBCS Codepage

Factory default: 37

This is a numeric value specifying the single-byte character set codepage to use.

● SBCS Character Set

Factory default: 697

This is a numeric value specifying the single-byte character set to use.

● DBCS Codepage

Factory default: 0

This is a numeric value specifying the double-byte character set codepage to use.

● Font

Factory default: Courier New

This enables you to specify the font to be used for displaying characters. The available settings
depend on the fonts installed.

Table 17-1  Default Language, Character Set & Codepage Settings

Language KBDTYPE CHARSET SBCS CODEPAGE DBCS CODEPAGE

English (US) USB 697 37  

English (UK) UKB 697 285  

Belgian BLI 697 500  

Canadian French CAI 697 500  

Danish DMB 697 277  

Finnish FNB 697 278  

German AGB 697 273  

Dutch NEB 697 37  

Italian ITB 697 280  

Swiss French SFI 697 500  

Swiss German SGI 697 500  

Swedish SWB 697 278  

Norwegian NWB 697 277  
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Table 17-1  Default Language, Character Set & Codepage Settings (continued)

Language KBDTYPE CHARSET SBCS CODEPAGE DBCS CODEPAGE

French FAB 697 297  

Spanish SPB 697 284  

Portuguese PRB 697 37  

Japanese Kanji +
Katakana

JKB 1172 290 300

Korean KOB 1173 833 834

Simplified Chinese RCB 1174 836 837

Traditional Chinese TAB 1175 37 835

Hebrew New Code NCB 941 424  

Hebrew Old Code  941 803  

Thai THB 1176 838  

Greek GNB 925 875  

Cyrillic CYB 960 880  

Turkish TRB 1152 1026  

Russian RUB 1150 1025  

Czech CSB 959 870  

Slovak SKB 959 870  

Polish POB 959 870  

Icelandic ICB 697 871  

Arabic  697 420  

Table 17-2  IBM EBCDIC Codepages Supplied

Codepage Type Countries

37 SBCS USA, Canada, Netherlands, Portugal,
Brazil

273 SBCS Austria, Germany

274 SBCS Belgium (old)

277 SBCS Denmark, Norway

278 SBCS Finland, Sweden

280 SBCS Italy

284 SBCS Spain, Latin America (Spanish)

285 SBCS UK
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Table 17-2  IBM EBCDIC Codepages Supplied (continued)

Codepage Type Countries

290 SBCS Japanese - Katakana

297 SBCS France

300 DBCS Japanese - Kanji

420 SBCS Arabic

424 SBCS hebrew New Code

500 SBCS (Latin 1) Belgium, Canada, Switzerland

803 SBCS hebrew Old Code

833 SBCS Korean

834 DBCS Korean

835 DBCS Tradational Chinese

836 SBCS Simplified Chinese

837 DBCS Simplified Chinese

838 SBCS Thai

870 SBCS (Latin 2) Czech, Slovak, Polish

871 SBCS Icelandic

875 SBCS Greek

880 SBCS Cyrillic

905 SBCS (Latin 3) Turkish (old)

1025 SBCS Russian Cyrillic

1026 SBCS (Latin 5) Turkish

1027 SBCS Japanese - Latin extended

1140 SBCS [EURO] USA, Canada, Netherlands,
Portugal, Brazil

1141 SBCS [EURO] Austria, Germany

1142 SBCS [EURO] Denmark, Norway

1143 SBCS [EURO] Finland, Sweden

1144 SBCS [EURO] Italy

1145 SBCS [EURO] Spain, Latin America

1146 SBCS [EURO] UK

1147 SBCS [EURO] France

1148 SBCS [EURO] Belgium, Canada, Switzerland

1149 SBCS [EURO] Icelandic
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Environment Variables

The options on this tab specify Environment Variables and values passed as part of the Telnet 5250E
protocol.

Note the following rules for entering values:

● A value of "," deletes the variable.

● A value of CURRENTVALUE,NAME=VALUE adds a new variable NAME with value VALUE.

● Use ",," to enter a ",".

● Use "==" to enter a "=".

● Values started [! are not reported (this is the default do not report string which can be changed).
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The following is a list of the Environment Variables and explanations of their values:

● USER

Specifies the user or account name to use to log on to the remote system.

● JOB

Specifies the job ID to use when logging into the remote system.

● ACCT

Specifies the account ID to use when logging into the remote system.

● PRINTER

Specifies the default location for printer output.

● SYSTEMTYPE

Specifies the type of operating system used by the system sending this variable.

● DISPLAY

Specifies the X display location of the client.

● DEVNAME

Specifies the name of the printer device.

● IBMIGCFEAT

This is always set to Don't Report.

● IBMMSGQNAME

Specifies the name of the message queue to which operational messages for the printer are to
be sent.

● IBMMSGQLIB

Specifies the message queue library.

● IBMFONT

Factory default: 10

Specifies the font identifier and point size used by the single-byte printer.

● IBMFORMFEED

Factory default: [! Don't Report]

This is always set to Don't Report. The IBMPPRSRC1 option is used to specify the paper
format to be used.

● IBMTRANSFORM

Factory default: Yes (1)

Specifies whether the printer will use the host print transform function to generate ASCII printer
data. This is always set to Yes. The IBMMFRTYPMDL option must specify the printer
manufacturer, type and model.
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● IBMMFRTYPMDL

Factory default: *None

Specifies the printer manufacturer, type and model. The entry must exactly match an AS400
printer type string, including the * (asterisk) character. The following valid entries are for the IBM
AS/400 V3R1. Note that the list can change depending on AS/400 settings.

Table 17-3  IBM 5250 Printer Manufacturer, Type and Model Values

*IBM2380 *IBM2381 *IBM2390 *IBM2391 *IBM3812

*IBM3816 *IBM3912HP *IBM3916HP *IBM39302 *IBM39303

*IBM4019 *IBM4019HP *IBM4029 *IBM4029HP *IBM4037

*IBM4039HP *IBM4070 *IBM4070EP *IBM4072 *IBM4076

*IBM42011 *IBM42012 *IBM42013 *IBM42021 *IBM42022

*IBM42023 *IBM42071 *IBM42072 *IBM42081 *IBM42082

*IBM4212 *IBM4216 *IBM4226 *IBM4230 *IBM4232

*IBM47121 *IBM47122 *IBM47221 *IBM47222 *IBM4770

*IBM5152 *IBM5201 *IBM5202 *IBM5204 *IBM5216

*IBM6404 *IBM6404EP *IBM6408 *IBM6408EP *IBM6412

*IBM6412EP *HPII *HPIID *HPIIP *HPIII

*HPIIID *HPIIIP *HPIIISI *HP4 *HP310

*HP500 *HP520 *HP550C *HP560C *HPPAINT

*CPQPM15 *CPQPM20 *EPAP2250 *EPAP3250 *EPAP5000

*EPAP5500 *EPDFX5000 *EPDFX8000 *EPFX850 *EPFX870

*EPFX1170 *EPLX810 *EPLQ510 *EPLQ570 *EPLQ860

*EPLQ870 *EPLQ1070 *EPLQ1170 *EPLQ2550 *EPSQ870

*EPSQ1170 *EPEPL7000 *EPEPL8000 *NECP2 *NECP2200

*NECP2200XE *NECP5200 *NECP5300 *NECP6200 *NECP6300

*OKI184IBM *OKI320IBM *OKI321IBM *OKI390IBM *OKI391IBM

*OKI393IBM *OKI590IBM *OKI591IBM *OKI400 *OKI800

*OKI810 *OKI820 *OKI3410 *PAN1123EP *PAN1124EP

*PAN1124IEP *PAN1180EP *PAN1180IEP *PAN1191EP *PAN1624EP

*PAN1654EP *PAN1695EP *PAN2123EP *PAN2124EP *PAN2180EP

*PAN2624EP *PAN4410HP *PAN4420HP *PAN4430HP *PAN4450IHP

*PAN4451HP

● IBMPPRSRC1 / IBMPPRSRC2

Factory default: [! Don't Report]
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These options specify the paper format to be used. The possible settings are:

Table 17-4  IBM 5250 Printer Paper Format

Don't Report No value returned.

*NONE No paper source is defined

*MFR The system determines the paper type used based on the manufacturer, type and model of the
printer

*LET Letter-sized paper (8.5 x 11 inches)

*LEGL Legal-sized paper (8.5 x 14 inches)

*EXE Executive-sized paper (7.25 x 10.5 inches)

*A4 A4-sized paper (210 mm x 297 mm)

*A5 A5-sized paper (148 mm x 210 mm)

*B5 B5-sized paper (182 mm x 257 mm)

*C80 Continuous-form paper, 8.0 inches wide (IBMPPRSRC1 only)

*C132 Continuous-form paper, 13.2 inches wide (IBMPPRSRC1 only)

*A3 A3-sized paper (297 mm x 420 mm)

*B4 B4-sized paper (257 mm x 364 mm)

*LEDG Ledger-sized paper (11 inches x 17 inches)

● IBMENVELOPE

Factory default: [! Dont' Report ]

This specifies the envelope format to be used. The possible settings are:

Table 17-5  IBM 5250 Printer Envelope Format Values

Don't Report No value returned

*NONE No envelope source is defined

*MFR The system determines the envelope type used based on the manufacturer, type and model of
the printer

*B5 B5-sized envelopes (176mm x 250mm)

*MON Monarch-sized envelopes (3.875 X 7.5 inches)

*N9 Number 9-sized envelopes (3.875 x 8.875 inches)

*N10 Number 10-sized envelopes (4.125 x 9.5 inches)

*C5 C5-sized envelopes (162mm x 229mm)

*DL DL-sized envelopes (110mm x 220mm)

● IBMASCII899

Factory default: [! Don't Report]
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Specifies whether the single-byte printer has ASCII code page 899 installed. Selecting Don't
Report will cause no value to be returned.

● IBMWSCSTNMAME

Specifies the name of the object containing pointers to the work station customizing tables.

● IBMWSCSTLIB

Specifies the library name of the object containing pointers to the work station customizing
tables.

● Advanced Settings

Factory default: Unchecked

Displays a Refresh button and Value for Do Not Report option when checked.

● Value for Do Not Report

Factory default: [!

This specifies the character string used to indicate that the Environment Variable is not to be
reported.
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18 TA6530 Emulation

This chapter describes features of the Tandem 6530 terminal emulation.

Creating a TA6530 Emulation Session
You can create a session either using the TeemTalk Session Wizard or while TeemTalk is running.

Using the TeemTalk Session Wizard
This section describes how to use the TeemTalk Session Wizard to create an TA6530 emulation
session.

1. To run the TeemTalk Session Wizard from the Start menu, select All Programs > HP > HP
TeemTalk Terminal Emulator > Session Wizard.

2. In the Session Name field, enter a unique name that will identify this session configuration for
future selection.

3. Select the Transport method then click the Configure button to specify settings.

4. Select the Connection type then click the Configure button to specify settings.

5. Select TA6530 in the Emulation list box then click the Configure button to specify settings.
(The options are described in the section Setup Options on page 197.)

6. Click Next to display the Advanced Options dialog.

7. Click Next to display the Finalization dialog.

8. If you want a shortcut icon for this session to be created on the desktop, click the checkbox
Create icon on desktop for session.

9. Click OK to create the session and exit.

10. To run the session, either double-click on the desktop icon if one was created for the session, or
run TeemTalk, display the File menu and select Open Session. Select the name of the
required .tts session file then click Open.

Using the TeemTalk Emulator Window
This section describes the procedure for creating a TA6530 emulation session from the TeemTalk
emulator window.

1. Display the Session menu from the menu bar and select Transport... to set the transport
method.

2. Display the Session menu and select Connection... to set the connection method.

3. Display the Session menu and select Emulation.... Set the emulation to TA6530.
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4. You can configure the transport, connection and emulation settings by selecting the relevant
Configure options in the Session menu. The options displayed by selecting Configure
emulation are described in the section Setup Options on page 197.

5. To save the session, display the File menu and select Save session as. In the File Name field,
enter a unique name that will identify this session configuration for future selection, then click
Save. Note that session files have the filename extension .tts.

6. To run the session, display the File menu and select Open Session. Select the name of the .tts
session file then click Open.

Operating Modes
The Tandem 6530 emulation operates in one of three main modes: Conversational, Block, or ANSI.
Conversational and Block modes are normally used for applications running on a NonStop host
system. ANSI mode is for applications running on the LXN host system.

Conversational mode
In Conversational mode, characters are sent to the host as you type them. This is useful when
applications need to interact with you on a character, word or line-by-line basis.

Display memory is treated as one long page consisting of 400 lines, of which 24 lines may be viewed
at any one time. Lines above or below those currently displayed may be scrolled into view using
cursor or display control keys. Once all the display memory has been used, new data will force all
previous lines of data up one line so that the first line is erased, ensuring that the oldest data is
erased first.

The status line will display CONV when you are in Conversational mode.

Block Mode
In Block mode, characters are stored in a communications buffer and are not transmitted to the host
until the application requests them. The characters are then sent as a block. This enables you to
enter a large amount of data and edit it locally before it is transmitted.

Block mode has two sub-modes: Block Nonprotect and Block Protect. In Block Nonprotect mode you
can enter any type of character at any position on the screen (except on the 25th line). In Block
Protect mode the application divides the screen into protected and nonprotected areas called fields.
The cursor cannot be moved into protected fields, which may contain prompts or information or be
empty. The cursor can only be moved into unprotected fields, which may also define the type of
characters that can be entered.

In Block mode, display memory is divided into pages, the number of pages being determined by the
application.

The status line will display BLOCK when you are in Block mode, and PROT when in Block Protect
mode.

ANSI Mode
In ANSI mode, characters are sent to the host as you type them, and standard ANSI (American
National Standard Institute) functions are executed. Applications that run on the LXN host system
generally recognize and use these functions.
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The status line will display ANSI when you are in ANSI mode.

The Rule Cursor
A cross-hair rule cursor can be displayed by pressing the keys Alt + Page Up. To return to the
normal cursor, press Alt + Page Down.

Keyboard Mapping
The functions of the computer keyboard are mapped as closely as possible to the terminal being
emulated. The mapping of key functions can be determined by referring to the Emulation Keys list
box in the Key Macro Settings dialog, which is displayed by selecting Key Macros... on the Tools
menu.

The information in brackets in the right column indicates the default mapping of the key function
named in the left column. In the list, S+ indicates the Shift key, C+ indicates the Control key and A+
indicates the Alt key. For example:

TA_LINEINS (C+VK_INSERT)

indicates that the Insert Line function is mapped to the key combination Control + Insert.

Special key functions usually found on a TA6530 keyboard can be mapped to any key on your
keyboard using the TA virtual key names listed in the Key Macro Settings dialog.

The illustrations on the following pages show where TA6530 keyboard functions are mapped to keys
on a 101/102 key keyboard.

Figure 18-1  101/102 Key Keyboard Layout for the TA6530 Emulation

Table 18-1  TA6530 Keyboard Mapping

Key Key Modifier Result  Key Key Modifier Result

1
none

Shift +

ESCAPE

DELETE

 
15

Ctrl +

Shift + Ctrl +

ERASE LINE

ERASE PAGE
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Table 18-1  TA6530 Keyboard Mapping (continued)

Key Key Modifier Result  Key Key Modifier Result

2

none

Shift +

Alt +

Shift + Alt +

F1

F1 (Shifted)

F13

F13 (Shifted)

 

16
none

Shift +

BREAK

BREAK (Shifted)

3

none

Shift +

Alt +

Shift + Alt +

F2

F2 (Shifted)

F14

F14 (Shifted)

 

17
none

Shift +

TAB

BACKTAB

4

none

Shift +

Alt +

Shift + Alt +

F3

F3 (Shifted)

F15

F15 (Shifted)

 

18

none

Shift +

Ctrl +

CHARACTER
INSERT

INSERT

LINE INSERT

5

none

Shift +

Alt +

Shift + Alt +

F4

F4 (Shifted)

F16

F16 (Shifted)

 

19
none

Ctrl +

HOME

HOME + CONTROL

6
none

Shift +

F5

F5 (Shifted)

 
20

none

Shift +

PAGE UP

PAGE UP (Shifted)

7

none

Shift +

F6

F6 (Shifted)

 

21
none

Ctrl +

CHARACTER
DELETE

LINE DELETE

8
none

Shift +

F7

F7 (Shifted)

 
22  END

9
none

Shift +

F8

F8 (Shifted)

 

23

none

Shift +

PAGE DOWN

PAGE DOWN
(Shifted)

10
none

Shift +

F9

F9 (Shifted)

 

24

none

Alt +

Shift + Alt +

CURSOR UP

ROLL UP

ROLL UP (Shifted)

11
none

Shift +

F10

F10 (Shifted)

 
25  CURSOR LEFT
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Table 18-1  TA6530 Keyboard Mapping (continued)

Key Key Modifier Result  Key Key Modifier Result

12
none

Shift +

F11

F11 (Shifted)

 

26

none

Alt +

Shift + Alt +

CURSOR DOWN

ROLL DOWN

ROLL DOWN
(Shifted)

13
none

Shift +

F12

F12 (Shifted)

 
27  CURSOR RIGHT

14
none

Shift +

PRINT SCREEN

PRINT SCREEN
(Shifted)

 

28

none

Alt +

Shift + Alt +

Ctrl + Alt +

-

TAB SET

TAB CLEAR

TAB CLEAR ALL

    
29

none

Alt +

+

,

NOTE: All unmarked keys function as indicated by the legends on the keycaps.

The Status Line
The last (25th) line on the TA6530 emulation screen is used to display messages and status
information. You can enable or disable display of a border that separates this line from the lines
above it. This is achieved using the Status border option in the TA6530 Settings dialog.

The status line is divided into two fields. The first and leftmost field is used to display messages of up
to 64 characters in length. The second field displays the current operating status and will usually
display at least one of the following status indicators:

● ANSI

The emulation is operating in ANSI mode.

● BLOCK

The emulation is operating in Block mode.

● CNTRL

Display controls mode activated. In this mode, received control codes will be displayed but not
actioned.

● CONV

The emulation is operating in Conversational mode.

● HOLD

Hold screen is activated. The emulation stops processing incoming data when the Ctrl + S keys
are presse in ANSI mode. To release the hold state and continue normal processing, press Ctrl
+ Q.
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● INS

Insert mode is activated. In Block mode, keyboard entered characters are inserted at the cursor
position without overwriting already existing characters.

● LOCKED

The keyboard has been temporarily locked by the application.

● NUM

Num lock is activated. Num lock is toggled on and off by pressing the keys Alt + Num Lock.

● PROT

Block Protect mode enabled. Refer to Block Mode on page 193 for details.

When the emulation detects an error, the status line will be temporarily replaced by an error line
which will display one of the following messages:

● INVALID LANGUAGE SET REQUESTED

You tried to use an invalid national character set.

● INVALID DATA

You tried to enter an invalid character in the current field when in Block protect mode.

Setup Options
The TA6530 emulation is configured using setup options in the Tandem Settings dialog which can
be displayed using one of the following three methods:

Using the Session Wizard:

◦ In Step 1 set Emulation to TA6530 then click the Configure button.

Using the TeemTalk Window:

◦ On the Session menu, select Emulation > TA6530 then select Configure Emulation....

◦ On the configuration bar, select TA6530 in the Emulation list box then click Configure
Emulation.

The setup options are grouped on three tabs labelled General, Display and Preferences.
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General Settings

● Power-up mode

Factory default: Conversational

This option determines the operating mode that is in effect when the TA6530 emulation is
started.

NOTE: Changing the current setting will not take effect until you restart TeemTalk, so you will
need to save the new setting before exiting TeemTalk.

Conversational and Block modes are normally used for applications running on a NonStop host
system, and ANSI mode for applications running on an LXN host system. Save the new setting
before exiting the emulation by selecting Save session in the File menu.

● Font

Factory default: Courier New

This enables you to specify the font to use for displaying characters. The available settings
depend on the fonts installed on your system.

● Character set

Factory default: Iso Latin-1

This specifies the character set used for displaying characters.

● Multinational mode
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Factory default: Unchecked

This option will only be available if the system is configured for a language that supports national
replacement character sets. It determines the type of character set used to generate characters.
When unchecked, TeemTalk is in National mode in which a character set specific to the selected
keyboard nationality is used. When checked TeemTalk is in Multinational mode in which a
character set consisting of two tables of characters is used. This enables characters from any
keyboard nationality to be generated.

● Return function

Factory default: Unchecked

This option specifies whether or not the function of the Enter key is defined by the application
when in Block mode. When checked, the key is regarded as an application specific function key.
Normally this should be unchecked.
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Display Settings

● Cursor style

Factory default: Block

This enables you to specify how the text cursor is displayed. Select from Block, Underline,
Static block, Static underline or None.

● Auto wrap

Factory default: Unchecked

The setting of this option determines whether characters wrap to the next line when the right
margin is reached. When unchecked, on reaching the right margin, the last character position
will be overwritten by every new character received.

● Auto new line

Factory default: Unchecked

When checked, this will cause a carriage return command to be appended to every line feed
command received.

● Display controls

Factory default: Unchecked

The setting of this option determines whether received control codes are actioned or displayed.
When checked, a representation of most control codes will be displayed on the screen.
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● Cursor moves right to left

Factory default: Unchecked

This enables you change the direction in which the text cursor moves across the display.

● Copy right to left

Factory default: Unchecked

This enables the copy commands to function in right to left display mode.

● Status border

Factory default: Checked

This option enables you to display a thin border which separates the status line from the rest of
the lines on the display.
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Preferences

● Packet block

Factory default: Off

This option specifies whether you want to use packet blocking for X.25 communications line
support, and if so, the size of the packet block. The size may be set to any of the listed 128-byte
increments, or, by setting this option to Off, the default size of 260 bytes.

● Telserv format

Factory default: Unchecked

The setting of this option determines how network data is treated. When checked, data will be
treated in Tandem network server (Telserv) format. When unchecked, data will be treated in
serial format.

● Jump scroll

Factory default: Unchecked

The setting of this option determines whether data is scrolled one or several lines at a time when
the window becomes full.

When checked, data will scroll up several lines at a time as determined by the Scroll rate setting
below.

● Scroll rate

Factory default: 32
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This determines the number of lines that are scrolled when the Jump scroll option above is
selected.
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19 Wyse Emulations

This chapter describes features of the Wyse terminal emulations.

Introduction
The Wyse suite of terminal emulations consists of the following emulations which can be selected
using the Emulation mode option in the Wyse Settings dialog:

● ADDS A2

Provides compatibility with software designed to drive the ADDS Viewpoint A2 terminal, as
emulated by the Wyse WY-50/50+/60 terminals.

● HZ 1500

Provides compatibility with software designed to drive the Hazeltine 1500 terminal, as emulated
by the Wyse WY-50/50+/60 terminals.

● Stratus V102

Provides compatibility with software designed to drive the Stratus V102 terminal.

● TVI910, TVI920 and TVI925

Provide compatibility with software designed to drive the TeleVideo 910+, 920 and 925
terminals, respectively, as emulated by the Wyse WY-50/ 50+/60 terminals.

● TVI950 and TVI955

Provide compatibility with software designed to drive the TeleVideo 950 and 955 terminals,
respectively.

● WY50, WY50+ and WY60

Provide compatibility with software designed to drive the Wyse WY-50, WY-50+ and WY-60
terminals, respectively.

● Wyse PCTerm

Provides compatibility with software designed for the PC Term personality supported by Wyse.

Creating a Wyse Emulation Session
You can create a session either using the TeemTalk Session Wizard or while TeemTalk is running.
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Using the TeemTalk Session Wizard
This section describes how to use the TeemTalk Session Wizard to create an Wyse emulation
session.

1. To run the TeemTalk Session Wizard from the Start menu, select All Programs > HP > HP
TeemTalk Terminal Emulator > Session Wizard.

2. In the Session Name field, enter a unique name that will identify this session configuration for
future selection.

3. Select the Transport method then click the Configure button to specify settings.

4. Select the Connection type then click the Configure button to specify settings.

5. Select Wyse in the Emulation list box then click the Configure button to specify settings. (The
options are described in the section Setup Options on page 210.)

6. Click Next to display the Advanced Options dialog.

7. Click Next to display the Finalization dialog.

8. If you want a shortcut icon for this session to be created on the desktop, click the checkbox
Create icon on desktop for session.

9. Click OK to create the session and exit.

10. To run the session, either double-click on the desktop icon if one was created for the session, or
run TeemTalk, display the File menu and select Open Session. Select the name of the
required .tts session file then click Open.

Using the TeemTalk Emulator Window
This section describes the procedure for creating a Wyse emulation session from the TeemTalk
emulator window.

1. Display the Session menu from the menu bar and select Transport... to set the transport
method.

2. Display the Session menu and select Connection... to set the connection method.

3. Display the Session menu and select Emulation.... Set the emulation to Wyse.

4. You can configure the transport, connection and emulation settings by selecting the relevant
Configure options in the Session menu. The options displayed by selecting Configure
emulation are described in the section Setup Options on page 210.

5. To save the session, display the File menu and select Save session as. In the File Name field,
enter a unique name that will identify this session configuration for future selection, then click
Save. Note that session files have the filename extension .tts.

6. To run the session, display the File menu and select Open Session. Select the name of the .tts
session file then click Open.

Display Format
The display is divided into three areas by default: the status line, the data area, and the label line.
The status line which is used to display information relating to the emulation and messages from the

ENWW Display Format 205



application. The section Status Line on page 208 describes the status messages that can be
displayed by the emulation.

The data area is where data entered from the keyboard or the application is displayed. The data area
is set to 24 lines by 80 columns by default.

The label line is displayed at the bottom of the screen when the data area is set to 24 or 42 lines. This
is can be used to display messages or function key labels defined by the host.

Keyboard Mapping
The functions of the computer keyboard are mapped as closely as possible to the terminal being
emulated. The mapping of key functions can be determined by referring to the Emulation Keys list
box in the Key Macro Settings dialog, which is displayed by selecting Key Macros... on the Tools
menu.

The information in brackets in the right column indicates the default mapping of the key function
named in the left column. In the list, S+ indicates the Shift key, C+ indicates the Control key and A+
indicates the Alt key. For example:

WY_INSLINE (S+C+VK_INSERT)

indicates that the Insert Line function is mapped to the key combination Shift + Control + Insert.

Special key functions usually found on a Wyse keyboard can be mapped to any key on your keyboard
using the WY virtual key names listed in the Key Macro Settings dialog.

The illustrations on the following pages show where Wyse keyboard functions are mapped to keys on
a 101/102 key keyboard.

Figure 19-1  101/102 Key Keyboard Layout for the Wyse Emulations

Table 19-1  Wyse Series Keyboard Mapping

Key Key Modifier Result  Key Key Modifier Result

1
none

Shift +

ESCAPE

ESCAPE (Shifted)

 
17

none

Shift +

TAB

TAB (Shifted)
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Table 19-1  Wyse Series Keyboard Mapping (continued)

Key Key Modifier Result  Key Key Modifier Result

2

none

Shift +

Alt +

Shift + Alt +

F1

F1 (Shifted)

F11

F11 (Shifted)

 

18

none

Shift +

Ctrl + Alt +

Shift + Alt +

BACKSPACE

BACKSPACE (Shifted)

DEL KEY

DEL KEY (Shifted)

3

none

Shift +

Alt +

Shift + Alt +

F2

F2 (Shifted)

F12

F12 (Shifted)

 

19

none

Shift +

Alt +

Ctrl +

INSERT

REPLACE

INSERT CHARACTER

INSERT LINE

4

none

Shift +

Alt +

Shift + Alt +

F3

F3 (Shifted)

F13

F14 (Shifted)

 

20
none

Shift +

HOME

HOME (Shifted)

5

none

Shift +

Alt +

Shift + Alt +

F4

F4 (Shifted)

F14

F14 (Shifted)

 

21
none

Shift +

PAGE UP

PAGE UP (Shifted)

6

none

Shift +

Alt +

Shift + Alt +

F5

F5 (Shifted)

F15

F15 (Shifted)

 

22

none

Shift +

Ctrl +

Shift + Ctrl +

DELETE

DELETE (Shifted)

DELETE CHARACTER

DELETE LINE

7

none

Shift +

Alt +

Shift + Alt +

F6

F6 (Shifted)

F16

F16 (Shifted)

 

23

none

Shift +

Alt +

Shift + Ctrl +

CLEAR LINE

CLEAR SCREEN

END

END (Shifted)

8
none

Shift +

F7

F7 (Shifted)

 
24

none

Shift +

PAGE DOWN

PAGE DOWN (Shifted)

9
none

Shift +

F8

F8 (Shifted)

 

25

none

Shift +

Alt +

Shift + Alt +

CURSOR UP

CURSOR UP (Shifted)

COMPOSE CHARACTER

CHARACTER SET

10
none

Shift +

F9

F9 (Shifted)

 
26

none

Shift +

CURSOR LEFT

CURSOR LEFT (Shifted)
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Table 19-1  Wyse Series Keyboard Mapping (continued)

Key Key Modifier Result  Key Key Modifier Result

11
none

Shift +

F10

F10 (Shifted)

 
27

none

Shift +

CURSOR DOWN

CURSOR DOWN (Shifted)

12
none

Shift +

F11

F11 (Shifted)

 
28

none

Shift +

CURSOR RIGHT

CURSOR RIGHT (Shifted)

13
none

Shift +

F12

F12 (Shifted)

 
29 Shift + Ctrl + SPLIT

14

none

Shift + Ctrl +

Shift +

PRINT

PRINT (Shifted)

SEND

 

30
none

Shift +

Keypad 5

Keypad 5 (Shifted)

15
Shift + Ctrl +

Alt +

FUNCTION

PAUSE

 
31

none

Shift +

ENTER

ENTER (Shifted)

16

none

Shift +

Shift + Ctrl +

BREAK

ANSWERBACK

FDXBLK

 

32
none

Shift +

RETURN

RETURN (Shifted)

NOTE: All unmarked keys function as indicated by the legends on the keycaps.

Status Line
The status line is divided into two sections. The left section displays messages relating to the
emulation and the right section is used to display messages from the host. The type of status line
displayed is determined by the setting of the Status line option in the Wyse settings dialog. The
Extended status line provides similar information to the Standard status line but with additional fields
for displaying information on local editing mode.

The emulation status messages are displayed in one of six or eight fields along the first section of the
status line, depending on whether the Standard or Extended status line is displayed. The messages
and their meanings are listed below.
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Table 19-2  Wyse Terminal Status Line Messages

Field 1 Both Indicates the current keyboard mode.

CAPS indicates that Caps Lock is on. Press the Caps Lock key to
toggle the mode on and off.

LOCK indicates that the keyboard is locked. This takes
precedence over the CAPS and NUM messages.

NUM indicates that Num Lock is on. Press the Num Lock key to
toggle the mode on and off.

Field 2 Both Indicates the number of the page that is currently displayed. No
message is displayed when the current page is 0.

Field 3 Both * indicates that Monitor mode is on. In this mode, received codes
are not actioned but displayed as symbolic representations.

Field 4 Both Indicates the current operating mode.

FDX indicates full-duplex mode.

HDX indicates half-duplex mode.

LCL indicates local mode.

BLK indicates block mode.

HBLK indicates half-duplex block mode.

HLD indicates that display update has been suspended. Pressing
the Hold key will toggle display update on and off.

Field 5 Both >AUX indicates that the emulation is in auxiliary print or
transparent print mode.

<AUX indicates that the emulation is in auxiliary receive mode.

=AUX indicates that the emulation is in auxiliary receive mode and
auxiliary print mode.

%AUX indicates that a print screen operation is in progress.

Field 6 Standard rrr-ccc indicates the current row and column position of the cursor.

Field 6 Extended PROT indicates that Protect mode is on.

Field 7 Extended WPRT indicates that Write-protect mode is on when in Protect
mode.

Field 8 Extended INS indicates that Insert mode is on.
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Setup Options
The Wyse emulation is configured using setup options in the Wyse Settings dialog which can be
displayed using one of the following three methods:

Using the Session Wizard:

◦ In Step 1 set Emulation to Wyse then click the Configure button.

Using the TeemTalk Window:

◦ On the Session menu, select Emulation > Wyse then select Configure Emulation....

◦ On the configuration bar, select Wyse in the Emulation list box then click Configure
Emulation.

The setup options are grouped on three tabs labelled General, Display and Preferences.

General Settings

● Emulation mode

Factory default: WY50+
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This specifies the particular terminal to emulate, as supported by Wyse WY-50/50+/60 terminals.
Select from the following:

◦ ADDS A2

Provides compatibility with software designed to drive the ADDS Viewpoint A2 terminal, as
emulated by the Wyse WY-50/50+/60 terminals.

◦ HZ 1500

Provides compatibility with software designed to drive the Hazeltine 1500 terminal, as
emulated by the Wyse WY-50/50+/60 terminals.

◦ Stratus V102

Provides compatibility with software designed to drive the Stratus V102 terminal.

◦ TVI910, TVI920 and TVI925

Provide compatibility with software designed to drive the TeleVideo 910+, 920 and 925
terminals, respectively, as emulated by the Wyse WY-50/ 50+/60 terminals.

◦ TVI950 and TVI955

Provide compatibility with software designed to drive the TeleVideo 950 and 955 terminals,
respectively.

◦ WY50, WY50+ and WY60

Provide compatibility with software designed to drive the Wyse WY-50, WY-50+ and WY-60
terminals, respectively.

◦ Wyse PCTerm

Provides compatibility with software designed for the PC Term personality supported by
Wyse.

● Font

Factory default: Courier New

This enables you to specify the font to use for displaying characters. The available settings
depend on the fonts installed on your system.

● Character set

Factory default: Ascii

This specifies the character set used for displaying characters.

● Ansi codepage

Factory default: PC Multinational (437)

This option determines the set of characters that form the second half of the multinational
character set when in multinational mode.

● Multiple page

Factory default: Checked
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This option applies to the WY-50+, WY-60 and all the TVI emulations. It determines whether or
not more than one page of display memory can be accessed. When checked, all pages will be
accessible. See also the Auto page option.

Note that the TVI emulations support two pages of 24 lines each when this and the Auto page
options are selected, regardless of the Screen lines and Page size settings.

● Screen lines

Factory default: 24

This option applies to the WY-50+ and WY-60 emulations and specifies the number of data lines
displayed on the screen below the status line. Note that the other emulations only support 24
lines and a label line.

Screen lines Effect on display

24 24 data lines and a label line at the bottom

25 25 data lines but no label line

42 42 data lines and a label line at the bottom

43 43 data lines but no label line

● Screen columns

Factory default: 80

This option enables you to specify a display width of 80 or 132 columns.

● Page size

Factory default: 1 x Lines

This option applies to the WY-50+ and WY-60 emulations and specifies the size of a page in
display memory in multiples of the Lines setting. Note that the other emulations only support 1 x
Lines.

The 1 + Rest setting will divide the display memory into two pages, the first containing the
number of lines specified by the Lines option, the second containing all the remaining lines.

NOTE: Changing the page format will cause the entire display memory to be cleared, the
cursor will move to the home position and the scroll margin will be reset.

● Attribute type

Factory default: Page

The setting of this option determines whether display attributes are active to the end of the line
or the end of the page. The Character setting only applies to the WY-60 emulation and causes
attributes to only apply to characters written to the screen. The WY-50, ADDS A2 and HZ 1500
emulations only support the Page setting.

● Status line

Factory default: Standard

This option applies to all emulations and enables you to specify the type of status line displayed
at the top of the screen, or remove it from the display.
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Both the Standard and Extended status lines display messages about the state of the
emulation or application. The Extended status line displays additional editing status messages.
Refer to the section Status Line on page 208 for details.

● Cursor style

Factory default: Block

This enables you to specify how the text cursor is displayed. Select from Block, Underline,
Static block, Static underline or None.
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Display

● Auto scroll

Factory default: Checked

This option applies to all emulations and determines what happens when the cursor is moved
beyond the last line of the current page. When checked, the displayed data scrolls up and the
cursor remains on the last line. When unchecked, the cursor moves to the top of the same page.

● Auto page

Factory default: Unchecked

This option applies to the WY-50+, WY-60 and all the TVI emulations. It determines what
happens when the cursor reaches the top or bottom of the page.

When unchecked, the cursor either moves to the top of the same page or data scrolls up from
the bottom, as determined by the setting of the Auto Scroll option. When checked, a new page
of memory will be displayed.

NOTE: The other emulations will always display a new page of memory.

● Auto wrap

Factory default: Checked
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The setting of this option determines whether characters wrap to the next line when the right
margin is reached. When unchecked, on reaching the right margin, the last character position
will be overwritten by every new character received.

● Auto line feed

Factory default: Unchecked

When checked, a line feed command will be appended to every received carriage return
command.

● 80/132 clears

Factory default: Unchecked

This option applies to the WY-50+ and WY-60 emulations and determines whether or not data is
cleared from the display when the number of columns is changed. The screen is always cleared
when the number of columns is changed in the other emulations.

● Economy 80

Factory default: Unchecked

This option applies to the WY-50+ and WY-60 emulations and enables 80 column display with
more lines of display memory.

● WPRT dim

Factory default: Checked

This option applies to all emulations and enables you to specify the appearance of write-
protected characters on the display. Checking this option will cause the characters to be
dimmed.

● WPRT invisible

Factory default: Unchecked

This option applies to all emulations and enables you to specify the appearance of write-
protected characters on the display. Checking this option will cause the characters to be
invisible. Note that the WY-50+ and WY-60 emulations also support the invisible attribute.

● WPRT reverse

Factory default: Unchecked

This option applies to all emulations and enables you to specify the appearance of write-
protected characters on the display. Checking this option will cause the characters to be
displayed in reverse video.

● WPRT underline

Factory default: Unchecked

This option applies to all emulations and enables you to specify the appearance of write-
protected characters on the display. Checking this option will cause the characters to be
underlined. Note that the WY-50+ and WY-60 emulations also support the underline attribute.

● WPRT blink

Factory default: Unchecked
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This option applies to all emulations and enables you to specify the appearance of write-
protected characters on the display. Checking this option will cause the characters to blink.

● Display controls

Factory default: Unchecked

This option determines whether received control codes are actioned or displayed.
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Preferences

● DEL = DestBS

Factory default: Unchecked

This option applies to the WY-50+ and WY-60 emulations and determines what effect an ASCII
DEL character has on displayed characters. The other emulations ignore the DEL character.

When unchecked, the DEL character is ignored. When checked, the DEL character is
interpreted as a destructive backspace, causing the character to the left of the cursor to be
deleted and the cursor to move into that position.

● Margin bell

Factory default: Unchecked

This option applies to all emulations and it determines whether or not an audible warning sounds
when the cursor reaches a specified column. The default bell column number is 72 in 80 column
mode and 124 in 132 column mode.

● Enhance

Factory default: Checked

When this option is checked, TeemTalk will recognize an additional set of Wyse codes which are
not normally supported by specific non-Wyse terminals.
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● Answerback

Factory default: Unspecified

This enables you to specify the Answerback string that is sent to the host in response to an
ANSI mode enquiry command. The string may be up to 30 characters long.

● Answerback concealed

Factory default: Unchecked

Checking this option will cause the Answerback string specified in the text box above to be
locked from change and displayed as asterisks. Note that unchecking this option will cause the
Answerback string to be deleted.

● Answerback mode

Factory default: Unchecked

This option applies to all emulations and specifies whether or not an answerback message is
automatically sent to the host in response to an ASCII ENQ character.

● Send ACK

Factory default: Checked

This option applies to all emulations and specifies whether or not an ASCII ACK character is
sent to the host port after certain commands have been executed.

● Colour support

Factory default: Unchecked

When this option is checked, an additional set of host commands will be recognized to
determine the colors used for the display. Wyse 350 color commands will be recognized in all
modes except Wyse 60, which will use Wyse 60 color commands.

● Application key mode

Factory default: Unchecked

When application key mode is selected, the function keys and certain editing keys will send
application codes when pressed, regardless of whether or not the keys have been redefined.
When this option is not selected, the keys will send their programmed definitions.

● CR = CR/NULL

Factory default: Checked

This option allows you to disable the NULL being automatically sent on CR.

● Block mode

Factory default: Unchecked

This option applies to all emulations. In Block mode, keyboard entered data is displayed and
processed locally, allowing you to edit it before a block of data is sent to the host. When Block
mode is disabled, data is sent to the host as it is entered at the keyboard.

● Block end

Factory default: US/CR
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This option applies to all emulations and specifies the ASCII characters used to indicate the end
of a line and a block when a block of data is sent to the host.

When set to US/CR, the line terminator is a US character and the block terminator is a CR
character. When set to CRLF/ETX, the line terminators are the CR and LF characters, and the
block terminator is an ETX character.

● Jump scroll

Factory default: Checked

The setting of this option determines whether data is scrolled one or several lines at a time when
the window becomes full.

When checked, data will scroll up several lines at a time as determined by the Scroll rate setting
below.

● Scroll rate

Factory default: 24

This determines the number of lines that are scrolled when the Jump Scroll option above is
selected.

Tab Settings

Clicking the Set Tabs... button at the bottom of the Wyse Settings dialog will display the Tab
Settings dialog which enables you to set tab stops.

Tab stops are set every eight columns by default, as indicated by the T character below the relevant
column numbers. If you want tab stops to be set at regular intervals other than every 8th column,
enter the number of columns required between each tab stop in the box next to the Set Every button,
then click the button.

Individual tab stops can be toggled on or off by clicking the mouse pointer above or below the
relevant column number.

To remove all the tab stops, click the Clear All button.

To save the current tab stops, select Save Session in the File menu.
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20 MDIS Prism Emulations

This chapter describes the features of the MDIS (McDonnell Douglas Information Systems) Prism
terminal emulations..

Introduction
The MD Prism Series suite of terminal emulations consists of the following personalities which can be
selected using the Personality option in the General tab of the MD Prism Settings dialog:

Prism 8/12

Provides compatibility with software designed to drive the MDIS Prism 8 or Prism 12 terminals.

Prism 9

Provides compatibility with software designed to drive the MDIS Prism 9 terminals.

Creating a MD Prism Emulation Session
You can create a session either using the TeemTalk Session Wizard or while TeemTalk is running.

Using the TeemTalk Session Wizard
This section describes how to use the TeemTalk Session Wizard to create an MD Prism emulation
session.

1. To run the TeemTalk Session Wizard from the Start menu, select All Programs > HP > HP
TeemTalk Terminal Emulator > Session Wizard.

2. In the Session Name field, enter a unique name that will identify this session configuration for
future selection.

3. Select the Transport method then click the Configure button to specify settings.

4. Select the Connection type then click the Configure button to specify settings.

5. Select MD Prism in the Emulation list box then click the Configure button to specify settings.
(The options are described in the section Setup Options on page 224.)

6. Click Next to display the Advanced Options dialog.

7. Click Next to display the Finalization dialog.

8. If you want a shortcut icon for this session to be created on the desktop, click the checkbox
Create icon on desktop for session.

9. Click OK to create the session and exit.

10. To run the session, either double-click on the desktop icon if one was created for the session, or
run TeemTalk, display the File menu and select Open Session. Select the name of the
required .tts session file then click Open.
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Using the TeemTalk Emulator Window
This section describes the procedure for creating a MD Prism emulation session from the TeemTalk
emulator window.

1. Display the Session menu from the menu bar and select Transport... to set the transport
method.

2. Display the Session menu and select Connection... to set the connection method.

3. Display the Session menu and select Emulation.... Set the emulation to MD Prism.

4. You can configure the transport, connection and emulation settings by selecting the relevant
Configure options in the Session menu. The options displayed by selecting Configure
emulation are described in the section Setup Options on page 224.

5. To save the session, display the File menu and select Save session as. In the File Name field,
enter a unique name that will identify this session configuration for future selection, then click
Save. Note that session files have the filename extension .tts.

6. To run the session, display the File menu and select Open Session. Select the name of the .tts
session file then click Open.

Keyboard Mapping
The functions of the computer keyboard are mapped as closely as possible to the terminal being
emulated. The mapping of key functions can be determined by referring to the Emulation Keys list
box in the Key Macro Settings dialog, which is displayed by selecting Key Macros... on the Tools
menu.

The information in brackets in the right column indicates the default mapping of the key function
named in the left column. In the list, S+ indicates the Shift key, C+ indicates the Control key and A+
indicates the Alt key. For example:

MD_F20        (A+VK_F10)

indicates that the F20 function is mapped to the key combination Alt + F10.

Special key functions usually found on a MDIS Prism keyboard can be mapped to any key on your
keyboard using the MD virtual key names listed in the Key Macro Settings dialog.
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The illustrations on the following pages show where MDIS keyboard functions are mapped to keys on
a 101/102 key keyboard.

Figure 20-1  101/102 Key Keyboard Layout for the MDIS Prism Emulation

Table 20-1  MD Prism Keyboard Mapping

Key Key Modifier Result  Key Key Modifier Result

1  ESC  16  BREAK

2 none PF1
 

17
none

Shift +

TAB

BACKTAB

3 none PF2
 18 none

Shift +

DELETE

BACKSPACE

4
none

Alt +

PF3

F13

 
19

 
FIND

5

none

Shift +

Alt +

PF4

PRINT TTY MODE

F14

 

20

 

INSERT

6 Alt + HELP (F15)  21  REMOVE

7 Alt + DO (F16)  22  SELECT

8
none

Alt +

F7

F17

 
23

 
PREVIOUS PAGE

9
none

Alt +

F8

F18

 
24

 
NEXT PAGE

10
none

Alt +

F9

F19

 25 none

Ctrl +

Alt +

Shift + Ctrl +

CURSOR UP

SCROLL UP

COMPOSE CHARACTER

SETUP
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Table 20-1  MD Prism Keyboard Mapping (continued)

Key Key Modifier Result  Key Key Modifier Result

11 none

Alt +

F10

F20

 26 none

Ctrl +

CURSOR LEFT

SCROLL LEFT

12

 

F11

 27 none

Ctrl +

Alt +

CURSOR DOWN

SCROLL DOWN

DATATALK

13
 

F12
 28 none

Ctrl +

CURSOR RIGHT

SCROLL RIGHT

14

Ctrl +

Shift + Ctrl +

PRINT SCREEN

PRINT SCROLLING
REGION

 

29
none

Alt +

,

-

15  HOLD SCREEN  30  ENTER

NOTE: All unmarked keys function as indicated by the legends on the keycaps.

The Status Bar
Below the emulation workspace in the TeemTalk window is a status bar that indicates the status of
various operations and provides buttons for switching between modes. The information displayed in
the status bar depends on the current terminal emulation.

Item Description

1 This LED indicates whether you are connected to the host. It will appear red when not connected
and green when you are connected.

2 This LED indicates whether data is being sent to or from the host. It will appear dull green when
there is no activity, red when data is being sent to the host, and bright green when data is being
received from the host.

3 This button enables you to switch between Local and Online mode. The label indicates the mode
you will switch to when the button is clicked.

4 This button enables you to Pause or Resume scrolling data in the window. The label indicates the
action that will be taken when the button is clicked.

5 Indicates the current terminal emulation.

6 Displays the active session and current page number (always 1), and the line:column location of
the text cursor.
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Item Description

7 This indicates whether Overstrike mode or Insert mode is currently active. In Overstrike mode
(default), new characters will replace already existing characters at the cursor position. When Insert
mode is active, new characters will be inserted at the cursor position without deleting existing
characters, which will move to the right.

8 Indicates the status of the printer as follows:

● None indicates that the printer is not turned on or not connected, or not installed or
configured.

● Not Ready indicates that the printer is not ready to receive data for printing.

● Ready indicates that the printer is ready to receive data for printing.

● Auto indicates that the emulation is in Auto Print mode in which the current cursor line is sent
to the printer when a command for the cursor to move to the next line is issued.

● Controller indicates that the emulation is in Printer Controller mode in which the host has
direct control over the printer. Print screen commands issued from the keyboard or mouse will
be ignored.

● Tty Print indicates that the emulation is in TTY Print mode. In this mode, incoming screen text
(but not control codes except CR and LF) are sent to the printer.

● ErrGen indicates that an error has occurred and a message box will be displayed indicating
the error.

9 Indicates the status of the aux port as follows:

● Ready indicates that the aux port is ready for bidirectional output.

● In Use indicates that the aux port is currently busy.

● None indicates that aux port not available or no aux port configured.

Setup Options
The MD Prism emulation is configured using setup options in the MD Prism Settings dialog which
can be displayed using one of the following three methods:

Using the Session Wizard:

◦ In Step 1 set Emulation to MD Prism then click the Configure button.

Using the TeemTalk Window:

◦ On the Session menu, select Emulation > MD Prism then select Configure Emulation....

◦ On the configuration bar, select MD Prism in the Emulation list box then click Configure
Emulation.

The setup options are grouped on three tabs labeled General, Display and Preferences.
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General Settings

● Personality

Factory default: Prism 8/12

This specifies the particular MD Prism terminal to emulate. Select from the following:

◦ Prism 8/12 Provides compatibility with software designed to operate the McDonnell
Douglas Prism-8 and Prism-12 terminals.

◦ Prism 9 Provides compatibility with software designed to operate the McDonnell Douglas
Prism-9 terminal.

● Font

Factory default: Courier New

This enables you to specify the font to use for displaying characters. The available settings
depend on the fonts installed on your system.

● Character set

Factory default: Multinational

This specifies the character set used for displaying characters.

When Iso Hebrew is selected, the following key functions will be enabled:

◦ Ctrl + Alt + F1 Select Multinational 8-bit mode and left-to-right typing.

◦ Ctrl + Alt + F2 Select National 7-bit mode (lowercase English characters will be displayed
as Hebrew) and right-to-left typing.

◦ Ctrl + Alt + F3 Toggle between left-to-right and right-to-left typing.

● Multinational mode
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Factory default: Checked

This option will only be available if the system is configured for a language that supports national
replacement character sets.

The setting of this option determines the type of character set used to generate characters.
When unchecked, TeemTalk is in National mode in which a character set specific to the selected
keyboard nationality is used. When checked (default) TeemTalk is in Multinational mode in
which a character set consisting of two tables of characters is used. This enables characters
from any keyboard nationality to be generated.

● MDC-UK National Keyboard

Factory default: Unchecked

This option will only be available if TeemTalk is set to National mode.

The setting of this option will automatically re-map the ?, $ and # symbols when system set to
UK locale.

● Columns per screen

Factory default: 80

This option enables you to specify a width of 80 or 132 columns for the workspace. When set to
132, the setting of the Use 80 Column Font option determines whether all 132 columns are
displayed using a narrow font, or only 80 columns at a time using the normal (80 column) font,
with the ability to scroll horizontally to view the remaining columns.

● Cursor style

Factory default: Block

This enables you to specify how the text cursor is displayed. Select from Block, Underline,
Static block, Static underline or None.
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Display Settings

● Jump scroll

Factory default: Checked

The setting of this option determines whether data is scrolled one or several lines at a time when
the window becomes full.

When checked, data will scroll up several lines at a time as determined by the Scroll rate setting
below.

● Scroll rate

Factory default: 80

This determines the number of lines that are scrolled when the Jump scroll option above is
selected.

● Display controls

Factory default: Unchecked

The setting of this option determines whether received control codes are actioned or displayed.
When checked, a representation of most control codes will be displayed on the screen.

● Display error codes

Factory default: Checked

This option determines whether a visual indicator is displayed when an error code is received.
When checked, error codes received are displayed as a reverse question mark and are not
ignored.

● Display delete codes

Factory default: Unchecked
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This option determines whether a visual indicator is displayed when a delete code (7f hex) is
received. When checked, a symbol is display on receipt of a delete code.

● Ignore nulls

Factory default: Unchecked

The setting of this option determines whether Null characters received from the host are
actioned or ignored.

● Cursor moves right to left

Factory default: Unchecked

The setting of this option enables you change the direction in which the text cursor moves
across the display.

● Copy right to left

Factory default: Unchecked

The setting of this option enables the copy commands to function in right to left display mode.
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Preferences

● Auto wrap

Factory default: Checked

The setting of this option determines whether characters wrap to the next line when the right
margin is reached. When unchecked, on reaching the right margin, the last character position
will be overwritten by every new character received.

● Auto new line

Factory default: Unchecked

When checked, this will cause a carriage return command to be appended to every line feed
command received.

● Auto line feed

Factory default: Unchecked

When checked, this will cause a line feed command to be appended to every carriage return
command received.

● Application keypad

Factory default: Unchecked

The setting of this option determines the effect of pressing keys in the keypad on the right side of
the keyboard.

When unchecked, the keypad is in numeric mode and keys will generate the characters shown
on the key caps. When checked, the keypad is in application mode and keys will generate
control functions when pressed.

● Keyboard sends scan codes
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Factory default: Unchecked

The setting of this option determines whether keyboard scan codes or ASCII codes are sent to
the host on key press/release.

● Backspace = DEL

Factory default: Unchecked

The setting of this option determines whether or not a backspace command performs a delete.

● CR = CR/NULL

Factory default: Checked

This option allows you to disable the NULL being automatically sent on CR.
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21 Running Scripts

This chapter describes how to run a script program.

Introduction
TeemTalk provides a scripting language that enables you to automate a variety of operations. The
commands that can be used in a script file are described in the HP TeemTalk Terminal Emulator 7.0
Programmer's Manual . This chapter describes the options for running a script file.

Script Item on Tools menu
To run a script from the TeemTalk Tools menu:

1. Select Script... on the Tools menu.

2. Select Run Script.

3. Either enter the name of the script file in the Script File box, or click the Browse button to select
the file.

4. If you want to edit the script you can do so by clicking the Edit button. This will display the Script
Editor window which provides editing facilities so that you can view and edit script files.

5. The Parameters box enables you to specify the values of ArgV# type variables within the script,
if required. The values are separated from each other by a comma. You must ensure that the
values are entered in the correct order so that they are assigned to the correct variables.

6. Click Run to run the script.
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Using a Key or Button Definition
You can program a key or button to run a script file when pressed by enclosing the name of the script
file including any parameters within the <' (left angle bracket and single quote) and '> (single quote
and right angle bracket) characters.

For example, to program a key or button so that it will run the script file myscript.scr and assign the
values value1 to variable ArgV1 and value2 to ArgV2, you would enter the following for the key or
button definition:

<'myscript.scr(value1,value2)'>
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22 Capturing Host Communication

This chapter describes how to capture the communication between the host and the emulator in a file,
then replay it.

Introduction
TeemTalk provides a facility for capturing the communication between the host and the emulation to a
file which you can replay. This is achieved using the Capture File and Replay File options on the
Tools menu.

The default capture state is to capture received host data only, but you can capture both received
data and data sent back to the host by the emulation by using the following command line options:

-debug

Capture data sent by host only.

-debug2way

Capture data sent by both host and emulation.

The default replay state is to the emulation, but you can direct the replay to the host only or to both
host and emulation by using the following command line options:

-replay

Replay directed to emulation only.

-replayhost

Replay directed to host only.

-replayboth

Replay directed to both host and emulation.

Note that you can modify the speed at which the replay is performed by appending a number in the
range 0 to 10 to the command line option, where 0 is fast and 10 is slow. For example: -replayhost8.
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Capture File
To start the Capture File process:

1. Select Capture File on the Tools menu to display the Save capture file as dialog.

2. Enter a name for the capture file in the File name box then click the Save button.

Communication between the host and the emulation will now be logged in the specified file and
the Capture File item on the Tools menu will have a check mark next to it indicating that the
Capture File process is active.

To stop the Capture File process, select Capture File on the Tools menu to stop the Capture File
process. The check mark will toggle off.
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Replay File
To start the Replay File process:

1. Select Replay File on the Tools menu to display the Choose a file to replay dialog.

2. Enter the name of the capture file to replay in the File name box then click the Open button.

Communication between the host and the emulation logged in the Capture File will now be
replayed and the Replay File item on the Tools menu will have a check mark next to it
indicating that the Replay File process is active.

To stop the Replay File process, select Replay File on the Tools menu to stop the Replay File
process. The check mark will toggle off.
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23 Preferences and Command Line
Options

This chapter describes the Preferences dialog and command line options that can be used to specify
the TeemTalk startup configuration.

Preferences
The Preferences dialog provides user control of several TeemTalk options as well as an alternative
input location for TeemTalk command line options. The preferences can be displayed from the File
menu by selecting the Preferences... option.

Specify the desired options as described below, and then click the Save Preferences button. Please
note that changes made in the preferences dialog will affect all TeemTalk sessions.

● Show Configuration Bar 

Factory default: Checked

When checked the configuration bar will be displayed. This option does not affect the display of
the Session menu.

● Save Current Window Position 

Factory default: Unchecked

When checked the current TeemTalk windows size and position will be saved when the Save
Preferences button is pressed and restored on next launch. If previously set, to save a new size
and position, bring up the Save Preferences dialog again, ensure the Save Current Windows
Position is check and click the Save Preferences button.

● Run in Full Screen Mode 

Factory default: Unchecked

This will cause the emulation workspace to fill the screen and will remove the window frame, soft
buttons, menu and configuration bars. Note that this option will not take effect until the next
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launch and will override the Show Configuration Bar and Save Current Window Position
options if selected.

● Command Line Start Up Options 

Factory default: Blank

This field provides an alternative location for specifying TeemTalk command line options. Please
refer to the remainder of this chapter for descriptions of the valid options which can be entered
here.

Command Line Options
The command line for running TeemTalk can include options that modify its startup configuration. The
options are entered after the name of the TeemTalk application and each option must be preceded by
a space.

For example, to run TeemTalk so that the configuration bar and soft buttons are not displayed you
would enter the following on the command line:

teemtalk.exe -cfg -bl0

where -cfg removes the configuration bar and -bl0 removes the soft buttons.

All the command line options currently supported by TeemTalk are described in the following tables.

Session Configuration
Table 23-1  Command switches that affect the Session configuration

Functionality Command switch Description

Load Session
File

+lsf"mysessionfile.tts" This enables you to load settings stored in a session configuration file
previously created using either the TeemTalk Session Wizard or the
Save Session As dialog. The specified filename must include the
extension .tts and must be enclosed within double-quote characters.

Path for
Language/
Codepage Files

-langdir"full directory path" This specifies the full directory path for language and codepage files.

Translation File -transl"filename" This specifies the name and optional path of the translation file to use.
If the entry contains no / or \ characters for directory, it assumes the
path is in the language directory. If the entry starts with the _
character it prepends the application name (teemtalk_).

Do Not Display
Query Save
Session
Message

-qss <n> This enables you to specify what happens when you attempt to exit a
session which has been modified but not saved. By default a
message box will be displayed asking if you want to save the new
settings before exiting. Using this command line option without the
optional <n> value will prevent the message from being displayed.

The value <n> is optional and can be one of the following:

1 Save the session.

2 Cancel (default action).
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Table 23-1  Command switches that affect the Session configuration (continued)

Functionality Command switch Description

Do Not Display
Dialog When
Host
Connection
Closed

-rce <n> This enables you to specify what happens on host disconnection. By
default a dialog box will be displayed asking if you want to reconnect,
cancel or exit TeemTalk. Using this command line option without the
optional value will prevent the message from being displayed.

The <n> value is optional and can be one of the following:

1 Reconnect.

2 Cancel (default action).

3 Exit.

Replay File to
Emulation Only

-replay <n> This specifies that a file replay is directed to the emulation only
(default), not to the host. The optional <n> parameter specifies the
speed of the replay and is a numeric value in the range 0 to 10, where
0 (default) is fastest and 10 is slowest.

Replay File to
Host Only

-replayhost <n> This specifies that a file replay is directed to the host only, not to the
emulation. The optional <n> parameter specifies the speed of the
replay and is a numeric value in the range 0 to 10, where 0 (default) is
fastest and 10 is slowest.

Replay File to
Both Host &
Emulation

-replayboth <n> This specifies that a file replay is directed to both the host and the
emulation. The optional <n> parameter specifies the speed of the
replay and is a numeric value in the range 0 to 10, where 0 (default) is
fastest and 10 is slowest.

Enable Debug -debug This enables received host data to be logged in a file for replaying
later using the Capture File and Replay File options on the Tools
menu.

Enable Debug
Two-Way

-debug2way This enables both received host data and data sent back to the host
to be logged in a file for replaying later using the Capture File and
Replay File options on the Tools menu.

Set Bitwise
Debugging
Flags

-debug=NN This sets bitwise debugging flags.

Window Appearance
Table 23-2  Command switches that affect the Window appearance

Functionality Command
switch

Description

Do Not Show Splash
Screen

-spl This prevents the initial splash screen from being displayed when TeemTalk
is started.

Show Window Full Screen +wfs This will cause the emulation workspace to fill the screen. Note that this
also removes the window frame, soft buttons, menu and configuration bars.

Show Window Minimized +wmn This will cause the TeemTalk window to be minimized on startup.

Show Window Maximized +wmx This will cause the TeemTalk window to be maximized on startup.
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Table 23-2  Command switches that affect the Window appearance (continued)

Functionality Command
switch

Description

Set Window Position +pos left , down This specifies the position of the top left corner of the TeemTalk window
relative to the top left corner of the display. The numeric value of left and
down (separated by a comma) specifies the number of pixels. For example,
to position the window 200 pixels from the left edge of the display and 100
pixels down, you would use the following entry: +pos200,100.

Set Window Size +siz width ,
depth

This specifies the size of the TeemTalk window. The numeric value of width
and depth (separated by a comma) specifies the number of pixels. For
example, to specify a window size of 1280 by 1024 pixels you would use
the following entry: +siz1280,1024.

Disable Window resize -wrd This prevents the TeemTalk window from being resized.

Remove the Window
Frame

-wfr This will remove the window frame from the display. Note that this also
removes the title bar, system menu, minimize and maximize buttons.

Remove the Title Bar -ttb This will remove the title bar from the display. Note that this also removes
the window frame, system menu, minimize and maximize buttons.

Add the Title Bar +ttb This will add the title bar to the display.

Window Title Command
option: +wtl"title"

This enables you to specify the title that is to be displayed in the title bar.
This is useful when you are running more than one instance of TeemTalk. If
no title is specified then the name of your version of the emulator will be
displayed.

Window Subtitle Command
option:

+stl"subtitle"

This specifies a subtitle which is appended to the title displayed in the title
bar.

Remove the System Menu -sys This will remove the system menu from the display. Note that this also
removes the window frame, minimize and maximize buttons.

Add the System Menu +sys This will add the system menu to the display. Note that the title bar must be
enabled.

Remove/Disable Minimize
Button

-mnb This will remove or disable the minimize button. Note that the window frame
will also be removed.

Add/Enable Minimize
Button

+mnb This will add or enable the minimize button. Note that the system title bar
and system menu must be enabled.

Remove/Disable Maximize
Button

-mxb This will remove or disable the maximize button. Note that the window
frame will also be removed.

Add/Enable Maximize
Button

+mxb This will add or enable the maximize button. Note that the system title bar
and system menu must be enabled.

Remove the Menu Bar -mnu This will remove the menu bar from the display.

Remove the File Menu -mfi This will remove the File menu from the menu bar.

Remove individual File
menu items

-ffd Remove Factory Default.

 -frt Remove Reset Termina.

 -fnw Remove New Window.
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Table 23-2  Command switches that affect the Window appearance (continued)

Functionality Command
switch

Description

 -fnt Remove New Tab.

 -fct Rmove Close Tab.

 -fos Remove Open Session.

 -fss Remove Save Session.

 -fsa Remove Save Session As.

 -fps Remove Print Screen.

 -fpr Remove Preferences.

 -fex Remove Exit.

Remove the Edit Menu -med This will remove the Edit menu from the menu bar.

Remove individual Edit
menu items

-eop Remove Clipboard Options.

 -ecb Remove Clear Buffer.

 -eec Remove Copy.

 -eep Remove Paste.

 -esa Remove Select All.

Remove the View Menu -mvi This will remove the View menu from the menu bar.

Remove individual View
menu items

-vto Remove Toolbars.

 -vwi Remove Windows.

 -vst Remove Status Bar.

Remove the Connection
Menu

-mco This will remove the Connection menu from the menu bar.

Remove individual
Connection menu items

-ccn Remove Connect.

 -cdi Remove Disconnect.

Remove the Session
Menu

-mse This will remove the Session menu from the menu bar.

Remove individual
Session menu items

-str Remove Transport.

 -sco Remove Connection.

 -sem Remove Emulation.

 -sct Remove Configure Transport.

 -scc Remove Configure Connection.

 -sce Remove Configure Emulation.
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Table 23-2  Command switches that affect the Window appearance (continued)

Functionality Command
switch

Description

Remove the Tools Menu -mto This will remove the Tools menu from the menu bar.

Remove individual items
from the Tools menu

-tat Remove Attributes.

 -tkm Remove Key Macros.

 -tma Remove Mouse Actions.

 -tsb Remove Soft Buttons.

 -tal Remove Auto Logon.

 -tcf Remove Capture File.

 -trf Remove Replay File.

 -tep Remove Emulation Printer

Remove the Help Menu -mhe This will remove the Help menu from the menu bar.

Remove individual Help
menu items

-hth Remove HP TeemTalk Help.

 -hab Remove About.

Remove the Emulation
Status Bar

-esb This will remove the emulation status bar from the display.

Remove the
Configuration Bar

-cfg This will remove the configuration bar from the display. Note that the
Session menu will also be removed from the menu bar.

Remove individual
Configuration Bar items

-ctr Remove Transport.

 -cco Remove Connection.

 -cem Remove Emulation.

 -ccb Remove Connect/Disconnect.

Remove the Window
Status Bar

-wsb This will remove the window status bar from the display.

Remove the Soft Buttons -bl0 or +bl0 This will remove the soft buttons from the display.

Soft Button Levels
Displayed

+bl1 to +bl4 This specifies how many soft button levels are displayed at any one time.
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Emulation Workspace
Table 23-3  Command switches that affect the emulation workspace

Functionality Command
switch

Description

Mouse Cursor Style +cu style This enables you to specify how the mouse cursor appears in the emulation
workspace. You can select from the following style options:

0 Blank cursor

1 I-Beam (the default)

2 Arrow

3 Up arrow

4 Crosshair

5 Hourglass/watch

6 Vertical resize

7 Horizontal resize

8 Diagonal resize (\)

9 Diagonal resize (/)

10 All directions resize

11 Vertical splitting

12 Horizontal splitting

13 Pointing hand

14 Slashed circle

15 Arrow with question mark

16 Arrow with hourglass/watch

Reflection 4 Color Support +r4c This enables Reflection 4 color commands to be processed in the VT
terminal emulation.

242 Chapter 23   Preferences and Command Line Options ENWW



A Programming Keys and Buttons

This appendix describes how to program a key or button to generate specific key functions and
characters when pressed.

Introduction
TeemTalk provides various ways of programming keys and buttons to perform functions that you
have defined. The following sections describe how to include key functions and special characters in
a user definition.

The function of keys and buttons can be redefined using settings in the following dialogs displayed
from the Tools menu:

Key Macro Settings described in the section Defining Key Functions on page 30.

Mouse Action Settings described in the section Defining Mouse Functions on page 38.

Soft Button Settings described in the section Defining Soft Button Functions on page 45.

Including Key Function Combinations & Sequences
You can program a key or button to perform the function of a combination or sequence of keys. For
example, you can cause a key or button to perform the same function as pressing the keys Alt + F4
together, or pressing the keys F2 then F3 then F4.

Virtual Key Names
Key functions are identified by virtual key names as listed in the Key Macro Settings dialog in the
Emulation Keys and Virtual Keys list boxes. The virtual key name has to be enclosed by the < and
> characters in the user definition box. You may omit the VK_ and VT_ (etc.) parts of the virtual key
name.

For example, the virtual key name for the Return key function when running a DEC VT terminal
emulation is VT_RETURN. You would enter this in the user definition box as follows:

<RETURN>

Key Combinations
To program a key or button so that it performs the same function as pressing two or more other keys
together, type the < character, followed by the virtual key names linked together with + (plus sign)
characters, and end with the > character

For example, to program a key or button so that when it is pressed it performs the same function as
pressing the keys Alt + F4 together, enter the following characters in the user definition box:

<ALT+F4>
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Key Sequences
To program a key or button so that it performs the same function as pressing a sequence of keys one
after the other, enter each virtual key name in the order required, starting and ending each virtual key
name with the < and > characters, respectively. Each enclosed virtual key name must immediately
follow the previous enclosed virtual key name with no spaces.

For example, to program a key or button so that when it is pressed it performs the same function as
pressing the keys F2 then F3 then F4, enter the following characters in the user definition box:

<F2><F3><F4>

Including Special Characters
Control Characters

There are various ways in which you can specify a particular character in a user definition. For
example, the ESC character can be specified using any one of the following five entries:

_027 Decimal value (underscore character followed by a 3-digit number).

\033 Octal value (backslash character followed by a 3-digit number).

\u001B Unicode value (backslash and u characters then unicode value).

^[ Control key value (^ represents the control key on the keyboard).

\e Additional value for ESC.

Backslash Values
The following backslash values can be used:

\u Unicode introducer

\n Line feed

\r Carriage return

\e Escape

Note that as the \ and ^ characters are used as value introducers, to enter these as character values
you need to precede them with a backslash character, i.e. enter \ as \\ and ^ as \^.

The Euro Character
The Euro character can be specified by entering the unicode value \u20ac.

Running a Script File
You can define a macro to run a script file by enclosing the name of the file and any arguments within
the <' (left angle bracket and single quote) and '> (single quote and right angle bracket) characters.
For example, to run the script file myscript.scr and assign the values value1 and value2 to two
variables, you would enter the following in the macro definition:

<'myscript.scr(value1,value2)'>
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B Virtual Key Names

This appendix lists the virtual key names available for defining key functions and including specific
key functions in macro definitions.

Introduction
This appendix lists the virtual key names supported by TeemTalk. Virtual key names enable you to
redefine keys on the keyboard and include specific key functions in a macro definition.

The virtual key names that can be used depends on the terminal emulation being run. The Emulation
Keys and Virtual Keys list boxes in the Key Macro Settings and Soft Button Settings dialogs list
all the virtual key names that can be used while running the current terminal emulation.

The following sections list the virtual key names that apply to each terminal emulation. Note that the
Standard Virtual Key Names section applies to all terminal emulations.

The virtual key names listed in each terminal emulation section includes an additional column
indicating the default mapping of the key function on the keyboard by TeemTalk. Note that the
following abbreviations apply:

S+ Shift Key

C+ Control Key

A+ Alt Key

Standard Virtual Key Names
The virtual key names listed in this section are applicable in all terminal emulations.

Table B-1  Standard Virtual Key Names

Key Function Virtual Key Name

0 - 9 VK_0 - VK_9

A - Z VK_A - VK_Z

Alt (right) VK_RALT

Apps VK_APPS

Apostrophe VK_APOSTROPHE

Attention VK_ATT

Backspace VK_BACK

Blank Key VK_NONAME

Break VK_BREAK

Capital VK_CAPITAL
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Table B-1  Standard Virtual Key Names (continued)

Key Function Virtual Key Name

Clear Clear (OEM)

Comma VK_COMMA

Compose Character VK_COMPOSE

Control (Left) VK_CONTROL

Control (Right) VK_RCONTROL

Copy VK_COPY

Cursor Up VK_UP

Cursor Down VK_DOWN

Cursor Left VK_LEFT

Cursor Right VK_RIGHT

Cursor Select VK_CRSEL

Data Talk VK_DATATALK

Delete VK_DELETE

End VK_END

Equal VK_EQUAL

Erase End Of File VK_EREOF

Escape VK_ESCAPE

Euro Sign VK_EUROSIGN

Execute VK_EXECUTE

Exit Emulator VK_EXIT

Exsel VK_EXSEL

F1 - F24 VK_F1 - VK_F24

Help VK_HELP

Hold Screen VK_HOLDSCREEN

Home VK_HOME

Hyphen VK_HYPHEN

Insert VK_INSERT

Menu VK_MENU

Num Lock VK_NUMLOCK

Numeric Pad 0 - 9 VK_NUMPAD0 - VK_NUMPAD9

Numeric Pad Add (+) VK_ADD
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Table B-1  Standard Virtual Key Names (continued)

Key Function Virtual Key Name

Numeric Pad Divide (/) VK_DIVIDE

Numeric Pad Decimal (.) VK_DECIMAL

Numeric Pad Multiply (*) VK_MULTIPLY

Numeric Pad Subtract (-) VK_SUBTRACT

Off (` |) 102 key kbd VK_OFF

PA1 VK_PA1

Page Down VK_NEXT

Page Up VK_PRIOR

Paste VK_PASTE

Pause VK_PAUSE

Period VK_PERIOD

Play VK_PLAY

Print VK_PRINT

Print Screen VK_SNAPSHOT

Quote (back) VK_BACKQUOTE

Return VK_RETURN

Scroll Lock VK_SCROLL

Select VK_SELECT

Semicolon (; :) VK_SEMICOLON

Separator VK_SEPARATOR

Setup VK_SETUP

Shift VK_SHIFT

Shift (right) VK_RSHIFT

Slash (backward) VK_BACKSLASH

Slash (forward) VK_SLASH

Spacebar VK_SPACE

Square Bracket (left) VK_LBRACKET

Square Bracket (right) VK_RBRACKET

Tab VK_TAB

Windows (left) VK_LWIN
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Mouse Buttons
Table B-2  Mouse Buttons

Mouse Action Virtual Key Name

Left Click VK_MSE_B1_CLK

Right Click VK_MSE_B2_CLK

Middle Click VK_MSE_B4_CLK

Left Double-Click VK_MSE_B1_DBL

Right Double-Click VK_MSE_B2_DBL

Middle Double-Click VK_MSE_B4_DBL

Extended Keyboard Functions
Table B-3  Extended Keyboard Functions

Key Function Virtual Key Name

Browser Back VK_BROWSER_BACK

Browser Forward VK_BROWSER_FORWARD

Browser Stop VK_BROWSER_STOP

Browser Refresh VK_BROWSER_REFRESH

Browser Home VK_BROWSER_HOME

Browser Favorites VK_BROWSER_FAVORITES

Browser Search VK_BROWSER_SEARCH

Japanese Kanji VK_KANJI

Japanese Kana VK_KANA

Korean Hanguel VK_HANGUEL

Korean Hanja VK_HANJA

Launch Mail VK_LAUNCH_MAIL

Launch Media Select VK_LAUNCH_MEDIA_SELECT

Launch Application 1 VK_LAUNCH_APP1

Launch Application 2 VK_LAUNCH_APP2

Media Play/Pause VK_MEDIA_PLAY_PAUSE

Media Stop VK_MEDIA_STOP

Media Previous Track VK_MEDIA_PREV_TRACK

Media Next Track VK_MEDIA_NEXT_TRACK

Volume Down VK_VOLUME_DOWN
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Table B-3  Extended Keyboard Functions (continued)

Key Function Virtual Key Name

Volume Up VK_VOLUME_UP

Volume Mute VK_VOLUME_MUTE

AT&T 4410 Virtual Key Names
The following virtual key names can be used when running the AT&T 4410 terminal emulation in
addition to all the VK_ virtual key names listed in the section Standard Virtual Key Names
on page 245.

Table B-4  AT&T 4410 Virtual Key Names

Key Function Virtual Key Name Default Mapping

Backspace AT_BACKSPACE VK_BACK

Break AT_BREAK

Clear AT_CLEAR VK_F10

Cursor Up AT_UP VK_UP

Cursor Down AT_DOWN VK_DOWN

Cursor Left AT_LEFT VK_LEFT

Cursor Right AT_RIGHT VK_RIGHT

Delete AT_DELETE VK_DELETE

Escape AT_ESCAPE VK_ESCAPE

F1 - F8 AT_F1 - F8 VK_F1 - VK_F8

Home Down AT_HOMEDOWN VK_END

Home Up AT_HOMEUP VK_HOME

Line Feed AT_LINEFEED VK_F9

Num Lock AT_NUMLOCK A+VK_NUMLOCK

Return AT_RETURN VK_RETURN

Setup AT_SETUP VK_F11

Tab AT_TAB VK_TAB

DEC VT510 Virtual Key Names
The following virtual key names can be used when running any of the DEC VT terminal emulations in
addition to all the VK_ virtual key names listed in the section Standard Virtual Key Names
on page 245.
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Table B-5  DEC VT510 Virtual Key Names

Key Function Virtual Key Name Default Mapping

Back Tab VT_CSIZ S+VK_TAB

Break VT_BREAK VK_PAUSE

Backspace VT_BACKSPACE S+VK_BACK

Compose Character VT_COMPOSE A+VK_UP

Cursor Up VT_UP VK_UP

Cursor Down VT_DOWN VK_DOWN

Cursor Left VT_LEFT VK_LEFT

Cursor Right VT_RIGHT VK_RIGHT

Datatalk VT_DATATALK A+VK_DOWN

Delete VT_DELETE VK_BACK

Do (F16) VT_DO A+VK_F6

Enter VT_ENTER VK_SEPARATOR

Escape VT_ESCAPE VK_ESCAPE

F6 - F12 VT_F6 - VT_F12 VK_F6 - VK_F12

F13 - F14 VT_F13 - VT_F14 A+VK_F3 - A+VK_F4

F17 - F20 VT_F17 - VT_F20 A+VK_F7 - A+VK_F10

Find VT_FIND VK_INSERT

Help (F15) VT_HELP A+VK_F5

Hold Screen VT_HOLD VK_SCROLL

Insert VT_INSERT VK_HOME

Keypad 0 - 9 VT_PAD0 - 9 VK_NUMPAD0 - 9

Keypad Comma VT_COMMA A+VK_ADD

Keypad Decimal VT_PADDECIMAL VK_DECIMAL

Keypad Minus VT_MINUS VK_SUBTRACT

Next Page VT_NEXT VK_NEXT

PF1 - PF4 VT_PF1 - VT_PF4 VK_F1 - VK_F4

Previous Page VT_PREV VK_END

Print VT_PRINT C+VK_PRINT

Print TTY Mode VT_PRINTTTY S+VK_F4

Print Scrolling Region VT_PRINTSCROLL S+C+VK_PRINT

Remove VT_REMOVE VK_PRIOR
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Table B-5  DEC VT510 Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

Return VT_RETURN VK_RETURN

Scroll Down VT_PANDOWN C+VK_DOWN

Scroll Left VT_PANLEFT C+VK_LEFT

Scroll Right VT_PANRIGHT C+VK_RIGHT

Scroll Up VT_PANUP C+VK_UP

Select VT_SELECT VK_DELETE

Setup VT_SETUP S+C+VK_UP

Tab VT_TAB VK_TAB

HP 700-92/96 Virtual Key Names
The following virtual key names can be used when running the HP terminal emulation in addition to all
the VK_ virtual key names listed in the section Standard Virtual Key Names on page 245.

Table B-6  HP 700-92/96 Virtual Key Names

Key Function Virtual Key Name Default Mapping

Backspace HP_BACKSPACE VK_BACK

Clear Display HP_CLEARMEM C+VK_F4

Clear Line HP_CLEARLINE C+VK_F3

Column Width HP_COLUMNWIDTH VK_F12

Compose Character HP_COMPOSE A+VK_UP

Cursor Up HP_UP VK_UP

Cursor Down HP_DOWN VK_DOWN

Cursor Left HP_LEFT VK_LEFT

Cursor Right HP_RIGHT VK_RIGHT

Cursor Home HP_HOMEUP VK_HOME

Cursor Home Shifted HP_HOMEDOWN VK_END

Delete HP_DELETE S+VK_BACK

Delete Character HP_DELETECHAR VK_DELETE

Delete Line HP_DELETELINE C+VK_F2

Delete Wrap HP_DELETEWRAP C+VK_DELETE

Enter HP_SEND VK_SEPARATOR

Escape HP_ESCAPE VK_ESCAPE
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Table B-6  HP 700-92/96 Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

F1 - F8 HP_F1 - HP_F8 VK_F1 - VK_F8

Hard Reset HP_HARDRESET C+VK_F8

Insert Character HP_INSERTMODE VK_INSERT

Insert Line HP_INSERTLINE C+VK_F1

Insert Wrap HP_INSERTWRAP C+VK_INSERT

Menu HP_MENU S+VK_F9

Mode Selection Keys HP_MODES VK_F11

Next Page HP_NEXTPAGE VK_NEXT

Previous Page HP_PREVPAGE VK_PRIOR

Print HP_PRINT A+VK_PRINT

Return HP_RETURN VK_RETURN

Scroll Down HP_ROLLDOWN S+VK_DOWN

Scroll Up HP_ROLLUP S+VK_UP

Select HP_SELECT C+VK_F5

Soft Reset HP_SOFTRESET C+VK_F7

Tab HP_TAB VK_TAB

Tab Shifted HP_BACKTAB S+VK_TAB

User Keys Mode HP_USER VK_F10

User Key Def. Menu HP_FKEYDEFS S+VK_F10

User System HP_SYSTEM VK_F9

IBM 3151 Virtual Key Names
The following virtual key names can be used when running the IBM 3151 terminal emulation in
addition to all the VK_ virtual key names listed in the section Standard Virtual Key Names
on page 245.

Table B-7  IBM 3151 Virtual Key Names

Key Function Virtual Key Name Default Mapping

Alrm Up I51_ALRMUP C+VK_F11

Alrm Down I51_ALRMDN C+VK_F12

Backspace I51_BACKSPACE VK_BACK

Back Tab I51_BACKTAB VK_END
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Table B-7  IBM 3151 Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

Break I51_BREAK C+VK_F3

Cancel I51_CANCEL A+VK_F2

Clear I51_CLEAR VK_PRIOR

Compose Character I51_COMPOSE A+VK_UP

Cursor Up I51_UP VK_UP

Cursor Down I51_DOWN VK_DOWN

Cursor Left I51_LEFT VK_LEFT

Cursor Right I51_RIGHT VK_RIGHT

Cursor Select I51_CRSEL C+VK_F9

Cursor Select I51_CRSEL C+VK_NUMPAD8

Define PF Key I51_DEFPFKEY S+VK_INSERT

Del I51_DEL C+VK_HOME

Delete I51_DELETE VK_DELETE

Delete Line I51_DELETELINE C+VK_DELETE

Display Message I51_DSPMSG C+VK_F10

Display Message I51_DSPMSG C+VK_NUMPAD9

Enter I51_ENTER VK_SEPARATOR

Erase End Of Field I51_EREOF VK_NEXT

Erase EOP I51_EREOP C+VK_NEXT

Erase Input I51_ERINP C+VK_PRIOR

Escape I51_ESCAPE VK_ESCAPE

F1 - F12 I51_F1 - I51_F12 VK_F1 - VK_F12

F13 - F24 I51_F13 - I51_F24 S+VK_F1 - S+VK_F12

Hold I51_HOLD VK_PAUSE

Home I51_HOME VK_HOME

Insert Line I51_INSERTLINE C+VK_INSERT

Insert Mode I51_INSERT VK_INSERT

Jump I51_JUMP C+VK_F5

Jump I51_JUMP C+VK_DIVIDE

Line Feed I51_LINEFEED C+VK_RETURN

Local I51_LOCAL C+VK_END
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Table B-7  IBM 3151 Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

Local I51_LOCAL C+VK_ADD

Numeric Pad 0 - 9 I51_NUMPAD0 - 9 VK_NUMPAD0 - 9

PA1 - PA3 I51_PA1 - I51_PA3 C+VK_NUMPAD1 - 3

Print Message I51_PRTMSG C+VK_F2

Print Line I51_PRTLINE VK_SCROLL

Print Screen I51_PRTSCRN C+VK_F6

Print View I51_PRTVIEW VK_SNAPSHOT

Reset I51_RESET A+VK_F1

Return I51_RETURN VK_RETURN

Send I51_SEND C+VK_SEPARATOR

Send Line I51_SNDLNE C+VK_F8

Send Message I51_SNDMSG C+VK_F7

Send Message I51_SNDMSG C+VK_MULTIPLY

Setup I51_SETUP C+VK_F4

Setup I51_SETUP C+VK_SUBTRACT

Sub I51_SUB C+VK_NUMPAD4

Sup I51_SUP C+VK_NUMPAD7

Tab I51_TAB VK_TAB

Trace I51_TRACE C+VK_F1

TXF1 - TXF12 I51_TXF1 - I51_TXF12 S+C+VK_F1 - F12

IBM 3270 Virtual Key Names
The following virtual key names can be used when running the IBM 3270 terminal emulation in
addition to all the VK_ virtual key names listed in the section Standard Virtual Key Names
on page 245.

Table B-8  IBM 3270 Virtual Key Names

Key Function Virtual Key Name Default Mapping

Alternate Code Page IB_ALTCP S+A+C+VK_SUBTRACT

Attention IB_ATTN S+VK_ESCAPE

Back Tab IB_BACKTAB S+VK_TAB

Backspace IB_BACKSPACE VK_BACK

254 Appendix B   Virtual Key Names ENWW



Table B-8  IBM 3270 Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

Clear IB_CLEAR VK_PAUSE

Close (Delete Space) IB_REV_CL S+VK_MULTIPLY

Copy IB_COPY S+VK_NEXT

Cursor Up IB_UP VK_UP

Cursor Down IB_DOWN VK_DOWN

Cursor Left IB_LEFT VK_LEFT

Cursor Right IB_RIGHT VK_RIGHT

Cursor Select IB_CURSORSEL S+A+VK_F9

Cursor Flash On/Off IB_FLCR S+C+VK_F10

Cursor Line/Block IB_ALTCR S+C+VK_F11

Delay 1 Second IB_DELAY S+A+C+VK_PAUSE

Delete Character IB_DELCHAR VK_DELETE

Delete Word IB_DELWORD A+VK_DELETE

Display Attributes IB_DISPATTR A+VK_F10

Duplicate IB_DUP S+VK_INSERT

Enter IB_ENTER VK_SEPARATOR

Erase End Of Field IB_ERASEEOF VK_END

Erase Input IB_ERASEINPUT S+VK_PAUSE

F1 - F12 IB_F1 - IB_F12 VK_F1 - VK_F12

F13 - F24 IB_F13 - IB_F24 S+VK_F1 - S+VK_F12

Field Mark IB_FIELDMARK S+VK_HOME

Fn Edit IB_FEDIT A+VK_F3

Go To End Of Line IB_GO_EOL S+VK_END

Home IB_HOME VK_HOME

Insert Mode IB_INSERT VK_INSERT

Jump IB_JUMP C+VK_HOME

Local National Map IB_LCLMAP S+VK_SUBTRACT

Mono Case IB_MONO C+VK_F4

Next Word IB_NEXTWORD A+VK_RIGHT

Notice Board Copy IB_NB_COPY S+C+VK_PRIOR

Notice Board Jump IB_NB_JUMP C+VK_PRIOR
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Table B-8  IBM 3270 Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

Notice Board Setup IB_NB_SETUP A+VK_F2

Notice Board Zoom IB_NB_ZOOM A+VK_PRIOR

Num Lock IB_NUMLOCK A+VK_NUMLOCK

PA1 IB_PA1 VK_PRIOR

PA2 IB_PA2 VK_NEXT

PA3 IB_PA3 S+VK_PRIOR

Pause IB_PAUSE A+VK_PAUSE

Play Keystrokes IB_PLAY A+VK_F8

Previous Word IB_PREVWORD A+VK_LEFT

Print Screen IB_PRINT VK_SNAPSHOT

Push Mode On/Off IB_PUSH S+C+VK_SUBTRACT

Quit IB_QUIT A+VK_ESCAPE

Record Keystrokes IB_RECORD A+VK_F7

Reset IB_RESET VK_ESCAPE

Return IB_RETURN VK_RETURN

Reverse Input Direction IB_REV_IP S+VK_DIVIDE

Reverse Screen IB_REV_SC S+VK_BACK

Rule Display IB_RULE A+VK_NEXT

Selectable Field Tab IB_FIELDTAB VK_SUBTRACT

System Request IB_SYSREQ A+VK_ESCAPE

Tab IB_TAB VK_TAB

Test Key To Host IB_TEST A+VK_SCROLL

IBM 5250 Virtual Key Names
The following virtual key names can be used when running the IBM 5250 terminal emulation in
addition to all the VK_ virtual key names listed in the section Standard Virtual Key Names
on page 245.

Table B-9  IBM 5250 Virtual Key Names

Key Function Virtual Key Name Default Mapping

Alternate Code Page AS_ALTCP S+A+C+VK_SUBTRACT

Attention AS_ATTN S+VK_ESCAPE
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Table B-9  IBM 5250 Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

Back Tab AS_BACKTAB S+VK_TAB

Backspace AS_BACKSPACE VK_BACK

Backspace (non-destruct) AS_NONDESTBS A+VK_BACK

Clear AS_CLEAR VK_PAUSE

Cursor Up AS_UP VK_UP

Cursor Down AS_DOWN VK_DOWN

Cursor Left AS_LEFT VK_LEFT

Cursor Right AS_RIGHT VK_RIGHT

Cursor Fast Left AS_FASTLEFT S+VK_LEFT

Cursor Fast Right AS_FASTRIGHT S+VK_RIGHT

Cursor Select AS_CURSORSEL C+VK_F9

Delay 1 Second AS_DELAY S+A+C+VK_PAUSE

Delete Character AS_DELCHAR VK_DELETE

Duplicate AS_DUP S+VK_INSERT

Enter AS_ENTER VK_SEPARATOR

Erase End Of Field AS_ERASEEOF VK_END

Erase Input AS_ERASEINPUT A+VK_PAUSE

F1 - F12 AS_F1 - AS_F12 VK_F1 - VK_F12

F13 - F24 AS_F13 - AS_F24 S+VK_F1 - S+VK_F12

Field Exit AS_FIELDEXIT VK_RETURN

Field Mark AS_FIELDMARK S+VK_HOME

Field Minus AS_FIELDMINUS VK_SUBTRACT

Field Plus AS_FIELDPLUS S+VK_SEPARATOR

Go To End Of Line AS_GO_EOL S+VK_END

Help AS_HELP VK_MULTIPLY

Home AS_HOME VK_HOME

Insert Mode AS_INSERT VK_INSERT

Local/General Keyboard AS_LCLMAP S+VK_SUBTRACT

Monochrome AS_MONO C+VK_F4

New Line AS_NEWLINE S+VK_RETURN

PA1 AS_PA1 A+VK_INSERT
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Table B-9  IBM 5250 Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

PA2 AS_PA2 A+VK_HOME

PA3 AS_PA3 A+VK_PRIOR

Pause AS_PAUSE A+VK_PAUSE

Play Keystrokes AS_PLAY A+VK_F5

Print Local AS_PRINTLOCAL C+VK_SNAPSHOT

Print AS_PRINT VK_SNAPSHOT

Push Mode On/Off AS_PUSH S+C+VK_SUBTRACT

Quit AS_QUIT A+VK_ESCAPE

Record Keystrokes AS_RECORD A+VK_F4

Reset AS_RESET VK_ESCAPE

Reverse Close Text AS_REV_CL S+VK_MULTIPLY

Reverse/Normal Toggle AS_REV_IP S+VK_DIVIDE

Reverse Whole Screen AS_REV_SC S+VK_BACK

Roll Down AS_ROLLDOWN VK_PRIOR

Roll Up AS_ROLLUP VK_NEXT

Rule Display AS_RULE A+VK_NEXT

System Request AS_SYSREQ A+VK_SNAPSHOT

Tab AS_TAB VK_TAB

Test AS_TEST A+VK_SCROLL

IBM 5250 Word Processing Mode
Table B-10  IBM 5250 Word Processing Mode

Key Function Virtual Key Name

Begin Bold AS_WP_BOLD

Begin Underline AS_WP_UNDERLINE

Word Underline AS_WP_WORD_UNDER

End Attribute AS_WP_END_ATTR

Centre Text AS_WP_CENTRE

Half-Index Up AS_WP_HI_UP

Half-Index Down AS_WP_HI_DOWN

Next Text Column AS_WP_NEXT_COL
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Table B-10  IBM 5250 Word Processing Mode (continued)

Key Function Virtual Key Name

Beginning of Line AS_WP_BEG_LINE

End of Line AS_WP_END_LINE

Top of Page AS_WP_TOP_PAGE

End of Page AS_WP_END_PAGE

Start New Page AS_WP_NEW_PAGE

Insert Carrier Return AS_WP_RETURN

Insert Stop Code AS_WP_STOP_CODE

Find Stop Code AS_WP_FIND_STOP

Required Page End AS_WP_REQD_PAGE

Required Space AS_WP_REQD_SPACE

Required Tab AS_WP_REQD_TAB

Symbols Command AS_WP_SYMBOLS

TA6530 Virtual Key Names
The following virtual key names can be used when running the TA6530 terminal emulation in addition
to all the VK_ virtual key names listed in the section Standard Virtual Key Names on page 245.

Table B-11  TA6530 Virtual Key Names

Key Function Virtual Key Name Default Mapping

Backspace TA_BACKSPACE VK_BACK

Back Tab TA_BACKTAB S+VK_TAB

Break TA_BREAK VK_PAUSE

Break Shifted TA_S_BREAK S+VK_PAUSE

Character Delete TA_CHARDEL VK_DELETE

Character Insert TA_CHARINS VK_INSERT

Cursor Up TA_UP VK_UP

Cursor Down TA_DOWN VK_DOWN

Cursor Left TA_LEFT VK_LEFT

Cursor Right TA_RIGHT VK_RIGHT

Delete TA_DEL S+VK_ESCAPE

End TA_END VK_END

Erase Line TA_ERASELINE C+VK_SCROLL
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Table B-11  TA6530 Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

Erase Page TA_ERASEPAGE S+C+VK_SCROLL

Escape TA_ESC VK_ESCAPE

F1 - F12 TA_F1 - TA_F12 VK_F1 - VK_F12

F13 - F16 TA_F13 - TA_F16 A+VK_F3 - A+VK_F6

F1 - F12 Shifted TA_S_F1 - TA_S_F12 S+VK_F1 - S+VK_F12

F13 - F16 Shifted TA_S_F13 - TA_S_F16 S+A+VK_F3 - F6

Home TA_HOME VK_HOME

Home + Control TA_C_HOME C+VK_HOME

Insert TA_INSERT S+VK_INSERT

Line Delete TA_LINEDEL C+VK_DELETE

Line Insert TA_LINEINS C+VK_INSERT

Num Lock TA_NUMLOCK VK_NUMLOCK

Numeric Pad 0 - 9 TA_PAD0 - TA_PAD9 VK_NUMPAD0 - 9

Numeric Pad Comma TA_PADCOMMA A+VK_ADD

Numeric Pad Decimal TA_PADDECIMAL VK_DECIMAL

Numeric Pad Enter TA_ENTER VK_SEPARATOR

Num Pad Enter Shifted TA_S_ENTER S+VK_SEPARATOR

Num Pad Enter + Ctrl TA_C_ENTER C+VK_SEPARATOR

Numeric Pad Minus TA_PADMINUS VK_SUBTRACT

Page Down TA_PAGEDOWN VK_NEXT

Page Down Shifted TA_S_PAGEDOWN S+VK_NEXT

Page Up TA_PAGEUP VK_PRIOR

Page Up Shifted TA_S_PAGEUP S+VK_PRIOR

Print Screen TA_PRTSCR VK_PRINT

Print Screen Shifted TA_S_PRTSCR C+VK_PRINT

Return TA_RETURN VK_RETURN

Return Shifted TA_S_RETURN S+VK_RETURN

Return + Control TA_C_RETURN C+VK_RETURN

Roll Up TA_ROLLUP A+VK_UP

Roll Up Shifted TA_S_ROLLUP S+A+VK_UP

Roll Down TA_ROLLDOWN A+VK_DOWN
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Table B-11  TA6530 Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

Roll Down Shifted TA_S_ROLLDOWN S+A+VK_DOWN

Tab TA_TAB VK_TAB

Tab Clear TA_TABCLEAR S+A+VK_SUBTRACT

Tab Clear All TA_TABCLRALL A+C+VK_SUBTRACT

Tab Set TA_TABSET A+VK_SUBTRACT

Wyse Virtual Key Names
The following virtual key names can be used when running the Wyse terminal emulations in addition
to all the VK_ virtual key names listed in the section Standard Virtual Key Names on page 245.

Table B-12  Wyse Virtual Key Names

Key Function Virtual Key Name Default Mapping

Answerback WY_ANSWERBACK S+VK_PAUSE

Backspace WY_BACKSPACE VK_BACK

Break WY_BREAK VK_PAUSE

Character Set WY_CHARSET S+A+VK_UP

Clear Line WY_CLRLINE VK_END

Clear Screen WY_CLRSCRN S+C+VK_END

Compose Character WY_COMPOSE A+VK_UP

Cursor Up WY_UP VK_UP

Cursor Up Shifted WY_S_UP S+VK_UP

Cursor Down WY_DOWN VK_DOWN

Cursor Down Shifted WY_S_DOWN S+VK_DOWN

Cursor Left WY_LEFT VK_LEFT

Cursor Left Shifted WY_S_LEFT S+VK_LEFT

Cursor Right WY_RIGHT VK_RIGHT

Cursor Right Shifted WY_S_RIGHT S+VK_RIGHT

Delete WY_DELETE VK_DELETE

Delete Shifted WY_S_DELETE S+A+VK_DELETE

Delete Character WY_DELCHAR C+VK_DELETE

Delete Line WY_DELLINE S+C+VK_DELETE

Del Key WY_DELKEY A+VK_BACK
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Table B-12  Wyse Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

Del Key (Shifted) WY_S_DELKEY S+A+VK_BACK

End WY_END A+VK_END

End Shifted WY_S_END S+C+VK_END

Enter WY_ENTER VK_SEPARATOR

Enter Shifted WY_S_ENTER S+VK_SEPARATOR

Escape WY_ESC VK_ESCAPE

Escape Shifted WY_S_ESC S+C+VK_ESCAPE

F1 - F12 WY_F1 - WY_F12 VK_F1 - VK_F12

F1 - F12 Shifted WY_S_F1 - WY_S_F12 S+VK_F1 - 12

F11 - F16 WY_F11 - WY_F16 A+VK_F1 - 6

F11 - F16 Shifted WY_S_F11 - WY_S_F16 S+A+VK_F1 - 6

FDXBLK WY_FDXBLK S+C+VK_PAUSE

Function WY_FUNCT S+C+VK_SCROLL

Home WY_HOME VK_HOME

Home Shifted WY_S_HOME S+VK_HOME

Insert WY_INSERT VK_INSERT

Insert Character WY_INSCHAR A+VK_INSERT

Insert Line WY_INSLINE C+VK_INSERT

Keypad 5 WY_KP5 VK_NUMPAD5

Keypad 5 Shifted WY_S_KP5 S+VK_NUMPAD5

Num Lock WY_NUMLOCK VK_NUMLOCK

Page Up WY_PAGEUP VK_PRIOR

Page Up Shifted WY_S_PAGEUP S+VK_PRIOR

Page Down WY_PAGEDOWN VK_NEXT

Page Down Shifted WY_S_PAGEDOWN S+VK_NEXT

Pause WY_PAUSE A+VK_SCROLL

Print WY_PRINT VK_SNAPSHOT

Print shifted WY_S_PRINT S+VK_SNAPSHOT

Replace WY_REPLACE S+VK_INSERT

Return WY_RETURN VK_RETURN

Return Shifted WY_S_RETURN S+VK_RETURN
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Table B-12  Wyse Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

Send WY_SEND S+VK_SNAPSHOT

Split WY_SPLIT S+C+VK_SUBTRACT

Tab WY_TAB VK_TAB

Tab Shifted WY_S_TAB S+VK_TAB

MDIS Prism Virtual Key Names
The following virtual key names can be used when running any of the MDIS Prism terminal
emulations in addition to all the VK_ virtual key names listed in the section Standard Virtual Key
Names.

Table B-13  MD Prism Virtual Key Names

Key Function Virtual Key Name Default Mapping

Back Tab MD_CSIZ S+VK_TAB

Backspace MD_BACKSPACE S+VK_BACK

Break MD_BREAK VK_PAUSE

Compose Character MD_COMPOSE A+VK_UP

Cursor Down MD_DOWN VK_DOWN

Cursor Left MD_LEFT VK_LEFT

Cursor Right MD_RIGHT VK_RIGHT

Cursor Up MD_UP VK_UP

Datatalk MD_DATATALK A+VK_DOWN

Delete MD_DELETE VK_BACK

Do (F16) MD_DO A+VK_F6

Enter MD_ENTER VK_SEPARATOR

Escape MD_ESCAPE VK_ESCAPE

F6 - F12 MD_F6 - MD_F12 VK_F6 - VK_F12

F13 - F14 MD_F13 - MD_F14 A+VK_F3 - A+VK_F4

F17 - F20 MD_F17 - MD_F20 A+VK_F7 - A+VK_F10

Find MD_FIND VK_INSERT

Help (F15) MD_HELP A+VK_F5

Hold Screen MD_HOLD VK_SCROLL

Insert MD_INSERT VK_HOME
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Table B-13  MD Prism Virtual Key Names (continued)

Key Function Virtual Key Name Default Mapping

Keypad 0 - 9 MD_PAD0 - 9 VK_NUMPAD0 - 9

Keypad Comma MD_COMMA VK-ADD

Keypad Decimal MD_PADDECIMAL VK_DECIMAL

Keypad Minus MD_MINUS A+VK_ADD

Left MD_LEFT VK_LEFT

Next Page MD_NEXT VK_NEXT

PF1 - PF4 MD_PF1 - MD_PF4 VK_F1 - VK_F4

Previous Page MD_PREV VK_END

Print Screen MD_PRINT C+VK_PRINT

Print TTY Mode MD_PRINTTTY S+VK_F4

Print Scrolling Region MD_PRINTSCROLL S+C+VK_PRINT

Remove MD_REMOVE VK_PRIOR

Return MD_RETURN VK_RETURN

Scroll Down MD_PANDOWN C+VK_DOWN

Scroll Left MD_PANLEFT C+VK_LEFT

Scroll Right MD_PANRIGHT C+VK_RIGHT

Scroll Up MD_PANUP C+VK_UP

Select MD_SELECT VK_DELETE

Setup MD_SETUP S+C+VK_UP

Tab MD_TAB VK_TAB

Up MD_UP VK_UP
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C Product Specification

This appendix describes the level of support provided by each terminal emulation.

Introduction
The following sections describe the level of support provided by each terminal emulation throughout
the product range. Note that your product version may not support all the terminal emulations listed
here.

General
Limitations

● Key click not supported.

● Badge and Magnetic Card reader support are supported via wedged data devices connected to
the unit's keyboard.

● No downloadable program module.

● The keyboard layouts may differ but substantially provide the same capabilities as the native
terminal.

● No screensavers.

● File Transfer protocols not supported on embedded products / thin clients.

● API's not supported on embedded products / thin clients.

● Smooth Scroll and Variable Scroll rates not supported.

● No graphics or APA graphics

Telnet
Specification

● Implements RFC 854, 855, 856, 857, 858, 860, 1091, 1408, 1571, 1572.

● Implements RFC 1205, 2877 for IBM 5250.

● Implements RFC 2355, 1576, 1646, 1647 for IBM 3270.

AixTerm
● No Vertical tab stops.

● No Select Alternate presentation variant.

● No Select reversed string.
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● No Select font in graphic rendition.

● No Virtual terminal commands.

● No Set curses fix.

● No Page scroll.

● No Alternate screen buffer.

● No Xwindows capabilities.

DEC VT Series Emulation
Specification

● Digital VT 420 Programmer's Manual (EK-VT420-RM-001).

Limitations

● The DEC Multisession and SSU protocols are not implemented.

HP 700-92/96 Emulation
Specification

● HP 2392A Reference Guide (02394-90001. April 1984).

IBM 3270 Emulation
Specification

● 3270 Information Display System Data Stream Programmer's Reference (GA23-0059-07).

Limitations

● No Double byte printing.

IBM 5250 Emulation
Specification

● 5494 Remote Control Unit Functions Reference. Release 2.0. (SC30-3533-02).

Limitations

● No text assist in Right to Left writing mode.

● No double-byte printing.

● The 3812-1 Non Host Print Transform (Non-HPT) print protocol is not supported.

● No Calculator / Hex key.

● No Password encryption.

● No Auxiliary port support.
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● No Control Unit customization.

● The specification is also defined by the 5250 Device Capabilities report Bytes 0 thru 5 which are
0x7f, 0x11, 0x4e, 0x00, 0x03 and 0x80 for Display Sessions.

IBM 3151 Native Emulation Model 11 & 31
Specification

● IBM 3151 Ascii Display Station Reference Manual (GA18-2634- 01. 1989).

Stratus V102
Specification

● V102 Display Terminal Operator's Manual (TVI 131974-00 June 1985).

Limitations

● Page print flip mode not supported.

● Serial configuration commands not supported.

● Select character set commands not supported.

Tandem 6526/6530 Emulation
Specification

● Tandem 653x Multi-Page Terminal Programmer's Guide (82310-B00 December 1983).

Limitations

● Telnet Line-Mode is not supported.

● Ansi media copy commands are not supported.

● No support for auxiliary port.

● No support for extended buffer and cursor commands.

● String configuration, machine and directory commands not supported.

● Data table redefinition commands not supported.

● Remote termination not supported.

● I/O device and file commands not supported.

● Set color configuration commands not supported.

Televideo 955
Specification

● Televideo 955 Display Terminal Operator's Manual (131969-00- B Sept 1985).

ENWW IBM 3151 Native Emulation Model 11 & 31 267



Limitations

● Page print flip mode not supported.

● Serial configuration commands not supported.

● Select character set commands not supported.

Wyse 60 Native Emulation
Specification

● WY-60 Programmer's Guide (880261-01 Rev A).

Limitations

● Only 16 colors supported, not 64.

● Some color commands are not supported.

● No page edit mode.

● Modem and aux port commands not supported.

● No Keyboard scan code mode.

● Character cell size commands not supported.

● Function key label save commands not supported.

● Automatic font loading not supported.

● Remote caps lock commands not supported.

● Ignore nulls commands not supported.

● Attribute overwrite mode not supported.

● Disable intensity commands not supported.

● Some select personality commands not supported.

● Wyseword mode not supported.

Wyse 50, 50+, TVI 910, 950, ADDS-A2, HZ 1500, Wyse PC-
Term

Specification

● WY355/ES Reference Manual (883227-01 Rev. A).
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Limitations

All modes:

◦ As Wyse 60 above where applicable.

TVI modes:

◦ Select Print / Line termination characters.

Wyse PC-Term:

◦ Default unit command not supported.

◦ Program key with direction not supported.

◦ Set print terminators not supported.

◦ Define delimiters not supported.
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euro character 244

F
File menu

New Tab 8
New Window 8
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Save Session 9, 87, 219
Save Session As 3, 9

function keys
AT&T 4410 75

G
Getting help 2

H
host communication

capture overview 233
capture to file 234
replay file 235

host connection
connection status LED 9
data transmission LED

indicator 9
local/online button 9
serial 11
SSH2 11
SSL 11
TCP/IP 11
transport 11

host connection LED indicator 9
HP 700-92/96

specification 266
virtual key names 251

HP 700-92/96 emulation
character display

attributes 102
configuration selection 96
create session 90
device control 96
device modes 97
display configuration 92
function keys 93
keyboard mapping 91
margins 98
mode selection 93
programming function

keys 100
Session Wizard 90
setup options 103
start column 98
tabs 98
TeemTalk Window 90

HP 700-92/96 Settings dialog
Configuration settings 106
General settings 104
Preferences 109

HZ 1500
limitations 268
specification 268

I
IBM 3151

specification 267
virtual key names 252

IBM 3151 emulation
create session 112
function keys 117
keyboard mapping 113
Session Wizard 112
setup options 118
status line 115
TeemTalk wizard 112

IBM 3151 Settings dialog
Display settings 121
General settings 119
Preferences 124

IBM 3270
virtual key names 254

IBM 3270 Display
codepages  0
extended attributes 127
fonts  0
specification 266
typeahead capability 127

IBM 3270 Display emulation
alternate code page 134
bilingual keyboard 132
bilingual keyboard

support 134
Close key 133
create session 126
cursor position 133
display direction 132
display right-to-left 133
do not enter 131
insert mode 132
keyboard mapping 127
Network Virtual Terminal

mode 130
notice board 137
numeric lock 132
operating mode 131
playback keystrokes 134
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